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1 
Introduction 

e-MDs Solution Series provides an extensive set of supporting automation tools to 
expand and build on the applications that are part of this Electronic Medical Record 
(EMR) and Practice Management software solution.  This guide provides instructions 
for using the following tools: 

• DocMan: Scan and manages documents electronically. 

• TaskMan: Supports interoffice messaging and tasking. 

• Snapshot (Digicam):  Captures photo images as computer code and inserts 
them in the patient's chart. 

• Forms/Letter Builder:  Creates forms and letters commonly used in the 
practice using fields from the database and performing mail merges for single 
or multiple mailings. 

• Spell Checker:  Integrates a third-party dictionary for use in text-based 
functions. 

• Signatures:  Manages bitmaps or images of a user’s handwritten signature 
that are captured electronically via scanning and can be used within both the 
ScriptWriter, DocMan and Chart modules. 

• Continuity of Care Documents (CCD):  Provides the option to either export 
or import a CCD file in an XML format with all pertinent patient information 
included. 

• Registry Processor to create, view, distribute and print customized reports 
based on patient demographics and healthcare records. 

Because of their tight integration with Chart module functionality, Fast Forms, 
Tracking Board, and the Rules Engine are described in the e-MDs Solution Series 
Chart User Guide instead of this guide. 

Continued on the next page ... 
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Using This Guide 
As you go through this guide, you will notice that each set of steps to perform a task begins with an 
indented heading starting with "To" and ending with a colon (:).  That heading is then followed by indented 
steps to be performed in a prescribed sequence.  For example, after a brief overview of when you may 
scan documents into a patient's folder, the procedure looks like the contents of the following box: 

To scan a document into a patient folder: 
1. Click Open Patient on the main toolbar.  

2. Type the desired patient name (or other search criteria) in the Find Chart Patient window and 
click Search.  

3. Highlight the appropriate patient name from the search results and click Select. 

4. Ensure that the correct Specialty Group is chosen from the drop-down list, so that appropriate 
Category and Subcategory folders are displayed in the left windowpane. After this is done per 
login, it should default to this Specialty Group from this point forward. 

5. Highlight the desired Category or Subcategory into which the document will be scanned, and then 
click New Document icon on the main toolbar. 

Related Documentation 
Documentation for Solution Series modules is provided in PDF (Portable Document Format) files for 
viewing and printing individually, and in Help format for easy access from each product module.  Both 
formats and access methods provide the same information.  The documentation library is updated 
extensively for each major product release as well as updated and corrected periodically, as needed.  For 
the latest version of any Solution Series documentation, go to the documentation section of the e-MDs 
Support site at Online Support > Downloads > Documentation. 

The following documents are available to all Solution Series users: 

• e-MDs Solution Series Administration Guide is your starting point for initializing and customizing 
Solution Series modules for use in your organization.  This guide provides step-by-step 
instructions for licensing your software, adding system users and defining access levels, adding 
and modifying user groups, and setting up default handling of various module tasks. 

• e-MDs Solution Series Bill User Guide provides instructions for working with insurance codes and 
electronic claims, setting fee schedules and rules, defining policies, posting and billing 
transactions and reversals, and performing numerous other practice management tasks. 

• e-MDs Solution Series Chart User Guide leads you from the beginning of an office visit through 
the visit conclusion when billing is enabled.  Using Chart you can track and code a patient’s 
medical information and provide prenatal, maternity and postnatal care.  This guide also details 
Chart's prescription processing, lab interfaces, and telephone interactions with patients. 

• e-MDs Formulary Benefits User Guide describes how to determine the pharmacy benefits and 
drug copays for a patient’s health plan, determine if a prescribed medication is covered (in 
formulary) under a patient’s plan, display therapeutic alternatives with preference rank (if 
available) within a drug class for non-formulary medications, determine if a patient’s health plan 
allows electronic prescribing to mail order pharmacies, and download a historic list of all 
medications prescribed for a patient by any provider. 

• e-MDs Solution Series Installation and Upgrade Guide leads you through the preparation of your 
site for Solution Series, the database and application installation steps, and post-installation 

https://supportcenter.e-mds.com/ics/support/default.asp?deptID=3222�
https://supportcenter.e-mds.com/ics/support/default.asp?deptID=3222�
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configuration.  If Solution Series is already installed at your facility, use the update instructions 
provided to update your system. 

• e-MDs Solution Series Schedule User Guide leads you through scheduling and tracking 
appointments, setting up and modifying patient accounts, blocking time on the calendar to restrict 
appointment scheduling, checking patients into the facility and tracking their progress through 
each encounter with a provider, and checking eligibility. 

• e-MDs Solution Series Reports User Guide lists the reports available through Solution Series.  A 
description of each report is provided, along with the location of the report within Solution Series 
modules, the available fields and filters used to select specific data for the report, and samples of 
most reports, illustrating what you can expect when running a report at your facility. 

Additional documentation is also available on the e-MDs Support site for performing specific tasks and for 
using e-MDs interface products for working with labs and other organizations.  For access to the latest 
versions of these documents, see the e-MDs Support site. 

Getting Additional Help and Information 
e-MDs realizes that one of the most important elements of any software system is the support services 
backing it up. There are a number of support resources available to help you optimize the use of your 
system and participate in the e-MDs community.  

Help Screens 
Help is accessible on each Solution Series application and module by going to Help > Search Topic on 
each application's top toolbar.  Related help files, such as this guide, the Utilities Guide, and the Reports 
User Guide, are generally accessible from the same help screen.  After opening each help file, you can 
use the table of contents, index or search function to locate the specific information you need. 

Online Help files are also available through the application toolbar for Portal applications by clicking the 
question mark. The following Help is available for the Portal application: 

• e-MDs Patient Portal: The Clinic’s Guide to Using the Portal provides instructions for maintaining 
user access on a Patient Portal, working with patient appointments scheduled through the Portal, 
communicating with patients through a Portal e-mail interface, processing prescription refill 
requests, and auditing Patient Portal usage. 

• e-MDs Patient Portal: The Patient’s Guide to Using the Portal instructs patients on the use of the 
Patient Portal to communicate with their healthcare provider, view their own healthcare 
information, and submit requests for appointments and prescription refills.  This HTML file is 
provided on your Patient Portal for easy online viewing or printing by patients. 

User Guides 
The e-MDs Solution Series user guides contain comprehensive information about all standard product 
functions. This includes dealing with many of the complex situations that can arise in a medical office. 
Use the table of contents, index or search option to locate items of particular interest.  These guides are 
very similar to the application help screens.  For a brief description of the Solution Series user guides 
available, see Related Documentation. 

Solution Series guides are always available in electronic format (Adobe .pdf files).  You can put copies on 
each computer in the network.  You can download the Adobe Acrobat Reader for free from 
www.adobe.com  Updated user guides are included on the CD-ROMs you will receive with each upgrade, 
as well as on the support pages at www.e-mds.com.   

To download files from the e-MDs Support site, you will need your clinic password.  Instructions on how to 
apply for a password are on the Web site.  Only one password is issued per customer account, so please 
ensure you communicate this to your staff. 

https://supportcenter.e-mds.com/�
http://www.adobe.com/�
http://www.e-mds.com/�
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Using the e-MDs Support Center 
The e-MDs Support Center is an online customer meeting place for clients with an active account.  It is 
accessed from the Support pages at www.e-MDs.com or 
http://supportcenteronline.com/ics/support/default.asp?deptID=3222 .  If you don’t have an account, you 
can request one by using the Request New Account button on the login page.  We strongly encourage 
each staff member in a clinic to have their own logins instead of one generic one for all people.  The 
primary reason for this is that when we need to push information such as update notifications it is sent to 
everyone meaning there is a smaller chance that the information will not be disseminated such as if 
someone is sick or ignores the message. 

Support Center includes the following tools that can be of great assistance to helping your practice work 
more efficiently with the e-MDs Software: 

• Forums/Newsgroups: The online forums are an e-MDs User Community where you can post 
messages related to support, general discussions, suggestions, tips and more.  It is a great non-
urgent support tool and is also searchable.  You can subscribe to various forums that interest you 
and get an e-mail notification if someone posts to them.  You can also elect to get an e-mail if 
someone posts to a specific message.  This is really useful if you post a question and want to 
know when it is answered.  Support forums are monitored by the e-MDs support team and a 
number of our customers also chip in with their knowledge. 

• Downloads: Downloads include shared templates for Chart, Word Forms, reports, updates to 
content such as ICD and CPT codes, bug patches, etc. 

• Knowledge Base: The knowledge base includes an extensive list of articles that you can use for 
troubleshooting, setup and so on.  These are generally posted based on questions from 
customers. 

• Troubleshooter: This search utility makes it easy to quickly locate the information you’re looking 
for.  It cross-references multiple parts of the support center and returns hyperlinks to articles, 
downloads and the like. 

• Surveys: Occasionally e-MDs will gauge your opinions about something via surveys which can 
be distributed via Support Center. 

• “Push” e-mails: If we want to let you know about something, we can push information to you 
from Support Center.  

 

 

 

http://www.e-mds.com/�
http://supportcenteronline.com/ics/support/default.asp?deptID=3222�
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2 
DocMan 

 

DocMan allows you to rapidly scan in old charts or paper generated from outside 
sources, and then categorize them using Fast File technology.   

DocMan supports all document formats, and allows you to capture anything related to 
the patient chart – lab results, color images, referral letters and other 
correspondence, video with sound, and images of insurance cards for reference 
purposes. You can even host and view files from third-party vendor applications and 
devices. A generic forms folder allows you to store custom forms such as Advanced 
Beneficiary Notices (ABN) and patient information forms for rapid access anywhere in 
your network. 

Specialties and patient folders are completely customizable, and the interface was 
designed to be simple and intuitive.  If DocMan has not already been installed and 
customized on your system, see the e-MDs Solution Series Administration Guide for 
assistance in customizing DocMan to exactly meet your specific needs. 

The following section provides detailed information on how to perform DocMan tasks 
such as scanning, importing, filing and generally managing documents in your 
system. 

Continued on the next page ... 
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Adding Images to DocMan 
The most frequently used methods of adding images to DocMan are scanning and importing. 

Scanning a Document 
Documents can be scanned into either Patient Category folders (i.e. patient-specific documents scanned 
directly into a patient’s chart) or into Reference Documents Category folders (i.e. administrative 
documents stored in DocMan but unrelated to a specific patient).  The following instructions relate to 
scanning a document into a Patient Category folder. 

To scan a document into a patient folder: 
1. Click Open Patient on the main toolbar. Type the desired patient name (or other search criteria) in 

the Find Chart Patient window and click Search. Highlight the appropriate patient name from the 
search results and click Select. 

2. Ensure that the correct Specialty Group is chosen from the drop-down list, so that appropriate 
Category and Subcategory Folders are displayed in the left windowpane. Once this is done per 
login, it should default to this Specialty Group from this point forward. 

3. Highlight the desired Category or Subcategory into which the document will be scanned, and then 
click New Document icon on the main toolbar. 

To scan with document types: 
1. If Document Types have been created for the chosen Category (or Subcategory), the Documents 

window will pop up. Select the document description(s) that are appropriate. Selecting the 
Document Type merely labels the image about to be scanned; this label can be edited later.  

2. Next, click the Multi Select button to string together multiple Document Types.  For example, a 
Lab Category might contain Document Types "CBC", "chemistry panel", "urinalysis", etc.  If a lab 
report containing both a CBC and chemistry result is to be scanned in, label that image with both 
of those Document Types.  Or select Single Item. 

Note:  A new default Category was created for all Medical Specialties called Advanced 
Directives.  This Category contains the following default Document Types:  Antibiotic Status, 
CPR Status, Intubations Status, Life Support Status, Other, Resuscitation Status, and Tub 
Feeding Status. 

3. If desired, click Send Message and select the Ordering Provider in the upper Right field.  Click the 
Search button (labeled " … ") and select the appropriate provider. Or select one from the quick 
list under Ordered By Provider column. 

4. If desired, assign a Priority Level to the document from the drop-down menu and a Due Date or 
Date of Service. 

5. Click OK. 

6. At this point, the Image page is launched.   

Note:  Other than the Laboratory (or Lab) category that uses Lab Tracking. 

To perform a bulk scan (No Document Types): 
1. If no Document Types have been created for the chosen Category or Subcategory, a message 

states "There are no scan types available. Do you want to bulk scan to this category?"  

2. Click Yes. This will allow scanning of the document directly into the folder with a generic 
description. For example, if the "Lab" category receives a bulk scan, that document will be 
labeled as "Bulk Lab". This will immediately open the Image window, bypassing the step above. 
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This opens the Document Info window.  Here you can select an ORDERED BY PROVIDER, 
choose to message a Provider, set a Priority Level and select a Date of Service.   

3. Click OK and this opens the Image window. 

At this point, the Image page is launched.   

Note:  Other than the Laboratory (or Lab) category that uses Lab Tracking.) 

To scan into Laboratory Category (Lab Tracking): 
1. After selecting the Laboratory Category, follow the instructions above for selecting Document 

Types, Ordering Provider, and Priority Level as needed in the Documents window.  Click OK to 
close the Documents window. 

2. After completing the Documents window, this opens the Lab Tracking window.  Any CPT or 
HCPCS code that has been set for Lab Tracking (see "Lab Tracking" for details) and has been 
ordered will display here.  If you are scanning in or importing a lab that has been listed here, click 
to check it.  This will stop overdue messages to the ordering provider and designated recipient 
through TaskMan. 

3. If neither the CPT or HCPCS code is listed here, or the user does not wish to select one, click the 
Cancel button to close this window. 

4. When the blank Image window opens, place the document into the scanner and click one of the 
following Scanner icons: 

○ Scan Document:  Clicking this button scans the document automatically based on the 
previously set scanner preferences.  These can be set either through the Scan Custom 
button or through another scanning software like IrfanView (www.irfanview.com) or Windows 
Imaging or Microsoft Office Document Imaging. 

○ Scan Custom:  Clicking this button opens the Scanner Driver dialog screen.  Depending on 
the driver, the user will have the ability to set specific preferences.  Some recommendations 
for DocMan scanning include: 

 Image Mode:  Line Art (also known as B&W or Black & White) 

 Resolution:  300 x 300 dpi (FastForm resets this setting to 100 x 100 dpi) 

 Paper Size:  Letter (8.5 x 11 in) 

 Unit:  Inches 

 Scan Type: ADF (automatic document feeder) 

 Width:  8.500 

 Length:  11.000 

 Brightness:  50-128 (varies based on Driver) 

 Threshold:  50-128 (varies based on Driver) 

 Contrast:  50-128 (varies based on Driver) 

○ Scan Color:  If this scanner supports Color Scanning, clicking this button opens the Scanner 
Driver dialog screen also.  Depending on the driver, the user will have the ability to set 
specific preferences.  For information about preference settings, see "Scan Custom."  

Note:  DocMan currently does not support multi page .TIF color files. 

5. After clicking the Scan icon, a Scanning Dialog screen displays intermittently following each 
page scanned.  When scanning is completed, the image will then appear in the Image window. 

6. Click Save to retain this scan, and then Exit to return to the main DocMan page. 

http://www.irfanview.com/�
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Note:  After scanning into Lab (Laboratory) Category and clicking Save or exiting Image page, 
this opens the Lab Tracking window.  Any CPT or HCPCS code that has been set for Lab 
Tracking (see "Lab Tracking" for details) and has been ordered will display here.  If you are 
scanning in or importing a lab that has been listed here, click to check it.  This will stop overdue 
messages to the ordering provider and designated recipient through TaskMan. 

If neither a CPT or HCPCS code is listed here, or if the user does not wish to select one, click the 
Cancel button to close this window. 

OR 

If you decide to not keep this scan, click the Exit button.  When asked “Would you like to save 
this image?” click No.  This leaves an entry in the list of linked documents for this patient with ‘0’ 
pages.  To re-scan, click the Scanner icon and re-click a Scan icon.  Otherwise, right-click the 
description and click Delete. 

Notes:     
○ Currently cannot re-scan over an existing document.  The scanner icon is disabled. 

○ Recently scanned documents display first in document list of main DocMan Grid. 

Troubleshooting: Click File and choose the Select Twain Source menu option.  This will display 
a list of all twain devices attached to the computer, such as scanners and peripheral devices such as 
digital cameras.  Ensure that the correct scanner is selected. 

Documents can be scanned into either Patient Category folders (i.e. patient-specific documents scanned 
directly into a patient’s chart) or into Reference Documents Category folders (i.e. administrative 
documents stored in DocMan but unrelated to a specific patient).  The following instructions relate to 
scanning a document into a Reference Documents Category folder. 

To scan a document into a Reference Documents folder: 
1. Click Reference Documents icon on the main toolbar.  Or click Tools Reference Documents 

menu item.  This opens the Reference Documents window. 

2. Highlight the appropriate Category into which the document will be scanned, and then click the 
Add Document button (with the yellow plus sign).  Supply an abbreviated Code/Name for the 
document in the first field and a more detailed description into the second field. Click OK. 

3. Highlight the newly created document description in the Reference Documents window and click 
the Scan button (with the scanner icon). This will open the Image window.  [Prior to clicking the 
Scan button, to edit the description, highlight it and click the Edit Document button (with the pencil 
icon)].   

4. When the blank Image window opens, place the document into the scanner and click Scan.  The 
image will appear in the window.  Click Save to retain the image, and then Exit to return to main 
DocMan page. For more information regarding preference settings, see "Scan Document", "Scan 
Custom", or "Scan Color." 

5. Once a document has been scanned and saved, a check mark will appear in the box linked to its 
description. 

6. To View a document, click the View Document icon (page with magnifying glass) or double click 
on the description. 

7. To delete a document, highlight the description and click the Delete button (red dash). 

8. To limit/grant access to a document, those end users with the DocMan Security privilege can 
click on the Padlock icon. 

9. (Troubleshooting: Click File and choose the Select Twain Source menu option. This will display 
a list of all twain devices attached to the computer, such as scanners and peripheral devices such 
as digital cameras. Ensure that the correct scanner is selected.) 
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Performing Bulk Scans 
Bulk scanning is the mass scanning of a patient record into a single folder, rather than scanning discrete 
sections (such as Progress Notes charts, Lab Results, etc.) into separate folders. Bulk scanning is the 
most efficient means of entering large or files into DocMan. With the Fast File option, the individual 
documents within a bulk scan can then be quickly re-filed into appropriate folders (see "Fast File" for 
details). 

To perform a bulk scan: 
1. Click Open Patient on the main toolbar. Type the desired patient name (or other search criteria) in 

the Find Patient window and click Search. Highlight the appropriate patient name from the search 
results and click Select. 

2. Ensure that the correct Specialty Group is chosen from the drop-down list, on the dark gray bar, 
so that appropriate Category and Subcategory Folders are displayed in the left windowpane. 

3. Highlight the desired Category or Subcategory into which the chart will be bulk scanned.  If no 
Document Types have been created for the chosen Category or Subcategory, a message states 
"There are no scan types available. Do you want to bulk scan to this category?"   

4. Click Yes.  This will allow scanning of the document directly into the folder with a generic 
description.  For example, if the "Lab" category receives a bulk scan, that document will be 
labeled as "Bulk Lab". 

5. This opens the Document Info window.  Here you can select an ORDERED BY PROVIDER, 
choose to message a Provider, set a Priority Level and select a Date of Service.  Click OK and 
this opens the Image window. 

6. When the blank Image window opens, place the document stack into the scanner and click Scan.  
The multi-page image will appear in the window.  Click Save to retain the image pages, and then 
Exit to return to main DocMan page. For more information regarding preference settings, see 
"Scan Document", "Scan Custom", or "Scan Color." 

Importing Files 
Any file type can be stored in the DocMan application.  However, in order to view a file, an appropriate 
hosting application must be installed on the computer.  DocMan is capable of viewing the following file 
types: .jpg, .bmp, .png, .tif, and .gif.  Other types of files, such as MS Word documents (.doc) and Excel 
spreadsheets (.xls), can be displayed assuming the computer’s program files includes applications such 
as Microsoft Word and Excel.  Also X-rays, CT Scans, MRI scans or any other radiological files can also 
be imported into and stored in DocMan, provided that the host application is installed on the computer 
where these files will be viewed from within DocMan. 

To import a file into a patient folder: 
1. Click Open Patient on the main toolbar. Type the desired patient name (or other search criteria) 

in the Find Patient window and click Search. Highlight the appropriate patient name from the 
search results and click Select. 

2. Ensure that the correct Specialty Group is chosen from the drop-down list, so that appropriate 
Category and Subcategory Folders are displayed in the left windowpane. 

3. Highlight the desired Category or Subcategory into which the document will be scanned.  

4. On the main DocMan toolbar, click the Import Document icon.  Or click Tools on the main 
toolbar, and select either the Import Document or Import Folder menu options.  

○ If Import Document is chosen, browse for the correct document, highlight it, and click Open.  
Next, if user selects to Send message, choose an Ordered by provider, by clicking on the 
radio search button (…).  Or click Do not Send Message.  Finally, set a Priority level and Date 
of Service if desired.  The selected document will be titled with its name as it is listed in the 
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location on the computer’s directory.  To edit the title, right click on its description and choose 
the Edit menu option. 

Note:  Make sure that you are importing files from a simple path like single directory on the 
root drive.  Otherwise, this will generate error messages and access violations that prevent 
importing of the file.  For example, all imports should come from a directory like 
C:\ImageFiles.  This allows DocMan to go directly to that directory folder to access the image.  
DO NOT attempt to import from an extended path with may sublevels like 
C:\images\tobeimported\byDocs\byStaff\approved or from the Desktop which also has an 
extended path address, like C:\Documents and Settings\user.network\Desktop\Tifs. 

○ If Import Document is chosen, browse for the correct document, highlight it, and click Open. 
The selected document will be titled with its location in the computer’s directory. To edit the 
title, right click on its description and choose the Edit menu option. 

Note:  Again, import from a simple path like single directory on the root drive.  Otherwise, 
this will generate error messages and access violations that prevent importing of the file.  For 
example, all imports should come from a directory like C:\ImageFiles.   

Any file type can be stored in the DocMan application.  However, in order to view a file, an 
appropriate hosting application must be installed on the computer.  DocMan is capable of viewing the 
following file types: .jpg, .bmp, .png, .tif, and .gif.  Other types of files, such as MS Word documents 
(.doc) and Excel spreadsheets (.xls), can be displayed assuming the computer’s program files 
includes applications such as Microsoft Word and Excel.  Also X-rays, CT Scans, MRI scans or any 
other radiological files can also be imported into and stored in DocMan, provided that the host 
application is installed on the computer where these files will be viewed from within DocMan. 

To import a file into a Reference Document folder: 
1. Click Docs on the main toolbar.  

2. Click Reference Documents icon on the main toolbar.   

OR 

Click Tools Reference Documents menu item.  This opens a Docs window. 

3. Highlight the appropriate category into which the document will be imported.  

4. Click the Import Document button (with the piece of paper icon).  

5. Browse for the correct file, and click Open.   

The document will be titled by its location in the computer’s directory. This includes the directory 
path name.   

6. Highlight the newly added document and click Edit Document (with the pencil icon) to edit its 
title.  

7. After a document has been imported and saved, a check mark will appear in the box linked to its 
description. 

8. To view a document, click the View Document icon (page with magnifying glass) or double-click 
the description. 

9. To delete a document, highlight the description and click the Delete button (red dash).  If you 
change your mind, click the Cancel button to cancel the delete process. 

10. To limit/grant access to a document, those end users with the DocMan Security privilege can click 
the padlock icon. 
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Adding Documents with Fast File 
The Fast File option allows the individual documents in a multi-page file to be quickly re-filed into 
appropriate folders. For example, if an entire patient chart is bulk scanned into one folder (see "Bulk 
Scan" for details), the document types it contains (such as progress notes and lab reports) can then be 
re-filed into those specific folders. 

Notes:     
• Fast File only works with multiple page .tif files 

• Fast File can be completed immediately after scanning/importing and saving a document. 

• If Fast filing a signed off document, the sign-off is transferred to the individual pages of the 
document when moved to a new Category. 

To Fast File documents: 
1. In the main DocMan window, select the folder that contains the bulk scan. The description of the 

bulk scan, as well as the number of pages it contains will be displayed in the right windowpane. 
Highlight the bulk scan description and click the Fast File icon on the main toolbar. 

OR 

Open the multi-page .tif file in the Image window (double-click or right-click and select view from 
drop-down menu).  Click the Fast File icon on the main toolbar. 

2. The left windowpane will continue to display available category and subcategory folders. The right 
windowpane will now show the first page of the multi-page bulk scan. Click the appropriate folder 
or subfolder to hold that document. 

3. The second page of the scan is now displayed in the right windowpane. Click the appropriate 
folder or subfolder for it. Continue in this manner until every page of the original bulk scan has 
been re-filed. 

Note:  Depending on how the user wishes to Fast File the individual pages determines the 
outcome of Fast Filing.  For example, if the end user continues to click on the same Category 
until all of the pages are stored, then this new file will be a multi-page document renamed with the 
new Category name.  If the end user clicks on one Category and then moves to another Category 
for the second page, then an individual file will be created in the first Category by that name (i.e. 
click Labs, then the newly created file will be named Labs).  This allows for the flexibility of Fast 
Filing all of the documents into one Category, or moving some individuals to their own Categories 
and some multiple page combinations into other categories.  This is especially helpful when Fast 
Filing a large bulk medical file that may contain labs, hospital reports, physician notes, 
immunization records, etc… 

4. While Fast Filing the user can choose to skip Fast Filing a page by clicking on a Blue Arrow 
located in the upper left corner of the right windowpane.  This can be helpful if the user wishes to 
remove a coversheet or other non-essential pages from this record (see "Fast Filing an Incoming 
Fax" for details). 

5. The user can also click on Rotate icon to modify the position of any page prior to Fast filing. 

6. Once all of the desired pages have been Fast Filed, the user receives the following message:  
“Would you like to save the last file?”  If the user clicks NO or clicks the right upper corner ‘X’ 
(close button), then the entire Fast File process will be canceled, leaving the Bulk file intact in its 
original Category as if no Fast Filing was done.  Then this returns them to the main DocMan 
window.  If the end user clicks YES, then the entire Fast Filing process is saved as performed. 

7. After saving the Fast Filing process, the user is asked if they “Would like to delete the bulk file?”  
If the user clicks NO, the original copy of the scanned Bulk file remains in its original Category 
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along with the newly created Fast Filed records.  If the user clicks YES, the Bulk file is deleted 
and only the newly created Fast Filed records remain. 

To move a misfiled patient document: 
1. Right-click the document description (in the main DocMan window) and select Move Document 

from the menu. Click Yes in the Confirmation window. Clicking No, cancels the process. 

2. Search for the correct patient in the Find Chart Patient window. Highlight the correct person from 
the search results and click Select. 

3. For audit trail purposes, the original patient’s record will retain an entry for that document stating 
that the document has been moved to account "XXXXXXX" (the other patient’s account number 
is inserted here). The image is visible only in the second patient’s chart. To jump directly to the 
second chart (to view the moved document in the correct location), highlight the document 
description, click Tools and select the Go to Linked Patient menu option. 

4. To return to the patient record from where the document was moved, click on document 
description; then click Tools and select the Go to Linked Patient menu option.  

Note:  You must have the DocMan Filing privilege set to read, write or read, write, delete to perform 
this function (see "Security" for details). 

To move a document to a different category within the same patient record: 
1. Right-click the document description in the Main DocMan window and select Edit. 

2. In the Edit Document window, click the drop-down arrow next to the Category field. 

3. Search and select the new category desired, and click OK. 

4. The entire file will now be listed in the new category.  The file retains its name from the previous 
category.  To edit the name, right-click the description and click Edit. 

Editing the Properties of a Patient Document 
The main DocMan window displays several document properties along with the description that are also 
search filters.   

To access these document properties: 
Right-click the image description and selecting Edit from the menu. 

OR 

Select the image description and click Document > Edit from the toolbar menu. 

This opens the Edit Document window with editable fields that correspond to the column placeholders. 
The following table describes each image that has the following column placeholders for data. 

Document Property 
Images 

 

Paper Clip icon Displayed here if an image is linked to this description.   
Red Paper icon Displayed here if this option is selected as a document property to identify this 

image file as abnormal. 
Single Red Exclamation 
Point icon 

Depending on what option is selected determines the icon displayed.  Normal 
displays no icon, Urgent displays a single red exclamation point icon, and Stat 
displays a double exclamation point icon. 

Ink Pen icon Displays Ink Pen icon if image is signed off. 
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Light Orange Clipboard 
icon 

Displays icon of associated linked form.  If no forms are linked, no icon is displayed.  
If Secure Email form is linked, a Green Clipboard icon is displayed.  If Portal 
Authorization form is linked, a Blue Clipboard icon is displayed.  If HIPAA document 
is linked, a Light Orange Clipboard icon is displayed. 

Sheet of Paper icon Displays the image page count. 
File Type icon Displays the file extension type for the image. 
Date Created (text header) Displays the date that the image file was scanned or imported. 
Description (text header) Displays the description of the image file. 
Date of Service (text 
header) 

Displays the date of service that is manually entered by end user. 

Notify Lists the login of the Ordered by Provider that was selected. (NOTE: If login appear 
in this field, only this provider may Sign-off this document.) 

Summary Displays a brief note in addition to the Description that can be added, deleted or 
edited before and after sign off. 

Some properties that are also search filters include: Description, Priority, Hold for Review, Abnormal 
Result, Date, and Category. 

Amendment Properties  
Amendment Accepted To approve the request to add the amendment to the patient’s record.   
Amendment Denied To deny the request to add the amendment to the patient’s record. 
Date Accepted/Denied Upon selecting whether the amendment was accepted or denied, a drop box will 

activate containing a full searchable calendar to indicate when the decision to 
approve or deny the amendment was made. 

Source This identifies the originator of the amendment request. 
Amendment Notes This free text box allows for the user to make additional notes and detail relevant 

information. 

To approve or deny an amendment: 
1. Open a patient’s DocMan. 

2. Highlight the document under consideration. 

3. Right-click the document and select Edit. The Edit Document screen will open. 

4. Select the Ordering Provider, as this will show who approved/denied the amendment. 

5. Under Amendment Properties, choose to Accept or Deny the amendment, select the date of the 
amendment and type any notes in the free-text box.  

6. Click OK.  

Notice that this document now has a check under the Amend column of the patient’s DocMan 
indicating that an Amendment has been made. 

Linking Forms to Patient Accounts 
Patient consent/authorization forms can be linked to the patient’s DocMan account. The following 
scanned/imported forms can be designated: 

• Secure Email Consent Form:  Gives the clinic and provider authorization to forward confidential 
patient medical information via Secure Email.  A green clipboard is displayed in this column 
designating that this form has been collected 
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• Portal Authorization Form:  Gives the clinic and provider authorization to setup a customer 
portal account whereby the patient can access clinic information and the facility can communicate 
medical information to patient.  This messaging is separate from the secure email system.  A blue 
clipboard is displayed in this column designating that this form has been collected. 

• HIPAA Form:  Confirms that the clinic has informed the patient of the clinic’s HIPAA’s policy.  
This form is signed and dated by patient.  A light orange clipboard is displayed in this column 
designating that this form has been collected. 

Notes:     
○ A rule in Rule Manager can be setup to message the patient when the Portal Authorization is 

about to expire (see "Rule Manager" for details). 

○ The HIPAA Form preference defaults to a four-month expiration date.  

These properties can be modified before and after sign off. 

Note:  This box must be checked prior to being able to send Secure Email for this patient. 

These properties can be modified only prior to Sign-Off.  Once singed off the properties cannot be edited. 

To use a Secure Email form: 
1. Right-click the document description and select Edit from the menu.  

OR 

Open the document in the Image window.  Click on the Summary icon. 

2. Modify any of the properties shown in the Edit Tracking Item window or the Summary window and 
click OK. 

After a document has been scanned or imported, memos can be attached to that image. Memos cannot 
be edited. Permanent memos, however, can be deleted up until the time that the attached document is 
signed off. "Sticky notes" are not permanent, can be deleted at any time (even after the document is 
signed off), and do not print. 

To add a memo to a document: 
1. Double-click the document description or right-click the description and select the View menu 

option to open the document in the Image window. 

2. Click the Memo icon.  This opens the Memo window.   

3. Select either Permanent or Sticky Memo.  Type text in the memo field and click OK.  This links 
this memo to the image file.  The Memo Grid now is displayed above the image file. 

4. If prior memos exist, the Memo Grid opens above the image file.  See the "Memo Grid Toolbar 
Buttons" and "Main Grid Columns" tables below for descriptions. 

5. To add a new memo, click either the Permanent Memo or the Sticky Memo button on the left 
side toolbar of the Memo Grid.  (Do not click the Memo button located on the main toolbar; as this 
will hide the Memo Grid rather than adding a new one.) 

Notes:   
○ Permanent memos can only be edited or deleted before Sign-off.  They are signed off along 

with the main image file. 

○ Stick Notes do not print or fax.  e-MDs recommends that these notes should not contain 
patient confidential medical information as they are designed to be temporary communication 
method amongst the facility staff. e-MDs further recommends using these memos like sticky 
post it notes. 
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Memo Grid Toolbar 
Buttons 

 

Permanent Memo Used to document medical information.  
Sticky Memo Used to document interoffice communication. 
Delete Allows end user to delete, Sticky Memos and Permanent Memos that have not been 

signed off. 
Print Allows user to print memos along with linked document. 
Padlock Security Allows user with DocMan privilege to restrict access to image files per login. 

   

Main Grid Columns  
Type Lists type of memo created.  
Create Date Lists date memo was created. 
Created By Lists the name and login of the user who created the memo. 
Priority (This column currently is not being populated with data.) 
Memo Lists a summary of the text included in this memo. 
Addendum Used to identify if this memo was created after signing off a Permanent memo.  If 

checked this memo was created. 

Linking Associated Labs to the Same Memo 
In the memo window, a new field and functionality was developed to provide users the ability to create a 
memo for one CPT (or HCPCS) order and link this memo to a group of associated Laboratory Orders 
added to the same Chart Visit or Order Note. 

In a table format, the associated CPT (or HCPCS) orders and descriptions are listed that were: 

• Set for Lab Tracking 

• Added to the same note as the current CPT (or HCPCS) order 

• Were scanned/imported into DocMan at the same time 

For example, user sets CPT (or HCPCS) codes XXXXX, YYYYY, ZZZZZ for Lab Tracking under the 
Details section of each code. User then creates a Chart Visit or Order Note and orders all three of these 
CPT (or HCPCS) codes within the note. 

Thereafter, these labs are received by the clinic and scanned into DocMan. Upon scanning, the user 
checks off the CPT (or HCPCS) codes for these labs that are pending in Lab Tracking window which now 
links these CPT (or HCPCS) codes to this DocMan document. Once scanned in, the user views one of 
these DocMan documents in the Image window. When creating a memo, the other two CPT (or HCPCS) 
codes and descriptions from the Chart Visit or Order Note will be listed in the upper-right corner of this 
memo. 

At this time, you can either: 

• Can create a memo for this CPT (or HCPCS) code linked Document only OR 

• Can check the “Add memo to ALL associated labs” box and click OK to add this memo to all 
associated CPT (or HCPCS) code linked Documents 

• The memo can then be viewed by opening each of the CPT (or HCPCS) code linked Documents 
stored in DocMan or through Labs/Tests in Chart View, which basically launches the Image 
window to display this memo. 
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Adding a Summary to a Document 
After a document has been scanned or imported, a summary can be attached to that image. The 
summary is displayed along with the document description in the main DocMan window. A concise 
summary can alleviate the need to actually view the image. Summaries can be added or edited before 
and after the document is signed off. 

To add a summary to a document: 
1. Double click the document description or right click the description and select the View menu 

option to open the document in the Image window.  Click the Summary icon. 

OR 

Right-click on the document description in the main DocMan window and select Edit.  This opens 
the Edit Document window 

2. Type text in the Summary memo field and click OK. (Other properties such as Abnormal Result, 
Hold for Review, and Priority Status can be addressed in this window as well.) 

3. If viewing through the Image window, click the Save button and then the Close button.  This will 
then close the Summary window.  Click the Exit button to return to the main DocMan page. 

4. In the Edit Document window, click OK to save the Summary memo and to close this window. 

Notes:     
○ Once added, to edit a Summary, right click the document description and click Edit or open 

the document in the Image window and click the Summary icon to modify or delete.  Or re-
open in the Image window and click the Summary icon to modify or delete. 

○ Once opened, the screen will display the Summary window when this image file is re-
accessed.  If the Summary window is closed prior to exiting the Image window, when re-
accessing the Image window, the Summary window is closed. 

Signing Off Documents 
Signing a document makes it a permanent part of the patient record, which cannot be deleted.   This also 
now includes the ability to add a rubber stamp statement along with a healthcare provider signature to all 
(.tif) documents.  This process involves adding an image file containing date, time, rubber stamp, 
comments and a healthcare provider signature literally on top of the DocMan image file (see "Signatures" 
for details). 

If the patient being signed off also has a Portal account, two other options will be active to sign off and 
make the document available in the patient’s Portal. Those are: Sign off Only/ Push to Portal and 
Rubber Stamp Sig…/Push to Portal. When you select the option for Rubber Stamp Sig…/Push to 
Portal, the menu icon changes to a rubber stamp with a global icon on top of it. 
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If you select the Sign off Only/Push to Portal option, the icon changes to a blue pen with the global icon 

on top . 

Note:  Signatures are scanned and saved as .tif files.  If user attempts to import a non-.tif file, an error 
message is launched which states that “the imported signature file is not the correct size” and the import 
process is cancelled (see "Signatures" for details). 

The Rubber Stamp editor can be accessed through the Control Panel or by clicking Tools, Rubber Stamp 
from the toolbar menu (see "Reusing Statement with Rubber Stamp" for details).  Here the end user can 
create, edit and delete short statements that can be added to a DocMan file.  These can include 
statements like “Labs Reviewed,” “Refill times 2,” “Patient Notified,” etc…  These stamp statements 
default to be used by everyone one or each login can save them as Personal, whereby they only display 
for their use.  Clicking the Sign-Off button allows the end user to preview the rubber stamp and signature 
(if used). 

Memos can be attached to signed documents (see "Add a Memo to a Document" for more information).  
Once a document is signed off, any existing memos also become a permanent part of the record, and any 
memos added after that point are also permanent.  Any user with read/write access to the DocMan Sign 
Off privilege can sign a document; however, if initials of a provider are listed in the Notify column, only 
that login can sign off this document. 

After this sign off is completed, there are several cues that the document is signed off: 

• The description font is normal (bold font means that it is not signed off). 

• In the image window, the user who signed off the document is listed after Signed By. 

• The document cannot be deleted. 

• Permanent memos created prior to sign-off are also signed off and cannot be edited or deleted. 

• Permanent memos created after sign-off are automatically signed off when saved and display the 
word Addendum in red letters above the memo field. 

• No changes can be made when editing the document properties by right-clicking the document 
description. 

• A rubber stamp/signature is appended to the document. 

• The Sign-Off button is disabled when clicking on the description. 

• Sign off can be done with or without a Rubber Stamp/Signature. 

• For patient’s who have a Portal account, a sign-off can be done with a Push to Portal, with or 
without a Rubber Stamp/Signature. When you select the option for Rubber Stamp Sig…/Push to 
Portal, the menu icon changes to a rubber stamp with a global icon on top of it.  If you select 
the Sign off Only/Push to Portal option, the icon changes to a blue pen with the global icon on 
top. 

To sign off a document: 
1. On the main DocMan screen, highlight the document’s description and click the drop-down arrow 

(Sign-Off Type) next to the Sign Off icon. 

OR  

Open the document in the Image Window and click the drop-down arrow (Sign-Off Type) next to 
the Sign Off icon. 

OR 

Right-click a document description and click Sign Off Only or Rubber Stamp/Sig… 

OR 
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If the patient has a Portal account, click Sign Off Only/Push to Portal and Rubber 
Stamp/Sig…/Push to Portal. 

2. You can click one of the menu items to set your preference. Once set, you should not have to 
click the drop-down arrow unless you want to change this preference. 

 
Sign Off Only (Ink Pen icon) allows the end user to sign-off their documents with one or two 
clicks (depending if the user opts to not display the Signoff Confirmation window). 

a. To Sign Off Only, set the preference to Sign Off Only as above. 

b. Click the Sign-Off button. 

c. Click Yes if the Signoff Confirmation Window is displayed (if not displayed then you checked 
the box to no longer display this confirmation window). 

d. Document should now be signed off. 

Sign Off Only/Push to Portal (Blue pen icon with a globe icon on top) 

a. To Sign Off and push to a patients Portal account, set the preference to Sign Off Only/Push 
to Portal as above. 

b. Click the Sign-Off button. 

c. Click Yes if the Signoff Confirmation Window is displayed (if not displayed then you checked 
the box to no longer display this confirmation window). 

d. Document should now be signed off. 

 

Rubber Stamp/Sig… (Gold rubber stamp icon) allows the end user to add a rubber stamp and/or 
signature to a .TIFF document. 

a. To sign off with the Rubber Stamp/Signature, set the preference to Rubber Stamp/Sig as 
above. 

b. If this document is NOT a (.tif) file format, clicking the drop-down arrow (Sign Off Type), the 
Rubber Stamp/Signature is not available.  Then Sign-Off will proceed as if the Sign Off Only 
option was selected. 

c. If this document is a (.tif) file format, selecting the Rubber Stamp/Signature option changes 
the icon to a stamp icon.  Then the Rubber Stamp Sign Off window is displayed and you can 
choose the desired rubber stamp, can add a details statement and/or signature (if on file).  By 
default, the date and time will be added to all rubber stamps.  If you do not have a signature 
on file, the file will be stamped as "Electronically Signed By Provider." You can also 
create/edit rubber stamps from within this window. 

d. Prior to clicking the Sign-Off button, you can click the Sign Off Preview button to preview 
the Rubber Stamp and Signature, as it will appear on the document. 

e. Click the Sign-Off button on the Rubber stamp sign-off window.  You will then be asked to 
confirm the sign off.  If you click Cancel, the sign off is canceled.  Deleting the Rubber Stamp 
and Signature annotation, also cancels the sign-off process. 

f. If you click Yes, a square box-shaped cursor is displayed when placing the cursor over the 
image file (this is the same cursor icon seen when using the ZOOM function).  When you 
have located the spot where you will be adding the rubber stamp/signature, hold down the 
left mouse button, and move the mouse to the left to expand the box.  After releasing the 
mouse button, the rubber stamp with signature will be displayed. 

Note:  If you attempt to place the Rubber Stamp/Signature image file outside of the DocMan 
image file’s boundary, a message will warn you that the "signature is out of bounds please try 
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again".  If this occurs, the sign-off process has been cancelled.  Re-click on the Sign-Off 
button to start the process anew. 

g. Left-clicking the Rubber Stamp/Signature image file will make it active. By placing the 
cursor (now displayed as a pencil) over the active box and holding down the left mouse 
button, you can drag the entire image anywhere on the DocMan image file.  Placing the 
cursor on any corner box reference point and holding down the left mouse button allows re-
sizing of the Rubber Stamp/Signature image file. 

Note:  After the Rubber Stamp/Signature image file has been placed correctly on the 
DocMan image file, if you choose to move it again outside of the boundary, you WILL NOT be 
warned about the boundary limits.  It may appear that the Rubber Stamp/Signature image file 
is being placed without problems, but after you close out of the document, if the Rubber 
Stamp/Signature image file is not placed within the correct boundary, it may not be displayed 
correctly or at all.  If unsure, delete the Rubber Stamp/Signature image file and restart the 
sign-off process. 

h. If this DocMan file requires a Rubber Stamp/Signature image file on each page of a multi-
page document, simply repeat the steps above on each page. 

Note:  After adding a Rubber Stamp/Signature image file to the first page, if you click on 
another page of this multiple page file, this Rubber Stamp/Signature is now permanent on 
this page.  It cannot be removed or deleted from this page. 

i. If you decide to redo the Rubber Stamp/Signature image file, you must do so prior to exiting 
the DocMan image page if adding a Rubber Stamp/Signature to one page only or done prior 
to clicking on another page of a multiple page image file.  Place the cursor over the Rubber 
Stamp/Signature image file, Left-click (makes the Rubber Stamp/Signature active), and click 
the Delete button on the keyboard. 

j. After you are satisfied with the Rubber Stamp/Signature image file, click the Exit button on 
the toolbar or the right corner X to close the Image page.  Note that the text is now normal 
font and if you view the file, the Rubber Stamp/Signature image file will be displayed on the 
DocMan file as well as the Sign-Off button on the toolbar will be disabled. 

Notes:     
○ If you have chosen to add a Rubber Stamp/Signature but click CANCEL in the CONFIRM 

screen when signing off the DocMan file, you will still be able to add the Rubber 
Stamp/Signature.  However, the DocMan file will NOT be signed off.  This can be useful if 
the staff needs to add multiple rubber stamps prior to final sign-off by the ordering 
provider.) 

○ Signing-off a document when not using a Rubber Stamp adds a Date and Time stamp to 
Image page. 

Rubber Stamp/Sig…/Push to Portal (Gold rubber stamp icon with a globe icon on top) allows 
the end user to add a rubber stamp and/or signature to a .TIFF document. 

a. To sign off with the Rubber Stamp/Signature and Push to Portal, set the preference to 
Rubber Stamp/Sig…/Push to Portal as above. 

 

Signing Off Multiple Documents – Sign-Off Only Preference 
Users can now sign-off multiple documents with the Sign-Off Only option. 

To log off multiple documents: 
1. Log in to DocMan. 

2. Search and select a patient record with linked documents. 
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3. Click Show All Documents or click on a specific Category folder or search for documents by 
filters to display documents in the Main DocMan grid. 

4. Click to select one document. 

5. Hold down the Shift key and left-click the last document description in the list of documents.  This 
highlights all of these documents. 

6. Set Sign Off Type to Sign Off Only preference. 

7. Click the Ink Pen icon. 

8. Click Yes if the Signoff Confirmation window is presented. 

All of the highlighted documents are now signed-off as noted by the ink pen icon in the associated 
column. 

Note:  Currently users cannot sign off multiple documents using the Rubber Stamp/Sig 
preference. 

Reusing Statements with Rubber Stamp 
The Rubber Stamp feature allows users to create, edit and delete short statements that can be attached 
to DocMan scanned images (.tif files).  Once created, these statements can be reused whenever 
necessary.  The purpose of these stamps is to allow you to add information to scanned DocMan 
documents such as lab results or refill requests.  For example, you can include statements like "Labs 
Reviewed," "Refill times 2," "Patient Notified" or any type of information that needs to be added to a 
document. When creating these stamp statements, the default setting is to allow all users to access them, 
but users can also save them as Personal stamps to restrict access to the person logged in when they 
are created.  These Rubber Stamps can be used in conjunction with the Signature feature to sign off 
DocMan documents. 

Note:  This functionality is limited to DocMan documents that are images (.tif files) that have been 
scanned or imported into DocMan.  They CANNOT be used with DocMan files such as HL7 lab results, 
Word documents, Excel files, Adobe PDF files, .jpg image files, .bmp image files, etc. Currently the 
Rubber stamp option is disabled for all file types other than .tif files. 

Accessing the Rubber Stamp Editor 
The Rubber Stamp editor is the module that is used to create, edit and delete rubber stamp statements.  
It is accessible from the main DocMan application, and also from the DocMan viewer. 

To access the Rubber Stamp editor from DocMan: 
1. Log into DocMan through Dashboard or from the DocMan shortcut in the Start > Programs > e-

MDs menu.  Log in using your usual Solution Series username and password. 

2. After DocMan is open click Tools > Rubber Stamp on the main DocMan menu toolbar.   

OR 

If your login has access, click the Control Panel icon and then the Rubber Stamp icon. 

3. The Rubber Stamp sign-off window will open in Edit Rubber Stamp mode 

4. Add, edit or delete Rubber Stamps as needed (see “Add, Edit or Delete a Rubber Stamp” for 
details). 

To access the Rubber Stamp editor from Chart: 
1. Log in to Chart through Dashboard or through Start > Programs > e-MDs menu, using your 

usual Solution Series username and password. 
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2. Go to Tools > DocMan on the main Chart menu toolbar. 

3. After DocMan is open, click Tools > Rubber Stamp on the main DocMan menu toolbar.   

OR 

If your user login has access, click the Control Panel icon and then the Rubber Stamp icon. 

4. The Rubber Stamp sign-off window will open in Edit Rubber Stamp mode. 

5. Add, edit or delete Rubber Stamps as needed (see “Add, Edit or Delete a Rubber Stamp” for 
details). 

Access to the editor from the DocMan viewer is part of the sign-off process.  When signing off documents 
users can access the editor to add, edit or delete a stamp on the fly. 

To access the Rubber Stamp editor from DocMan viewer: 
1. When viewing a DocMan document from within DocMan or as a TaskMan attachment, click the 

drop-down arrow (Sign Off Type) next to the Sign-Off button.   

2. Select Rubber Stamp/Sig menu option.  

Note:  Once this preference is set, it will continue unless changed by this login. 

3. Click the Sign-Off button. The Rubber Stamp sign-off window will open in Sign Off mode 

4. Click the Edit Rubber Stamp button icon on the toolbar. The window switches to Edit mode. 

5. Add, edit or delete Rubber Stamps as needed (see “Add, Edit or Delete a Rubber Stamp” for 
details). 

Notes:     
○ Rubber stamp field permits 75 characters. 

○ Details field permits 75 characters. 

○ Rubber Stamp and Details fields now word wrap at 55 characters and place remaining 20 
characters on second line. 

Adding, Editing or Deleting Rubber Stamps 
Rubber Stamp statements can be created for use with the sign-off process of DocMan.  The stamps can 
be created for use organization wide or only for personal use.  Once created these stamps can be edited 
or deleted. See the specific sections below for details. 

To add a Rubber Stamp: 
1. With the Rubber Stamp window open in Edit mode (see "Accessing the Rubber Stamp Editor" for 

details), click the Add button (yellow plus sign) on the toolbar.  The Edit Rubber Stamp window 
will open. 

2. Type the desired text into the Rubber Stamp field. 

3. Leave the Personal Rubber Stamp check box unchecked if you want ALL users to have access to 
the stamp 

4. Click OK when finished. 

To add a personal Rubber Stamp: 
1. With the Rubber Stamp window open in Edit mode (see "Accessing the Rubber Stamp Editor" for 

details), select the Add button (yellow plus sign) on the toolbar.  The Edit Rubber Stamp window 
will open. 

2. Type the desired text in the Rubber Stamp field. 
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3. Check the Personal Rubber Stamp check box if you want only YOU to have access to the 
stamp. 

4. Click OK when finished. 

Note:  To view Personal Rubber Stamps, you must have the Personal Rubber Stamps checkbox 
(just under the Add, Edit and Delete buttons) checked. 

To edit a Rubber Stamp: 
1. With the Rubber Stamp window open in Edit mode (see "Accessing the Rubber Stamp Editor" for 

details), select the stamp to be edited. 

2. Click the Edit button (pencil icon) on the toolbar. The Edit Rubber Stamp window will open. 

3. Make desired changes to the text in the Rubber Stamp field.   

4. Check or uncheck the Personal Rubber Stamp check box to change the status from or to a 
Personal stamp. 

Note:  To view Personal Rubber Stamps, you must have the Personal Rubber Stamps checkbox 
(just under the Add, Edit and Delete buttons) checked. 

To delete a Rubber Stamp: 
1. With the Rubber Stamp window open in Edit mode (see "Accessing the Rubber Stamp Editor" for 

details), select the stamp to be deleted. 

2. Click the Delete button (red minus sign icon) on the toolbar. 

3. At the delete confirmation message, click Yes.  The stamp will be deleted 

Viewing Personal Rubber Stamps 
When Rubber Stamps are created, the default status is set to allow ALL users to access them but the 
status can also be set restrict access to the person logged in when they are created.   

• Viewing Personal Rubber Stamps When Signing Off Documents:  By default, when using the 
Rubber Stamp feature to sign off DocMan documents, the Personal Rubber Stamps check box on 
the Rubber Stamp Sign Off window is unchecked.  This means that only the organization wide 
stamps will be accessible in the Rubber Stamp drop down field (see "Sign Off a Document in the 
DocMan" for details).  To access Personal rubber stamps, check the Personal Rubber Stamps 
checkbox. 

• Viewing Personal Rubber Stamps in Editor Mode:  When creating, editing or deleting Rubber 
Stamps in the Editor mode the default status of the Personal Rubber Stamp checkbox (just under 
the Add, Edit and Delete buttons) is set to be unchecked.  This means that only organizational 
stamps will be viewable.  To view Personal Rubber Stamps, you must have the Personal Rubber 
Stamps checkbox checked. 

Using Search Filters to Retrieve Images 
For patient records containing numerous documents, the Search filters enable the user to quickly find the 
desired document. The search is specific to the selected patient record, and does not search the entire 
database of records.  

Note:  The search criteria Priority, Hold For Review, and Abnormal Result pertain to document 
properties. See “Edit the Properties of a Patient Document” for details. 
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To search patient records for images: 
1. Click Search on the main DocMan toolbar. 

2. Choose any or all of the Search Filters and then click OK. 

Search Filter Options  
Description Enter all or part of the document description. 
Priority Select Normal, Urgent, or STAT. Select All to search documents that meet any 

other search criteria, regardless of priority status. 
Hold For Review Select Hold or No Hold. Select All to search documents that meet any other search 

criteria, regardless of Hold status. 
Abnormal Result Select Abnormal or Normal. Select All to search documents that meet any other 

search criteria, regardless of Abnormal status. 
Date Check the box to filter for documents added within a specified date range. 
Category Select a document category folder to find all documents contained in that folder. 

To retrieve an Image from a patient category: 
1. Click Open Patient on the main toolbar.  

2. Type the desired patient name (or other search criteria) in the Find Chart Patient window and 
click Search.  

3. Highlight the appropriate patient name from the search results and click Select. 

4. Ensure that the correct Specialty Group is chosen from the drop-down list, so that appropriate 
Category and Subcategory Folders are displayed in the left windowpane. 

5. In the left windowpane, highlight the Category or Subcategory in which the document is likely to 
be found. A description of every document in the selected folder will display in the right 
windowpane.  

OR 

Click the Show All Documents button on the main toolbar for a listing of every document for that 
patient.  

OR 

Click Search to find a document using specific search filters (see “Document Search Filters” for 
details).  

6. Right-click the appropriate document description and select the View menu option. This will open 
the selected document in the Image window. Another way to open the document is to double-click 
the document description. 

To retrieve an image from a reference documents category: 
1. Click the Reference Documents button on the main toolbar. 

2. Search for the document in one of three ways: 

Search by either Document Code (Doc Code) or Document Description (Doc Description) in 
the upper search field. 

OR 

Select the most appropriate Category.  The selected category will then display the descriptions of 
every document it contains in the left windowpane. 

OR 
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Click the Search button (with the magnifying glass) to display a list of all documents in the right 
windowpane. 

3. To view the document in the Image window, either double-click its description, or highlight the 
document description and click the View Document button (with the magnifying glass icon). 

Deleting a Patient Document 
The main DocMan window displays a description for each image. Images that have not been permanently 
signed off can be deleted from the application.  

Note:  If an image has been misfiled, it can be moved rather than deleted. See "Move a Misfiled Patient 
Document" for more information. 

To delete a patient document: 
1. Right-click the document description (in the main DocMan window) and select Delete from the 

menu. At the Confirm window that states, “Only documents that are not signed off can be deleted.  
Do you want to delete the selected record(s)?” select No, Cancel or the right upper corner ‘X’ to 
close the window.  This stops the delete process. 

2. Clicking Yes, deletes the record from the patient main DocMan Grid. 

Note:  If the image has been signed off, a message appears stating “Only documents that are 
not signed off or read only can be deleted.” 

Comparing Images 
End users can now place two .JPG image files, (e.g. diagnostic files like X-Rays, EKGs, CT scans) side-
by-side for viewing comparison. 

To compare images: 
1. To get started, select the appropriate Medical Specialty.  Next, create a Category folder and 

name it something like JPG Images.  This will help to quickly identify those .JPG files that can be 
loaded into this Viewer.  See “Create Category Groups” for more information. 

2. Import .JPG files into this Category folder.  See “Import a File” for more information. 

3. Once the files have been imported, click to Select the JPG Images Category.  This displays all of 
the .JPG files imported into this Category. 

4. Click the Compare Images icon which opens the Viewer.  Whatever .JPG file that was selected 
will be displayed in the left pane.  ZOOM IN and ZOOM OUT buttons allow for resizing of the 
image.  The Rotate button turns the image 90 degrees with each click. 

5. In the right pane, the first .JPG image may be displayed or another .JPG file may already be 
loaded.  To change the image file loaded, click on the drop down arrow next to the .JPG file 
description. ZOOM IN and ZOOM OUT buttons allow for resizing of the image.  The Rotate button 
turns the image 90 degrees with each click. 

6. Click the right upper corner X to close this viewer. 

Note:  Another tip to help identify .JPG files within all Categories, would be to edit the Description 
add “JPG” to the name.  Then the user can search by description to locate all JPG files. 
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Sending DocMan Images through TaskMan 
DocMan supports the transmission of images through the TaskMan messaging program described later in 
this guide. 

Sending an Image when Scanning or Importing 
At the time that a new item is scanned or imported into DocMan, the user is prompted to send the image 
to the ordering provider, though this is not mandatory.  

If the image is sent, a Document Scan Notification appears in the recipient’s inbox in TaskMan. The 
image appears as an attachment to that message. By clicking on the attachment, the document is 
displayed in a DocMan viewer through Chart. The recipient can then perform all functions as in DocMan 
like view the image, add a summary or a memo, and sign it off (except for scanning or importing files) as 
well as perform any Chart functions. See "DocMan Viewer in Chart" for more information. 

To send an image when scanning a specific document type: 
1. Highlight the desired Category or Subcategory into which the document will be scanned. 

1. Click the New Document icon on the main toolbar. If Document Types have been created for the 
chosen Category (or Subcategory), the Documents window will pop up.  

2. Select Send message option.  If this option is selected, this enables the Ordered by provider 
field.   

3. Select the ordering physician in the upper-right Ordered by provider field.   

4. Click the Search button (labeled "…") and select the appropriate provider.   This provider will be 
the recipient of the message in TaskMan. 

To send an image when bulk scanning documents: 
1. Highlight the desired Category or Subcategory information for which the document will be 

scanned, and then click New Doc on the main toolbar.  

2. If no Document Types have been created for the chosen Category or Subcategory, a message 
states "There are no scan types available. Do you want to bulk scan to this category?" Click Yes.  

3. This will open the Document Info window, allowing the user to send the image to the appropriate 
provider (via TaskMan) as discussed above.  

To send an image when importing documents: 
1. Highlight the desired Category or Subcategory information which the document will be imported. 

2. Click Tools on the main toolbar, and select either the Import Folder or Import Document menu 
options. Browse for the correct folder or document, highlight it, and click OK or Open.  

3. The Document Info window will open. Select the ordering physician in the upper left Ordered by 
provider field. Click the Search button (labeled "…") and select the appropriate provider. This 
provider will be the recipient of the message in TaskMan. 

4. The next field will automatically default to the Send Image option. If this option is selected, the 
image will be sent via TaskMan to the ordering provider.  

Notes:     
○ If the Send Message/Do Not Send Message options are disabled or inactive, it is because the 

user does not have the TaskMan New Message privilege (i.e. the right to send images from 
DocMan to recipients in TaskMan.) 

○ If the user login is NOT linked to a specific staff member, the SENDER in the TaskMan 
message will be blank. 
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○ When viewing a DocMan attachment through a TaskMan message, an entry is made to the 
audit trail in the Log Viewer. 

Sending an Image at a Later Date 
At the time that a new item is scanned or imported into DocMan, the user is prompted to send the image 
to the ordering provider, though this is not mandatory. Any image can also be messaged (via TaskMan) at 
any time after it has been scanned or imported. 

When an image is sent from DocMan, a Document Scan Notification appears in the recipient’s inbox in 
TaskMan. The image appears as an attachment to that message. By clicking on the attachment, the 
document is displayed in a DocMan viewer through Chart. The recipient can then perform all functions as 
in DocMan like view the image, add a summary or a memo, and sign it off (except for scanning or 
importing files) as well as perform any Chart functions. See "DocMan Viewer in Chart" for more 
information. 

To send an image from DocMan via TaskMan: 
1. In the main DocMan window, select the image to be sent. Double click on its description, or right 

click the description and choose the View menu option. 

2. With the image open in the Image window, click Tools and select the New Message menu option. 

3. This opens a TaskMan message with the image attached.  Click to select a recipient or group 
from the User/Group short list.  Or click To > button and select the intended recipient from the 
Select Names window.  Highlight the user’s name and then click the To >> button to move the 
user into the recipient column.  (More than one recipient can be selected).  Click OK.\ 

4. Select a Priority level, if other than the default "normal". 

5. The Category determines where the image will be sorted in the recipient’s inbox. The Category 
type will default to the name of the category in which the image was stored in DocMan, but this 
can be changed. 

6. A message can be typed into the white message field, if desired. 

7. Click Send (white envelope icon). 

Graphing Lab Results in DocMan 
Solution Series provides a Graphing module that can be accessed within both DocMan and Chart.   

Creating Data Types to Graph 
When lab results are scanned into a patient’s record, an image of the lab report is saved and the numeric 
results are not recorded in a structured way. In response, e-MDs has added the ability to graph lab 
results. Manual data entry is required, but is very easy to accomplish and can be performed while viewing 
the scanned lab report on screen. We do not expect that the user will want to graph every lab, but may 
have a few key data types (such as cholesterol or HgbA1c) that are worth the effort. The user will want to 
set up the key data types in advance. 

To create a Data Type: 
1. Open DocMan and open a patient record. 

2. Click Tools on the DocMan toolbar, and then select the Graph menu option. 

3. In the Image Data/Graph window, click Result Setup. 

The Graph Data window will open, listing all existing Data Types. Click the Data Type button (with 
the icon of the yellow plus sign). 
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4. In the Image Data Type window, enter the name of the lab in the Name field (e.g., HgbA1c, 
hemoglobin, TSH, etc.). The only required field in the Image Data Type window is the Name. 

5. Enter the Unit in which the numeric lab result is measured (e.g. %, mg/dl, etc.) The graphing 
module only supports labs with a numerical result.  

6. The longer data type description does not appear on the graph, and this description field can be 
left blank. 

7. When lab results are graphed, a red horizontal bar indicates the maximum normal value and a 
blue bar represents the minimum normal value. For these bars to appear on the graph, enter the 
Minimum Value and Maximum Value expected, for children, males, and females. 

8. Click OK. 

To edit or delete a Data Type: 
1. Open DocMan and open a patient record. 

2. Click Tools on the DocMan toolbar, and then select the Graph menu option. 

3. In the Image Data/Graph window, click Result Setup. 

The Graph Data window will open, listing all existing Data Types.  

4. Highlight the desired Data Type and then click either Edit or Delete, as appropriate. 

Adding Data Points to a Graph 
Before specific data points can be graphed, the Data Type must be created (see "Create Data Types to 
Graph" for details). 

To add a Data Point to a graph: 
1. Open DocMan and open the appropriate patient’s record. 

2. Click Tools on the main DocMan toolbar, and then select the Graph menu option.  

OR 

If the lab result image is currently being viewed in the Image window, click the Graph button (blue 
graph with red line icon). 

This opens the Image Data/Graph window. All Data Types that have previously recorded values 
for the given patient are listed in the Patient Results window. 

To record an additional value for a previously recorded Data Type: 
1. Highlight the desired Data Type in the Patient Results window. When a Data Type is selected, the 

upper right window displays all prior values for this Data Type as a graph, and the lower right 
window displays the results in a grid. 

2. Click the Add button (with the yellow plus sign), located between the graph and the grid. 

3. In the Image Data window, type the numerical result in the Value field. 

4. The Date field displays the current date. To change the date of the lab result, click the down 
arrow in that field. 

5. Click OK. 
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To record a value for a Data Type not previously used for this patient: 
1. Because this type of data has not been previously recorded for the given patient, the Data Type 

will not be listed in the Patient Results window. Click Result Setup. 

2. In the Graph Data window, highlight the desired Data Type and click Add. (If the desired Data 
Type is not listed, it has never been created. For instructions on creating a new Data Type, see 
“Create Data Types to Graph.” 

3. In the Image Data window, type the numerical result in the Value field. 

4. The Date field displays the current date. To change the date of the lab result, click the down 
arrow in that field. 

5. Click OK. 

6. Click the Close button in Graph Data window.  The upper right window displays these newly 
added value(s) for this Data Type as a graph, and the lower right window displays the results in a 
grid. 

7. Click the Exit button to close the Image Data/Graph window. 

Editing or Deleting Data Points from a Graph 

To find existing data points: 
1. Open DocMan and open the appropriate patient’s record. 

2. Click Tools on the main DocMan toolbar, and then select the Graph menu option.  Alternately, if 
the lab result image is currently being viewed in the Image window, click the Graph button (blue 
graph with red line icon). 

3. This opens the Image Data/Graph window. All Data Types that have previously recorded values 
for the given patient are listed in the Patient Results window. 

4. Highlight the desired Data Type in the Patient Results window. When a Data Type is selected, the 
upper right window displays all prior values for this Data Type as a graph, and the lower right 
window displays the results in a grid. 

To edit an existing value: 
1. Highlight the value to be edited in the Data grid and then click the Edit button located between 

the graph and the grid. 

2. In the Image Data window, make the desired changes to the Value and/or Date fields. 

3. Click OK. 

To delete an existing value: 
1. Highlight the value to be deleted in the Data grid and then click the Delete button located 

between the graph and the grid. 

2. Click Yes in the delete confirmation window. 

Viewing Graphed Labs 

To view all graphed labs for a given patient: 
1. Open DocMan and open the appropriate patient’s record. 

2. Click Tools on the main DocMan toolbar, and then select the Graph menu option.   

OR 
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If the lab result image is currently being viewed in the Image window, click the Graph button (blue 
graph with red line icon). 

This opens the Image Data/Graph window. All Data Types that have previously recorded values 
for the given patient are listed in the Patient Results window. 

3. Highlight the desired Data Type in the Patient Results window.  

When a Data Type is selected, the upper right window displays all prior values for this Data Type 
as a graph, and the lower right window displays the results in a grid.  

The graph is titled with the Data Type and Patient Name, and represents numerical results over 
time. Red and blue horizontal bars represent expected maximum and minimum normal values, 
respectively. Plotted values are identified by black squares with yellow labels that display the 
individual numerical results. Successive values are connected with a black line. The horizontal 
axis, representing time, will lengthen or narrow depending on the number of plotted points. 

Printing from DocMan 
You can print to any standard printer attached to the network or workstation on which DocMan is 
installed.  You must, of course, set up that printer first so that DocMan knows what it is named and how to 
access it. 

To set up the printer: 
1. Log into DocMan. 

2. Click File and select the Print Setup menu option. 

3. Select the correct printer and number of copies, set desired properties and click OK. 

Single documents are printed from the Image window. Instructions vary depending on whether the 
document file is a single page or consists of multiple pages. 

To print a single document: 
1. Retrieve an image (see either “Retrieve an Image from a Patient Category” or “Retrieve an Image 

from a Reference Documents Category” for details).  This opens the document in the Image 
window. 

2. If the image is a single page, do the following: 

o Click File; then Print Current Page 

o Click File; then Print All 

o Click the Print Current Page (1 page only) icon on the Image window toolbar 

o Click the Print All icon on the Image window toolbar 

3. If the image contains multiple pages, thumbnail sketches of the pages appear in a vertical window 
on the left side of the Image window.   

○ To print every page of the file, click File and select the Print All menu item or click the Print 
All Pages icon on the Image window toolbar.   

○ To print a single page, select that page (either click on its thumbnail sketch or click the blue 
arrow buttons until the desired page appears in the Image window) and click File > Print 
Current Page menu item or click Print Current Page (1 page only) icon. 

4. In Printing Explanation required by HIPAA window select a reason for printing.  Per HIPAA 
regulations, when information is copied or printed from a patient record, a purpose must be 
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documented.  Examples of explanations might include "Given to Patient", "Sent to Patient’s 
Insurance Company", etc.   

5. Click OK. 

o To add to the list of possible responses, see "Document Reason for Printing Image."  

o Print Reasons can be added to all image file types (.tif, .jpg, .gif, .bmp files) and lab result 
files (HL7, QL7, & GL7). 

o For those file types that cannot be displayed in the DocMan viewer, such as Microsoft Word , 
Excel, etc… the user will need to launch the host program to print.  Print reasons cannot be 
listed for these file types.  

Note:  There is no Print Preview window.  The image is routed to the printer identified in Printer 
Setup.  See "Printer Setup" for more information. 

Multiple documents are printed from the main DocMan window. All documents whose descriptions are 
displayed in the main window will print. 

To print multiple documents: 
1. Produce a list of the desired group of images.  For example, click Show All Documents icon to 

list all images in a particular patient record.  Or, select a category folder, such as Lab Reports, to 
list all images of a particular type in that patient record.  Or, use the Search to produce a list of 
multiple images matching the search criteria, such as "all CBCs."  See "Document Search Filters" 
for more information.   

2. Click File and select the Print menu option. 

3. In the Image Print window, check appropriate boxes to indicate whether to print all documents 
and/or all pictures.  Check the Include Memos box to print existing memos along with their 
attached images.  Remember that every document and/or picture whose description appears in 
the main DocMan window will be printed if DocMan can preview this document in its viewer (e.g. 
.tif, .gif, .bmp, HL7, QL7, GL7). 

Note:  Documents that are hosted by other programs, like MS Word or Excel files, will be 
displayed as grayed out, and must be printed individually by launching the host program. 

4. Click the Print Document button (with the printer icon). Verify the printer setup and click OK. 

5. Click the Exit button to cancel all print jobs. 

6. In Printing Explanation required by HIPAA window select a reason for printing.  Per HIPAA 
regulations, when information is copied or printed from a patient record, a purpose must be 
documented.  Examples of explanations might include "Given to Patient", "Sent to Patient’s 
Insurance Company", etc.  Click OK. 

7. A “Printing Complete” message is launched when print job is done.  Click OK to close all 
windows. 

8. To add to the list of possible responses, see “Document Reason for Printing Image.” 

Any appropriate document (for example, an ECG) can be printed as a reduced, wallet-size image.  

To print wallet cards: 
1. Retrieve an image (see either "Retrieve an Image from a Patient Category" or "Retrieve an Image 

from a Document Category"). This opens the document in the Image window. 

2. Retrieve an image (see either "Retrieve an Image from a Patient Category" or "Retrieve an Image 
from a Reference Document Category").  This opens the document in the Image window. 

3. Click File in the Image window, and select the Print Card menu option.  (NOTE: If the image 
contains multiple pages, only the selected page will print.) 
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4. In the Print window, select the printer and number of copies, and click OK. 

5. In Printing Explanation required by HIPAA window select a reason for printing.  Per HIPAA 
regulations, when information is copied or printed from a patient record, a purpose must be 
documented.  Examples of explanations might include "Given to Patient", "Sent to Patient’s 
Insurance Company", etc.   

6. Click OK. 

To add to the list of possible responses, see “Document Reason for Printing Image.”   

Faxing from DocMan  
As with printing, you can set up DocMan to send output to a fax machine on your network.  As with using 
any fax machine, you must provide contact information for the fax being transmitted. 

To fax from DocMan: 
1. After an incoming fax has been re-filed to the patient record, the healthcare provider can opt to 

"fax back this document" after signing it off without printing it.  Simply select the document to be 
faxed and view it in the Image window.  Click the Fax Icon button or click File, Fax. 

2. In the Printing Explanation required by HIPAA window select a reason for printing (faxing).  Per 
HIPAA regulations, when information is copied or printed from a patient record, a purpose must 
be documented.  Examples of explanations might include "Given to Patient", "Sent to Patient’s 
Insurance Company", etc.  Click OK. 

3. This launches the Select Fax Recipient window.  (This window can be accessed also through e-
MDs Fax Monitor module by clicking the Add Recipient button.  See "Fax Monitor" for more 
details.) The fields described in the "Select Fax Recipient Options" table below are automatically 
filled in with known data from the incoming fax and patient info. 

4. Click Done to submit the fax print job to the pre-selected Fax Server for processing. 

Note:  Make sure to mark all of the check boxes of recipients listed under TO: Linked to Patient 
that need to receive this fax.  Currently, DocMan does not confirm if the fax was sent or failed.  
The Select Fax Recipient window is simply closed after clicking DONE.  If the check box is NOT 
checked, the fax will not be sent to the recipient listed.  For details on tracking outgoing faxes, 
see "FaxMan" for details. 

Select Fax Recipient 
Options 

 

Title This is the incoming fax description that is listed in DocMan. 
From This defaults to the login that is currently re-faxing the incoming document.  Clicking 

on the drop down arrow allows user to select facilities linked to this login as the 
sender. 

Additional Notes for Cover 
Page 

Allows user to add default notes to the comment box directly below the drop down 
arrow field.  Click on the drop down arrow to select a default note and then click 
ADD to move this note to the comment box.  User can also manually type notes into 
the comment box.  To create, edit or delete default notes, click EDIT button. 
This opens the Support Tables window.  Click on Comment under Table Name.  
Then click on an existing FAX group note and click EDIT.  This opens the Comment 
window so that the existing group and comment can be modified.  Clicking NEW 
opens the New Comment window.  Type FAX in the Group field and then type in 
your desired comment.  The text limit is 60 characters. Click SAVE. 
Note:  In order to view in the Select Fax Recipient window, the Comment must be 
saved under the FAX group. 
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Click to select an existing FAX group note and click Delete.  Click Yes to confirm the 
deletion 
Note:  Do not add, edit, or delete other groups or comments from the 
Support Tables as it is tied to e-MDs Bill and may be needed in one of its 
interfaces. 

To (Linked to Patient) Allows user the ability to add recipients that can be linked to this patient, e.g. default 
Pharmacy, Specialists, Patient’s personal fax, etc…. to send faxes.  These linked 
recipients can be added through the Select Fax Recipient window by clicking on the 
ADD button next to the Linked to Patient text.  OR they can be added by editing the 
Patient’s Demographics and updating Fax Contacts section. OR by opening Fax 
Monitor and clicking ADD RECIPIENT button to open the Select Fax Recipient 
window. 
Note:  In previous 5.x and 6.0 versions, if the incoming fax sender’s name and fax 
phone number was stored in the TopsData database, it was automatically added 
under the TO field when clicking to re-fax.  This functionality has been changed in 
6.1 version as the incoming fax sender’s name and fax phone number is no longer 
added automatically when re-faxing. 
To be able to re-fax an incoming fax, first verify that the fax phone number for the 
incoming fax is linked to this patient and listed under the TO (Linked to Patient) field.  
If not, add it by one of the methods listed above. 
To send a fax to any recipient, make sure to mark its check box. 

Favorite Recipients Allows users to create a default list of recipients (persons, providers, or 
organizations) that are linked to the current user that is logged in to DocMan.  This 
recipient list can be updated, edited or removed. 
You can then fax to these recipients at the same time that they are responding to 
the original sender.  To link a Favorite Recipient to this specific patient, click the blue 
arrow which to move the recipient to the To (Linked to Patient) field. 
To update the Favorite Recipient list, in the Select Fax Recipient window, click the 
Add button next to the Favorite Recipient field.  This opens the Find Fax Phone 
window.  Search for the recipient under Provider, Organization or Person filter.  Click 
Select button to add to the Favorite Recipient list. OR edit the demographics of 
current user login, and add a recipient under Fax Contacts. 

Other Fax Number Allows user to manually enter a fax phone number not currently in the database. 

If you wish to fax all of the items listed for a patient record in DocMan or items currently listed in the 
patient’s main DocMan grid, open a patient record. 

To fax from DocMan – Main DocMan grid: 
1. Click the drop-down arrow to select the desired specialty. 

2. Click Show All Documents to display all of the items linked to this patient or click on a category 
folder to display specific records linked to this patient. 

3. Click File, Fax.  At the Image Print window, click the Exit button or the right upper corner X to 
cancel the print job. 

OR  

Click on the Fax Printer icon to proceed with faxing all of these documents.  Check the Include 
Memos box, if desired.  Next, select a HIPAA reason and click OK.  This opens the Select Fax 
Recipient window. 

4. Edit the Title field to summarize this group of patient records that are to be faxed, e.g. Patient 
Name Labs, Patient Name Medical Records, Patient Name Radiology Reports, etc… 

5. Fill in the rest of the Select Fax Recipient window as desired.  For more details on completing this 
window, see “Faxing From DocMan – Re-Faxing Incoming Faxes.”  

6. Click Done and you will receive a message that the Printing Complete.  



 

e-MDs Solution Series Utilities Guide 8.0 R01 33 
 

Note:  Documents that are hosted by other programs, like MS Word or Excel files, will be displayed 
as grayed out, and must be printed individually by launching the host program.  Within that program, 
select the APF Fax printer driver from the list of available printer drivers to be able to send this file to 
Fax Monitor so that the fax print job can be sent to the Fax Server.  See Fax Help for more 
information regarding installing APF Fax Printer driver if not installed and for faxing with Fax Monitor. 

If you want to fax from different e-MDs Solution Series modules, you can submit all of the fax print 
jobs to the Fax Monitor and then send out one Fax Print job through the Fax Server.  See Fax Help 
for more information and guidance. 

Generating Custom DocMan Reports 
Custom reports can be generated in DocMan by users with the DocMan Reports privilege, authorized to 
view these reports. 

To run custom reports: 
1. Click the Control Panel icon on the toolbar. 

OR 

Click Reports, DocMan Reports from the DocMan menu toolbar. 

2. This opens the Custom Reports window. You have two reports to choose from: 

○ The first report generates an alphabetical list of all patients whose records contain scanned or 
imported images. 

○ The second report produces a list of all images contained in the selected patient’s record, 
including items such as date and time entered, description, number of pages, Type, and 
Scanned by.  Must open a patient record to run this report and display results.  If this report is 
run with the Fax Filing patient record (Zero Patient), a message is launched stating, “Please 
open a patient before running this report.” 

3. Click Print Report icon to print a report. 

4. Click View Report icon (or double-click the report description) to view a report on screen.  
Reports can also be printed from the Print Preview window. 

5. Click Exit to close the Custom Reports window. 

Tracking Labwork in DocMan 
Lab Tracking is an auditing report module used within e-MDs Chart, DocMan, and TaskMan to track labs, 
radiology tests and procedures by their respective CPT and HCPCS codes.  A pre-defined rule within 
Rule Manager identifies if these codes are overdue and automatically sends a message using TaskMan 
to the ordering physician and/or designated medical assistant.  CPT and HCPCS codes can now be set to 
“trackable” status, so that once they are selected within a Visit or Order Note in e-MDs Chart, a pre-
defined “clock” is started.  The due dates are based on the TYPE OF SERVICE parameter this code 
belongs to such as Diagnostic Labs, Diagnostic X-rays, and Medical Care (includes procedures). 

To access the Lab Tracking window in DocMan: 
Open a patient and click on the DocMan icon to open DocMan.  Then, within the DocMan module, 
click the lab Tracking icon on the main toolbar.   

OR 

Open a patient record in the DocMan standalone module.  Then, within the DocMan module, click the 
Tracking icon on the main toolbar.   
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OR 

Open a patient record and click Tools; then select Lab Tracking on the main DocMan toolbar. 

OR 

Open a patient record, select a specific category that is marked for tracking such as Labs, Radiology, 
etc… and click the New Document icon prior to scanning. Complete the scanning process in the 
Image window.  When you click Save, the Lab Tracking Window will open. 

OR 

Select a specific category that is marked for tracking such as Labs, Radiology, etc. and click Tools 
then Import Document from the main DocMan menu. Browse out and locate the file to import and 
click Open.  Select preferences in Document Info window and click OK.  This opens the Lab Tracking 
Window. 

To set up tracking categories in DocMan: 
1. Log into DocMan with a DocMan Administrator login. 

2. Click Control Panel and select Category. 

3. Select a category under a specialty like Labs. 

4. Click Edit and check Set Lab Tracking. 

This will launch the Lab Tracking screen prior to scanning and importing any item within that 
category. 

To access Lab Tracking – Results have arrived: 
As mentioned before, lab tracking can be accessed through DocMan in several ways: 

• Open a patient record and click the lab Tracking icon: 

Used to review the current outstanding CPT and HCPCS codes for this patient.  You can 
manually update the codes without sending a message to a Provider that the results for this lab, 
radiology test, or procedure have arrived 

• Open a patient record, go to Tools > Lab Tracking: 

Used to review the current outstanding CPT and HCPCS codes for this patient. 

You can manually update the codes without sending a message to a Provider that the results for 
this lab, radiology test, or procedure have arrived 

• Open a patient record, select a specific category such as Labs, Radiology, etc… and click New 
Document prior to scanning: 

This launches the Lab Tracking window so that you can update the codes that are pending 
(stop/prevent overdue messages), and then proceed to selecting the document type with 
sending/not sending a message to the provider that the results have arrived. 

See the Chart User Guide for more information about using the Lab Tracking window. 

Processing Incoming Faxes in DocMan 
The e-MDs faxing components allow items to be faxed directly from within the application and, as an 
option, you can also choose to set up FaxMan to accept and identify incoming faxes and temporarily store 
them in DocMan.  Storage of incoming faxes in DocMan allows you to view the faxes, to easily refile them 
to the appropriate patient’s DocMan account, and to send a message to affected parties with information 
about the item. This option can be an important step in adopting a more paperless approach to greatly 
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reduce the amount of paper and fax toner being consumed, thereby reducing office overhead.  For details 
on activating this optional functionality, see Setting Up and Maintaining FaxMan. 

The storage and refiling of faxes in DocMan is accomplished by the designation of a DocMan account 
that is not linked to a particular patient.  Normal DocMan accounts are automatically created as part of an 
individual patient’s chart.  In the case of incoming faxes there is no way to identify faxes that are intended 
for specific patients, so the faxes need to be stored in a “generic” DocMan account.  This account, for 
identification purposes, is referred to as the Zero Patient account (also referred to as Fax Filing).  See 
below for details about refiling of incoming faxes. 

Accessing Incoming Faxes 
An account that is not linked to any specific patient has been set up in DocMan to facilitate the storage 
and refiling of incoming faxes.  This account is designated as the Fax Filing window or Zero Patient 
account in DocMan. The received faxes in this window can also show which faxes belong to which 
groups. Hovering over a received fax in the list causes the Fax Group, to which the fax belongs, to 
become highlighted.  
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Fax Groups are used to presort incoming faxes based on the phone line on which they are received. In 
other words, fax phone lines are associated with fax groups. (See Creating and Maintaining Fax Groups 
and Maintaining Fax Line Numbers for more information.)  The pane in the lower-left corner allows you to 
control which group(s) faxes are visible on this screen. You can select one, more or all of the listed 
groups to view the faxes for those groups. If you have selected a group with no faxes in it, the Items 
Found list will appear blank after you click the Reset List button. Your selection will be retained on this 
screen until you select more (for example “All Fax Groups”) or deselect your preferred group(s). After 
changing your selections in this pane, click Reset List to update the screen results.  

To access the Fax Filing window (the Zero Patient Account): 
1. Open DocMan as a standalone application  

OR 

Open the Chart application and open a patient’s chart; then open that patient’s DocMan account 
by clicking the DocMan icon on the chart toolbar. 

2. After DocMan is open, click the Filing button on the main DocMan toolbar. 

The Fax Filing (Zero Patient account) will open.  This account looks much like a regular patient’s 
DocMan account with some exceptions.  One of the differences is that there is no patient name, 
date of birth, or account number information displayed other than Fax Filing.   

3. Go to Document > Filing Preview on the DocMan menu toolbar 

OR 

When in the Fax Filing window, click the button on the main DocMan toolbar labeled Refile (next 
to the Filing button). 

Note:  If a file type other than .TIF is selected in the list of files, the fax viewer will not display 
regardless if the Filing Preview option is selected. 

Refiling Incoming Faxes 

To refile incoming faxes: 
1. After the Fax Filing window (or Zero Patient account) is opened, a list of incoming faxes (if any 

exist) is displayed in the top-right part of the screen below the menu and toolbar along with a fax 
viewer at the bottom-right below the list of incoming faxes. 

2. Click any of the images in the list to cause the selected fax to be displayed in the fax viewer. 

3. View the fax to obtain information such as which patient the fax contains information about and 
what provider needs to be informed of this information. 

4. After the appropriate information is obtained, click the Refile button on the main DocMan Toolbar 
to refile the fax. 

5. A Refile Document window will open.   

This window is split into three main columns along with a preview pane at the bottom.  The left 
column displays a list of categories.  This list designates the category the fax will be refiled to. At 
the top of the middle column is a field that lists the fax Description.   

5. Type in the Description field or select one or more documents descriptions from the Document 
Description window. 

To select from the Document Description window: 

a. Click the … button to the right of the Description field. 

The Document Description window will open (if document descriptions have been created for 
the category chosen in the left column).   
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Note:  If there are no descriptions for the selected category a message will be displayed that 
indicates:  “There are no lookup document descriptions present for the selected category”. 

b. Select one or more descriptions for the document from the list by clicking the check box next 
to each desired description.   

c. Click OK when finished. 

The selected descriptions will be appended to the description.  You may also choose to 
highlight the description before clicking the … button and selecting the description(s).  This will 
cause the selection to overwrite the highlighted description. 

6. To provide a summary of information about the document, type free text in the Summary field 
(immediately below the Description field). The summary is displayed along with the document 
description in the main DocMan window.  A concise summary can alleviate the need to actually 
view the image.  You can also add or edit summaries at any point, even after a document has 
been signed off. 

7. Select a patient in the Patient Search field to re-file the document into their DocMan account.  

To select a patient: 

a. Click the … button to the right of the Patient Search field.  This will open the Find Chart 
Patient window.  Type all or part of the patient’s last name into the Name field and click 
Search. 

b. In the search results returned, highlight the desired patient’s name and click the Select button. 

The Find Chart Patient window will close and return to the Refile window with the selected 
patient’s name in the Patient field. 

8. Select the appropriate search filters in the group of check boxes next to the Patient Search field.  
They include: 

○ Abnormal:  Checking this box marks the document as containing an abnormal result and 
causes the document name to be displayed in DocMan with a red icon.  If the document is 
linked to an order being tracked for the patient, checking this box will also update the status of 
the linked order to Abnormal in the Order Tracking module.   

○ Hold for Review:  Checking this box identifies the document as being held for review and the 
Search function filters documents to include Hold for Review items in the search. 

9. In the Priority field (immediately below the Patient Search field), select the priority for the 
document and any message that is sent with the document attached. 

The priority level always defaults to Normal.  To designate the document and message as 
something other than Normal, click the down-arrow at the right of the Priority field and select a 
different level from the drop-down menu.  The other choices are Urgent and Stat.  Urgent labels 
both the document and the message with one red exclamation point.  Stat labels both the 
document and the message with two red exclamation points. 

10. Click the drop-down arrow next to the Required Form field to display the forms that can be linked 
to this document.  They include: 

○ Secure Email 

○ Portal Authorization 

○ HIPAA document 

11. To the right of the Required Form field, set the date value, as appropriate: 

○ Create Date:  Displays the date the document was scanned or imported.  This field is not 
editable. 
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○ Date Of Service:  Allows you to add a date of service for this document, such as a date of 
diagnostic test, procedure or medical evaluation.  Click the drop-down arrow to open the 
Calendar screen for setting the desired date. 

12. Select a name in the column on the right side (labeled Send Message To) to create a message 
to the selected user telling them about the document that is being refiled.  When the message is 
sent the document, as well as the patient’s chart, will be attached to it. 

Note:  If no message is to be sent, highlight None at the top of the Send Message To list. 

13. In the Ordered by Provider section, select the name of the provider whose initials will display 
under Notify in the Main DocMan window.  If no one is to be selected, select the None option. 

14. When all appropriate fields are filled out, click OK to refile the document and send the message. 

Printing Incoming Faxes 
At times it may be necessary to print an incoming fax directly from the Fax Filing Window.  

To print incoming faxes: 
1. With the Fax Filing Window open, highlight to select the incoming fax to be printed. 

2. Click Print or Print All at the top of the fax viewer window. 

OR 

Open the incoming fax in the Image window and click File Print current page or Print All 

OR 

Click Print Current Page (1 page only) or Print All Pages icon from the Image Window toolbar. 

Deleting Incoming Faxes 
If Incoming Fax Monitoring is turned on, all faxes coming through the FaxMan will eventually be stored in 
DocMan.  This may include faxes that are not patient related or that might be junk faxes.  These faxes will 
usually need to be deleted from the Fax Filing window at some point.  

To delete an incoming fax: 
1. With the Fax Filing Window open, highlight to select the incoming fax to be deleted. 

2. Right-click on the highlighted fax and select Delete from the pop-up menu. When asked to 
confirm the deletion, click Yes.  

OR 

To cancel the deletion, click No, Cancel or the x in the upper-right corner of the confirmation  
window. 

Fast Filing Incoming Faxes 
You can also Fast File incoming faxes as they are converted into (.tif) file format when stored in DocMan.  
This is useful when receiving bulk fax reports like labs or radiology reports from a hospital that may 
contain several patient files in one fax job.  You can also use this feature to remove an unwanted cover 
sheet from a fax. 

To Fast File incoming faxes: 
1. Prior to Fast Filing, go to Control Panel > Category and create category folders for Fast Filing 

records temporarily.  This allows you to separate the individual reports so they can be refiled into 
specific patient records. 

2. Highlight the incoming fax file to be Fast Filed and click the Fast File icon.   
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3. As when Fast Filing in a patient record, click on the category where this page needs to be filed.   

4. When done, click Yes to save the last file, and then decide to save or not save the bulk file after 
Fast Filing. 

To Fast File without a fax cover page: 
Option #1 

1. Log into DocMan and access the fax filing record where the incoming faxes are stored. 

2. Through the Control Panel and with a login that has DocMan Admin rights to create categories, 
create a category called Incoming Faxed Cover Pages. 

3. Select an incoming fax and click the Fast File button. 

4. When the Fax Cover Page is displayed, click on the Incoming Faxed Cover Pages category 
created above. 

5. When you have finished Fast Filing remaining documents, either maintain the fax cover page to 
reference later or delete it from this category. 

Option #2 

1. Log into DocMan and access the fax filing record where the incoming faxes are stored. 

2. Select an incoming fax and click the Fast File button. 

3. When the Fax Cover Page is displayed, click on blue right-arrow to skip the cover page. 

4. Begin Fast Filing the remaining pages by clicking the desired category. 

5. When done, click Yes to save the last page of the file; then click Yes or No to delete the bulk file. 

6. The cover page will then not be Fast Filed. 

Separating a Bulk File with Fast Filing 
If you choose, you can scan or import bulk files into the Fax Filing patient record. However, at times, you 
may prefer to scan/import records from multiple patients as one bulk file and then separate them by fast 
filing. This can be accomplished by creating a set of generic categories to which these files can be Fast 
Filed temporarily until they can be imported into the correct patient record. 

To separate a bulk file with Fast Filing: 
1. Log into DocMan and open the fax filing record.   

2. If you are in a patient record, click on the Filing button located next to the scanner button icon.   

Use a DocMan login that has DocMan Admin privileges to create a main category (for example, 
one called Incoming Labs), and then five sub-categories, like so: 

 Main Category: Incoming Labs 
 Sub_Category:  Incoming Labs - Patient #1 
 Sub_Category:  Incoming Labs - Patient #2 
 Sub_Category:  Incoming Labs - Patient #3 
 Sub_Category:  Incoming Labs - Patient #4 
 Sub_Category:  Incoming Labs - Patient #5 
 

3. Place the bulk set of paper records into the scanner and proceed to scan the records into the 
newly created category. 

OR 

If importing, select the newly created category and follow the steps to import this newly created 
category. 
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4. Once scanned or imported, select the bulk file and click the Fast File button. 

5. When a patient record is displayed, click the category to which you want to Fast File this patient 
record.  

6. When you get to a new different patient, select a different patient category and click the blue 
arrows to navigate within the file without Fast Filing and to skip any pages desired.  

7. Finish Fast Filing the remaining pages by clicking on the desired sub category. 

8. When complete, click Yes to save the last page of the file; then click Yes or No to delete the bulk 
file. 

Individual patient records should now be separated into different categories as different files. 

Note:  Create as many subcategories, as needed, based the number of categories required on the 
largest amount of different patient records you have scanned in or imported. Create others such as 
one for pharmacies, labs, imaging centers, insurance companies, and so forth. 

Reassigning Misplaced Faxes in DocMan 
If a fax is accidentally routed to an incorrect fax group through FaxMan, you can reroute the fax through 
the DocMan interface.  For example, if a fax is received on the Clinic A fax phone line, but it should have 
gone to the Clinic B fax phone line, the fax will be incorrectly routed to the Clinic A Fax Group. In order 
for Clinic B to ever “see” the fax, it must be moved to the correct fax group or to the Default Fax Group, 
which is visible to all users. 

To reassign a fax to a different fax group: 
1. On the Fast Filing screen, click to select the fax to be reassigned. 

Note:  If necessary, you can select more than one fax to be reassigned. 

2. In the Fax Group list (lower-left pane), double-click the name of the group to which the fax should 
be reassigned.  

Note:  If the correct fax group is not listed, you do not have access to that group.  In that case, 
double-click the Default Fax Group option. Because all users have access to the Default Fax 
Group, the users in the correct fax group will be able to access the reassigned fax for processing. 

The following confirmation window will appear, reflecting the name of the actual fax group 
selected. 

 
3. Click Yes to confirm the reassignment. 

OR 

Click No if you do not want to complete the change. 

This reassignment activity will be tracked and viewable in the DocMan audit trail. 
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Using the DocMan Viewer in Chart 
Documents stored in DocMan can also be viewed from within the patient’s chart without opening 
DocMan. 

To access DocMan within Chart: 
1. Search and select a patient record. 

2. Go to Chart View > Documents. 

On the left side, the document descriptions are displayed by Category that contains linked 
documents in tree format. 

3. To view a DocMan document, click on the document description with the orange paper icon. 

Note:  Currently only those categories and subcategories with linked documents will be 
displayed in this viewer. 

4. On the right side, a DocMan viewer displays the same DocMan view as shown when viewing the 
Image page within DocMan. 

End users can perform all DocMan functions within the viewer as done within Main DocMan page 
and Image page except scanning and importing including, faxing, printing, adding/deleting/editing 
memos, updating FlowSheets and Lab Tracking, performing refills, and sign-off 

Note:  To help prevent conflicts, end users should not document into both the DocMan displayed 
in Chart view as well as the DocMan running in the Dashboard (or DocMan stand-alone or 
DocMan launched from within Chart) while both are up and running. 

Using the ABN/Forms Manager Work List 
The ABN/Forms Manager is a work list that is populated when policy requirements are satisfied by Word 
forms or scans/files being linked to the requirement.  The policy requirements must be triggered by having 
them linked to a patient case. 

The forms manager is available from the CPT/HCPCS Alerts window as well as from DocMan.  When 
used in an alert it is a work list for a patient that lets you open, save, view and scan forms.  When used in 
DocMan, it lets you link a document that has already been scanned for the patient using the normal 
DocMan scanning functionality. 

To satisfy forms-based tasks from the CPT/HCPCS Alert Window: 
See the Bill and Schedule user guides. 

Linking Scanned Forms to Alert Tasks 
These instructions assume that the form has already been scanned into the patient’s folders in DocMan.  
This tool lets you link the document to a task so you do not have to delete it and then rescan. 

To link a form scanned in DocMan to an alert task: 
1. Open the patient in DocMan. 

2. Select the document you need to link. 

3. Click Tools > ABN/Forms Manager.  You can also click the toolbar button which looks like a 
piece of blue paper with a dollar bill icon sitting on it.  Another option is to open the scan and click 
the same button in the image viewer. 

4. Review the outstanding tasks in the list for the patient.  These are loaded by default. 
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5. If the task you are looking for is not in the list, you can change filters like Show Incomplete 
Tasks or Show Missing Forms to see if the task is in the list and has maybe been linked to 
another form, or has already been completed. 

6. Select the task to which you want to link this document. 

7. Review the document name in the Image field.  This is the document you selected.  If it is the 
correct one, click Link Image.  (Note that if you make a mistake, you can select another 
document and replace the link.) 

That is how alerts can be satisfied and because the requirement is linked to a case, it does not matter 
how many more times the patient visits the clinic or in the modules in which staff work.  The 
requirement is taken care of for the duration of this case. 

Understanding the DocMan Interface 
This section provides an overview of the DocMan screen options.  Use this as a reference any time you 
are not sure of which option to select when performing a DocMan task.  

 

Main DocMan Menu  
File Options  
Open Patient Opens the Find Chart Patient window, enabling the search for a particular patient 

record. 
Search Opens the Document Search window, enabling searches filtered by criteria such as 

Document Description, Priority, documents tagged as either "Hold for Review" or 
"Abnormal Result", Date, or Category. 

Security Allows end users with this privilege to: 
 Create and modify user logins, passwords, privileges, and groups 
 Set Password options 

See the Security section for more details. 
Options Allows end user to set: 

 An application timeout preference  
 The option to cancel the sign-off confirmation screen 
 The number of records listed in the main grid 

A HIPAA Document Expiration Date 
Message User Setup Allows end user to create/modify a “quick list” of recipients and recipient groups for 

messages sent in TaskMan. 
Print Setup Displays the printer dialog screen so users can select a default printer for DocMan 

printing as well as to set printer preferences. 
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Print Allows end user to print item(s) listed in main DocMan list.  This may include only 
the items listed for a specific Category or all of the items linked to this patient record 
if Show All Documents has been clicked.  Only .tif, .jpg, .gif, .bmp and HL7, QL7, & 
GL7 lab result files will be printed through this menu option.  Users can also choose 
to print the attached memos as well. 

Fax Allows end user to Fax item(s) listed in main DocMan list.  This may include only the 
items listed for a specific Category or all of the items linked to this patient record if 
Show All Documents has been clicked. Only .tif, .jpg, .gif, .bmp files and HL7, QL7, 
& GL7 lab result files will be faxed through this menu option.  Users can also choose 
to fax the attached memos as well. 

Select Twain Source Allows users to view the available Imaging Devices currently installed on this 
computer, including scanners and/or cameras that use a Twain driver. 

Exit Closes the application. 
 

Demographics Options  
Patients Opens the Find Chart Patient window, enabling the search for a particular patient 

record. 
Guarantors/Policyholders Opens the Find Guarantor window, enabling the search for a particular Guarantor. 
Persons/Contacts Opens the Find Person window, enabling the search for a particular Person record. 
Providers & Staff Allows users to search for Physicians, Physician Assistants, Nurse Practitioners, 

Clinical Staff, Non-Clinical Staff, NonStaff Providers, and All Providers. 
Organizations Allows users to search for Organizations/Employers, Insurance Companies, 

Laboratories, Pharmacies, and Employees by Organization. 
Medical Facilities Allows users to search for Internal and External Facilities. 

 
Reference Options  
Printing Reasons Opens the Reason Edit window where users can add, edit or delete reasons for 

Printing or Faxing image files. 
 
Reports Options  
Crystal Opens the Find Report window that allows users to search for, create new or 

edit/delete stored Crystal reports. 
Forms/Letters Opens the Forms/Letter editor that allows users to edit or print Forms/Letters. 
DocMan Reports Opens the Custom Reports window that allows users to view and print two reports:  

“Patients with images scanned” and “All images for a patient.” 
Log Viewer Opens the Log Viewer window that allows users to view and print an audit trail of all 

activity performed by logins in DocMan by Date and List All. 
Document Log Opens the Log Viewer window that allows users to view and print an audit trail of all 

activity performed by logins related to a specific item. 
 
Tools Options  
Record Security Allows those users with this DocMan privilege to grant/limit access to a specific 

document within a patient record. This feature is not active under the Fax Filing 
patient record regardless of the user’s privileges. 

Break Security Allows those users with this DocMan privilege the ability to override the level of 
security for the current patient. Notifies the system administrator and logs this event 
per HIPAA requirements. This feature is not active under the Fax Filing patient 
record regardless of the user’s privileges. 
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Move Document Allows users the ability to move a document or file from one patient record to 
another.  A notation of this move is added to the original patient record. This feature 
is not active under the Fax Filing patient record regardless of the user’s privileges. 

Import Folder Opens the File Directory window to allow users to search and import files within 
specific folders into a specific Category. 

Import Document Opens the Open window to allow users to search the hard drive for a specific file 
document that can be imported into a specific Category.   

Fast File Permits bulk-scanned documents to be rapidly re-filed into appropriate Category 
folders within the same patient record.  See "Fast File" for details. 

Control Panel Allows access to the Control Panel.  See "Control Panel Overview" for more details. 
Go to Linked Patient When selecting an item that has been re-filed to another patient record, allows user 

to open the patient record that received that item. This feature is not active under 
the Fax Filing patient record regardless of the user’s privileges. 

Graph Allows users to manually graph Laboratory Results. This feature is not active under 
the Fax Filing patient record regardless of the user’s privileges. 

Graph Data Type Opens the Graph Data Type window to allow users to add, edit and delete Data 
Types for manually graphing Laboratory results. This feature is not active under the 
Fax Filing patient record regardless of the user’s privileges. 

New Message Opens the TaskMan message window that allows end user to create messages 
from the DocMan Menu Toolbar. 

Lab Tracking Displays a list of pending CPT and HCPCS codes for the selected patient.  These 
pending codes can be marked as complete to prevent overdue lab messages from 
being sent. See "Lab Tracking Interface Overview" for details. This feature is not 
active under the Fax Filing patient record regardless of the user’s privileges. 

Rubber Stamp Opens the Rubber stamp sign off window where the users can add, edit, delete and 
preview Rubber Stamps. 

Signature Opens the Signature window where the users can print, scan and/or import a 
signature page.  These signatures can be appended to DocMan .tif files at Sign-Off. 

Reference Documents Permits the scanning (or importation) and storage of administrative forms that are 
not linked to specific patient charts.  See "Scan a Document into a Reference 
Document Folder" or "Import a File into a Reference Document Folder" for more 
information. 

Import CCR Allows users the ability to import CCR records into DocMan. 

ABN/Forms Manager Allows end user to track pending tasks set in Schedule/Bill and link them to an 
image in DocMan. 

 
Document Options  
New When scanning a document into the application, the user first selects the Category 

(or Subcategory) folder that will store the image, and then clicks Tools, New menu 
item. See "Scan a Document into a Patient Folder" for more details. 

Bulk When scanning a document into the application, the user first selects the Category 
(or Subcategory) folder that will store the image, and then clicks Tools, Bulk menu 
item. This opens the Image window whereby the user can scan in a bulk document. 
See "Scan a Document into a Patient Folder" for more details. 

Edit Opens the Edit Document window where the user can edit the Description and 
Summary; select filters for searching, and setting the Ordered by provider. This 
feature is not active under the Fax Filing patient record regardless of the user’s 
privileges. 

Delete Allows user to delete a document that has not been signed off. 
Filing Preview Allows user to display a preview of an incoming fax when viewing the records linked 

to the Fax Filing patient record.  Active when a check mark is displayed next to 
menu item. 
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Help Options  
Search Topic Opens the Help Search tool. 
Legend Displays legend of icons related to a specific DocMan file and action buttons used 

with all DocMan files.  These include signed/unsigned status with respect to text 
bold/not bold font, Open Patient, Show all documents, Search, New Document, 
Attachment, Grid icons (abnormal, urgent, stat), Page count, Category status, 
Secure email form, Portal authorization form, and HIPAA document.  See "Edit the 
Properties of a Patient Document" for more details. 

About Displays the DocMan version currently installed including support files. 
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Main DocMan Toolbar 

 

DocMan Toolbar Icons  
Open Patient Opens the Find Chart Patient window, enabling the search for a particular patient 

record. 
Show All Documents Displays all of the descriptions of all documents and images stored for that patient. 
New Document When scanning a document into the application, the user first selects the Category 

(or Subcategory) folder that will store the image, and then clicks the New Document 
button. See "Scan a Document into a Patient Folder" for more details. 

Import Document When importing a document into the application, the user first selects the Category 
(or Subcategory) folder that will store the image or document, and then clicks the 
Import Document button. See "Import a File into a Patient Folder" for more details. 

Scan Enabled only after canceling a scan job. 
Camera Allows end user to use an attached Camera to import photos directly into DocMan. 
Compare Images Viewer Allows end user to display 2 .JPG photo images side by side for comparison. 
Sign Off Allows users with appropriate privileges to sign-off documents, making them a 

permanent part of the patient record.  See "Sign Off a Document" for details. 
Filing Opens the Fax Filing Patient record that displays the incoming faxes. 
Refile Opens the Refile Document screen which allows users to re-file a document to a 

specific patient record.  See "Re-file Document" for details. 
Print Forms Opens the Select Form/Letter window (Forms/Letter editor) to merge demographics 

with a default MS Word Template letter and then store in a Specific DocMan 
Category.  See "Forms/Letter Editor" for details. 

Control Panel Allows access to the Control Panel.  See "Control Panel Overview" for more details. 
Reference Documents Permits the scanning (or importation) and storage of administrative forms that are 

not linked to specific patient charts.  See "Scan a Document into a Reference 
Document Folder" or "Import a File into a Reference Document Folder" for more 
information. 

Graph Allows users to manually graph Laboratory Results.  
NOTE: Not active in Fast Filing patient record regardless of privilege access. 

Fast File Permits bulk-scanned documents to be rapidly re-filed into appropriate folders within 
the same patient record.  See "Fast File" for details. 

Lab Tracking Displays a list of pending CPT and HCPCS codes for the selected patient.  These 
pending codes can be marked as complete to prevent overdue messages from 
being sent.  See "Lab Tracking Interface Overview" for details. 

Import CCR Allows end user to import or export CCR (Continuity of Care Record) files that are 
stored in DocMan. 

ABN/Forms Manager Allows end user to track pending tasks set in Schedule/Bill and link them to an 
image in DocMan. 

Messages/Task Opens the TaskMan message window that allows end user to create messages 
from the Main DocMan toolbar. 

Patient Demographics Allows end user to update/edit patient demographics from the Main DocMan toolbar. 
Refresh Allows end user to refresh the contents of a specific Category or the contents of the 

entire patient record, displaying the most recent list of files linked. 
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Legend Displays legend of icons related to a specific DocMan file and action buttons used 
with all DocMan files.  These include signed/unsigned status with respect to text 
bold/not bold font, Open Patient, Show all documents, Search, New Document, 
Attachment, Grid icons (abnormal, urgent, stat), Page count, Category status, 
Secure email form, Portal authorization form, and HIPAA document.  See "Edit the 
Properties of a Patient Document" for more details. 

Help Opens the Help Search tool. 
Exit Closes the application. 

Main DocMan Window – Patient Record 
Patient-Specific Icons 
and Buttons 

 

Break Security Padlock 
Button 

Works like the Tools > Break Security menu option.  Allows those users that have 
this DocMan privilege the ability to override the level of security for the current 
patient. Notifies the system administrator and logs this event per HIPAA 
requirements. This is not active under Fax Filing patient record regardless the 
privilege access.  

Identification Bar Identifies the patient name, display name (i.e. nickname), date of birth, age, gender 
and insurance information including Insurance company name, co-pay and percent 
insured.  Identifies the current user. 

Snapshot (Digicam) Photo Displays the most recent photo linked to this patient.  See "e-MDs Snapshot (aka 
Digicam)" and "Recording a Photograph in e-MDs Snapshot (aka Digicam)" for 
additional information. 

Document Display Located on the upper Right hand corner of the Identification bar.  Displays if a 
specific category is selected or if ALL documents are displayed. .  If user clicks on 
the PAGES icon header, the word PAGE is displayed. 

 

Document  Section  
Specialty Group A drop-down list of medical specialties. Depending on which specialty is selected, a 

different group of document folders is displayed in the left windowpane. See "Create 
Category Groups" for details. 

Document Folders (Tree 
Display) 

The left windowpane displays Document Categories (and Subcategories), identified 
by folder icons. In the example above, the Document Category "Hospital" contains 
two subcategory folders, one that stores Admission H&Ps, and one for Discharge 
Notes (see "Create Categories and Subcategories" for details). 
Gray folders are empty, and yellow folders contain images. Numbers in parentheses 
indicate the document count of a given folder. In the example above, the "Lab" 
folder contains 3 documents. 

Document Descriptions 
and Properties (Grid 
Display) 

The right windowpane displays the descriptions and properties of documents in the 
patient record.  Click Show All Documents on the main toolbar to view all images in 
a given record, or select a Category folder in the left windowpane to view documents 
in that particular category. Document descriptions are displayed by alternating light 
blue and white backgrounds in a lined table format.  Clicking on a Document 
description highlights the document. 

Across the top of the grid is a toolbar with the following functionality: 
Blue Navigation Arrows Allows end users to navigate to First/Last Page of all documents or to Prior/Next 

Page of Documents. 
Page Count Displays the page count of documents including the current page of documents 

being viewed. 
Item Count Displays the amount of documents on the particular page viewed. 
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DocMan Main Grid 
Icons and Columns 

Users can sort by column by clicking on a column header.  Clicking a column header 
replaces the header icon with a drop down/up arrow (icon header) or adds a 
down/up arrow (text header). 

Paper Clip icon Indicates that a scanned or imported Image of the selected document exists. 
Red Paper icon Indicates that the document contains an Abnormal result (see "Edit the Properties of 

a Patient Document" for details). 
Single Exclamation Point A single (urgent) or double (stat) exclamation point icon denotes this document’s 

priority status.  No icon indicates normal status (see "Edit the Properties of a Patient 
Document" for details). 

Ink Pen Indicates that a document is signed-off. 
Light Orange Clipboard 
icon 

Displays icon of associated linked form.  If no forms are linked, no icon is displayed.  
If Secure Email form is linked, a Green Clipboard icon is displayed.  If Portal 
Authorization form is linked, a Blue Clipboard icon is displayed.  If HIPAA document 
is linked, a Light Orange Clipboard icon is displayed. 

Sheet of Paper icon Indicates the total number of pages of an image document that has been imported 
or scanned.  Pages for documents not supported by DocMan viewer will display a 
‘1’, i.e. MS Word Documents. 

File Type icon Lists the file extension for the document, e.g. .TIF, .JPG, .BMP, .GIF. 
Date Created (text header) Displays the date that the document was entered into DocMan, either via scanning 

or importing. 
Description (text header) Short description of the document (see "Create Document Types" for details). 
Date of Service (text 
header) 

Displays the date of service for a particular diagnostic report, test, or procedure 
(such as a lab result, x-ray, or surgical procedure) that can be entered or modified 
by the user. 

Notify Displays the initials of the user who was selected as the Ordered By provider of this 
document (see "Edit the Properties of a Patient Document" for details). 

Summary Shows a short, optional summary of the document. 
Bold Text Indicates documents that have not yet been signed (see "Sign Off a Document" for 

details). 
Normal Text Indicates documents that have been signed off (see "Sign Off a Document" for 

details).   
Note:  When a document description of a document that is not signed off is 
selected, it loses it BOLD text.  Review the ink pen icon column to determine if 
document is signed off when selecting a document description. 

  

Main DocMan Window – Fax Filing (a.k.a. Zero Patient Record) 
DocMan defaults to this patient record when logging into DocMan. This section of DocMan can also be 
accessed by clicking on the Filing Cabinet button icon from within a patient account. 

Patient-Specific  
Section 

 

Identification Bar Identifies the patient name (Fax Filing).  Identifies the current user. 
Document Display Located on the upper Right hand corner of the Identification bar.  Displays if a 

specific category is selected or if ALL documents are displayed.  If user clicks on the 
PAGES icon header, the word PAGE is displayed. 

Specialty Group A drop-down list of medical specialties.  Depending on which specialty is selected, a 
different group of document folders is displayed in the left pane (see "Create 
Category Groups" for details). 
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Document  Section  
Document Folders (Tree 
Display) 

The left windowpane displays Document Categories (and Subcategories), identified 
by folder icons. In the example above, the Document Category "Hospital" contains 
two subcategory folders, one that stores Admission H&Ps, and one for Discharge 
Notes (see "Create Categories and Subcategories" for details). 
Gray folders are empty, and yellow folders contain images. Numbers in parentheses 
indicate the document count of a given folder. In the example above, the "Lab" 
folder contains 3 documents. 

DocMan Main Grid - 
Document Descriptions 
and Properties 

The right windowpane displays the descriptions and properties of documents in the 
patient record.  Click Show All Documents on the main toolbar to view all images in 
a given record, or select a Category folder in the left windowpane to view documents 
in that particular category. 
Note:  Users can left click to select a document description and then use the scroll 
to navigate among the document descriptions.  

Across the top of the grid is a toolbar with the following functionality: 
Blue Navigation Arrows Allows end users to navigate to First/Last Page of all documents or to Prior/Next 

Page of Documents. 
Page Count Displays the page count of documents including the current page of documents 

being viewed. 
Item Count Displays the amount of documents on the particular page viewed. 
Filing Preview Displays a preview pane of the document if this menu item is selected.   

 

DocMan Main Grid 
Icons and Columns 

Users can sort by column by clicking on a column header.  Clicking a column header 
replaces the header icon with a drop down/up arrow (icon header) or adds a 
down/up arrow (text header). 

Paper Clip icon Indicates that a scanned or imported Image of the selected document exists. 
Red Paper icon Indicates that the document contains an Abnormal result (see "Edit the Properties of 

a Patient Document" for details). 
Single Exclamation Point A single (urgent) or double (stat) exclamation point icon denotes this document’s 

priority status.  No icon indicates normal status (see "Edit the Properties of a Patient 
Document" for details). 

Ink Pen Indicates that a document is signed-off. 
Light Orange Clipboard 
icon 

Displays icon of associated linked form.  If no forms are linked, no icon is displayed.  
If Secure Email form is linked, a Green Clipboard icon is displayed.  If Portal 
Authorization form is linked, a Blue Clipboard icon is displayed.  If HIPAA document 
is linked, a Light Orange Clipboard icon is displayed. 

Sheet of Paper icon Indicates the total number of pages of an image document that has been imported 
or scanned.  Pages for documents not supported by DocMan viewer will display a 
‘1’, i.e. MS Word Documents. 

File Type icon Lists the file extension for the document, e.g. .TIF, .JPG, .BMP, .GIF. 
Date Created (text header) Displays the date that the document was entered into DocMan, either via scanning 

or importing. 
Description (text header) Short description of the document (see "Create Document Types" for details). 
Date of Service (text 
header) 

Displays the date of service for a particular diagnostic report, test or procedure 
(such as a lab result, x-ray or surgical procedure) that can be entered or modified by 
the user. 

Notify Displays the initials of the user who was selected as the Ordered By provider of this 
document (see "Edit the Properties of a Patient Document" for details). 

Summary Shows a short, optional summary of the document. 
Bold Text Indicates documents that have not yet been signed (see "Sign Off a Document" for 

details). 
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Normal Text Indicates documents that have been signed off (see "Sign Off a Document" for 
details).   
Notes:   
• When a document description of a document that is not signed off is selected, it 

loses it BOLD text.  Review the ink pen icon column to determine if document is 
signed off when selecting a document description. 

• Users can set individual specific column widths by login. 

Image Window – JPG, BMP and GIF (Patient Record) 
This image window displays jpg, bmp and gif image types. Tif file types are displayed in a slightly different 
window. 

Image Screen  
Identification Bar Identifies the patient name, display name (i.e. nickname), date of birth, age, gender, 

insurance information including Insurance company name, co-pay and percent 
insured and patient telephone number. Also includes the Document Name, Create 
Date, Date of Service, and Created by (user name and login).  If document is signed 
off, also displays Signed by (user login, date and time). 

 
File Menu Options  
Import Disabled when viewing a scanned/imported document. 
Select Twain Source Displays the available Imaging Devices currently installed on this computer, 

including scanners and/or cameras that use a Twain driver. 
Print Setup Displays the printer dialog screen so users can select a default printer for DocMan 

printing as well as to set printer preferences. 
Print First 5 Pages Allows user to print the first 5 pages of this document. 
Print Current Page Prints current page of a document displayed. 
Print All Prints all pages of a document whether displayed or not. 
Print Card Prints a wallet card size version of this document. 
Fax Allows users to Fax .TIF, .JPG, .BMP and .GIF image files. 
Exit Closes the application. 

 

Tools Menu Options  
New Message Opens the TaskMan message window that allows end user to create messages 

from the DocMan Image Menu Toolbar. 
Lab Tracking Displays a list of pending CPT and HCPCS codes for the selected patient.  These 

pending codes can be marked as complete to prevent overdue lab messages from 
being sent (see "Lab Tracking Interface Overview" for details). 

FlowSheet Opens FlowSheet window that allows users to document data.  See "FlowSheets, 
Patient Specific FlowSheets" for more information. 

 

Help Menu Options  
Search Topic Opens the Help Search tool. 
About Displays the DocMan version currently installed including support files. 
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Main Toolbar Options  
Print First 5 Pages Allows user to print the first 5 pages of this document. 
Print Current Page (1 page 
only) 

Prints the image seen on screen, 1 page only.  This does not print associated 
memos (see "Print a Document" for details). 

Print All Pages Prints all pages associated with the document displayed. 
Fax All Pages and 
Permanent Memos 

Allows users to Fax .JPG, .BMP and .GIF image files with associated memos. 
These files are converted to .TIF format prior to faxing. 

Scan Document Disabled when viewing a scanned or imported document (see "Scanning 
Documents" for details). 

Scan Custom Disabled when viewing a scanned or imported document (see "Scanning 
Documents" for details). 

Scan Color Disabled when viewing a scanned or imported document (see "Scanning 
Documents" for details). 

Import Document Disabled when viewing a scanned or imported document (see "Scanning/Importing 
Documents" for details). 

Save Disabled when viewing a scanned or imported document (see "Scanning 
Documents" for details). 

Fast File Disabled for all image file types except .TIF image files (see "Fast File" for details). 
Tracking Displays a list of pending CPT and HCPCS codes for the selected patient.  These 

pending codes can be marked as complete to prevent overdue messages from 
being sent (see "Lab Tracking Interface Overview" for details). 

Print All Pages Prints all pages associated with the document displayed. 
Fax All Pages and 
Permanent Memos 

Allows users to Fax .JPG and .TIF image files only.  Clicking this Fax button when 
viewing a .BMP and .GIF file launches the reasons window, but will NOT fax these 
file types by using this Fax menu item. 

Lab Tracking Displays a list of pending CPT and HCPCS codes for the selected patient.  These 
pending codes can be marked as complete to prevent overdue lab messages from 
being sent.  See "Lab Tracking Interface Overview" for details. 

Graph Allows users to manually graph Laboratory Results. 
FlowSheet Opens FlowSheet window that allows users to document data.  See "FlowSheets, 

Patient Specific FlowSheets" for more information. 
Refill Request Allows end user to access the refill grid to complete refills based incoming fax 

requests. 
ABN/Forms Manager Allows end user to track pending tasks set in Schedule/Bill and link them to an 

image in DocMan. 
Sign Off Allows users with appropriate privileges to sign documents, making them a 

permanent part of the patient record (see "Sign Off a Document" for details). 
Sign-Off Type Allows end user to set preference for sign-off with or without a rubber stamp. 
Memo Allows user to attach a memo to an image (see "Add a Memo to a Document" for 

details). 
Summary Allows the addition of a concise summary of the document along with document 

parameters, which are displayed in the main DocMan grid along with the document 
description (see "Add a Summary to a Document" for details). 

Messages/Task Opens the TaskMan message window that allows end user to create messages 
from the DocMan Image Window toolbar. 

Message Options Allows end user the ability to attach/not attach associated memos and/or summary 
along with document when sending a message. 

Patient Demographics Allows end user to update/edit patient demographics from the Image Page DocMan 
toolbar. 
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Help Opens the Help Search tool. 
Exit Closes the application. 

 

Image Toolbar Options  
Search Topic Opens the Help Search tool. 
About Displays the DocMan version currently installed including support files. 

 

Images Toolbar  
Zoom In Allows user to zoom in to enlarge the image size.  The image is returned to default 

size by exiting out of image page. 
Zoom Out Allows user to zoom out to reduce the image size.  The image is returned to default 

size by exiting out of image page. 
Rotate Rotates the image 90 degrees each time the button is clicked. 

Image Window – JPG, BMP and GIF (Patient Record) 
This image window displays jpg, bmp and gif image types. Tif file types are displayed in a slightly different 
window. 

Image Screen  
Identification Bar Identifies the patient name (Fax Filing). Also includes the Document Name, Create 

Date, Date of Service, and Created by (user name and login). 
 

File Menu Options  
Import Disabled when viewing a scanned/imported document. 
Select Twain Source Displays the available Imaging Devices currently installed on this computer, 

including scanners and/or cameras that use a Twain driver. 
Print Setup Displays the printer dialog screen so users can select a default printer for DocMan 

printing as well as to set printer preferences. 
Print First 5 Pages Allows user to print the first 5 pages of this document. 
Print Current Page Prints current page of a document displayed. 
Print All Prints all pages of a document whether displayed or not. 
Print Card Prints a wallet card size version of this document. 
Fax Allows users to Fax .TIF, .JPG, .BMP and .GIF image files. 
Exit Closes the application. 

 

Tools Menu Options  
New Message Opens the TaskMan message window that allows end user to create messages 

from the DocMan Image Menu Toolbar. 
Lab Tracking Displays a list of pending CPT and HCPCS codes for the selected patient.  These 

pending codes can be marked as complete to prevent overdue lab messages from 
being sent (see "Lab Tracking Interface Overview" for details). 

FlowSheet Opens FlowSheet window that allows users to document data.  See "FlowSheets, 
Patient Specific FlowSheets" for more information. 
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Help Menu Options  
Search Topic Opens the Help Search tool. 
About Displays the DocMan version currently installed including support files. 

 

Main Toolbar Options  
Print First 5 Pages Allows user to print the first 5 pages of this document. 
Print Current Page (1 page 
only) 

Prints the image seen on screen, 1 page only.  This does not print associated 
memos (see "Print a Document" for details). 

Print All Pages Prints all pages associated with the document displayed. 
Fax All Pages and 
Permanent Memos 

Allows users to Fax .JPG, .BMP and .GIF image files with associated memos. 
These files are converted to .TIF format prior to faxing. 

Scan Document Disabled when viewing a scanned or imported document (see "Scanning 
Documents" for details). 

Scan Custom Disabled when viewing a scanned or imported document (see "Scanning 
Documents" for details). 

Scan Color Disabled when viewing a scanned or imported document (see "Scanning 
Documents" for details). 

Import Document Disabled when viewing a scanned or imported document (see "Scanning/Importing 
Documents" for details). 

Save Disabled when viewing a scanned or imported document (see "Scanning 
Documents" for details). 

Fast File Disabled for all image file types except .TIF image files (see "Fast File" for details). 
Tracking Displays a list of pending CPT and HCPCS codes for the selected patient.  These 

pending codes can be marked as complete to prevent overdue messages from 
being sent (see "Lab Tracking Interface Overview" for details). 

Print All Pages Prints all pages associated with the document displayed. 
Fax All Pages and 
Permanent Memos 

Allows users to Fax .JPG and .TIF image files only.  Clicking this Fax button when 
viewing a .BMP and .GIF file launches the reasons window, but will NOT fax these 
file types by using this Fax menu item. 

Lab Tracking Displays a list of pending CPT and HCPCS codes for the selected patient.  These 
pending codes can be marked as complete to prevent overdue lab messages from 
being sent (see "Lab Tracking Interface Overview" for details). 

Graph Allows users to manually graph Laboratory Results. 
FlowSheet Opens FlowSheet window that allows users to document data.  See "FlowSheets, 

Patient Specific FlowSheets" for more information. 
Refill Request Allows end user to access the refill grid to complete refills based incoming fax 

requests. 
ABN/Forms Manager Allows end user to track pending tasks set in Schedule/Bill and link them to an 

image in DocMan. 
Sign Off Allows users with appropriate privileges to sign documents, making them a 

permanent part of the patient record (see "Sign Off a Document" for details). 
Sign-Off Type Allows end user to set preference for sign-off with or without a rubber stamp. 
Memo Allows user to attach a memo to an image (see "Add a Memo to a Document" for 

details). 
Summary Allows the addition of a concise summary of the document along with document 

parameters, which are displayed in the main DocMan grid along with the document 
description (see "Add a Summary to a Document" for details). 

Messages/Task Opens the TaskMan message window that allows end user to create messages 
from the DocMan Image Window toolbar. 
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Message Options Allows end user the ability to attach/not attach associated memos and/or summary 
along with document when sending a message. 

Patient Demographics Allows end user to update/edit patient demographics from the Image Page DocMan 
toolbar. 

Help Opens the Help Search tool. 
Exit Closes the application. 

 

Images Toolbar  
Zoom In Allows user to zoom in to enlarge the image size.  The image is returned to default 

size by exiting out of image page. 
Zoom Out Allows user to zoom out to reduce the image size.  The image is returned to default 

size by exiting out of image page. 
Rotate Rotates the image 90 degrees each time the button is clicked. 

 

Image Window – TIF Image Files (Patient Record) 
This image window displays only tif image types. Jpg, bmp and gif file types are displayed in a slightly 
different window. 

Image Screen  
Identification Bar Identifies the patient name, display name (i.e. nickname), date of birth, age, gender, 

insurance information including Insurance company name, co-pay and percent 
insured and patient telephone number. Also includes the Document Name, Create 
Date, Date of Service, and Created by (user name and login).  If document is signed 
off, also displays Signed by (user login, date and time). 

 

File Menu Options  
Import Disabled when viewing a scanned/imported document. 
Select Twain Source Displays the available Imaging Devices currently installed on this computer, 

including scanners and/or cameras that use a Twain driver. 
Print Setup Displays the printer dialog screen so users can select a default printer for DocMan 

printing as well as to set printer preferences. 
Print First 5 Pages Allows user to print the first 5 pages of this document. 
Print Current Page Prints current page of a document displayed. 
Print All Prints all pages of a document whether displayed or not. 
Print Card Prints a wallet card size version of this document. 
Fax Allows users to Fax .TIF, .JPG, .BMP and .GIF image files. 
Exit Closes the application. 

 

Tools Menu Options  
New Message Opens the TaskMan message window that allows end user to create messages 

from the DocMan Image Menu Toolbar. 
Lab Tracking Displays a list of pending CPT and HCPCS codes for the selected patient.  These 

pending codes can be marked as complete to prevent overdue lab messages from 
being sent (see "Lab Tracking Interface Overview" for details). 

FlowSheet Opens FlowSheet window that allows users to document data.  See "FlowSheets, 
Patient Specific FlowSheets" for more information. 
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Help Menu Options  
Search Topic Opens the Help Search tool. 
About Displays the DocMan version currently installed including support files. 

 

Main Toolbar Options  
Print First 5 Pages Allows user to print the first 5 pages of this document. 
Print Current Page (1 page 
only) 

Prints the image seen on screen, 1 page only.  This does not print associated 
memos (see "Print a Document" for details). 

Print All Pages Prints all pages associated with the document displayed. 
Fax All Pages and 
Permanent Memos 

Allows users to Fax .JPG, .BMP and .GIF image files with associated memos. 
These files are converted to .TIF format prior to faxing. 

Scan Document Disabled when viewing a scanned or imported document (see "Scanning 
Documents" for details). 

Scan Custom Disabled when viewing a scanned or imported document (see "Scanning 
Documents" for details). 

Scan Color Disabled when viewing a scanned or imported document (see "Scanning 
Documents" for details). 

Import Document Disabled when viewing a scanned or imported document (see "Scanning/Importing 
Documents" for details). 

Save Disabled when viewing a scanned or imported document (see "Scanning 
Documents" for details). 

Fast File Disabled for all image file types except .TIF image files (see "Fast File" for details). 
Tracking Displays a list of pending CPT and HCPCS codes for the selected patient.  These 

pending codes can be marked as complete to prevent overdue messages from 
being sent (see "Lab Tracking Interface Overview" for details). 

Print All Pages Prints all pages associated with the document displayed. 
Fax All Pages and 
Permanent Memos 

Allows users to Fax .JPG and .TIF image files only.  Clicking this Fax button when 
viewing a .BMP and .GIF file launches the reasons window, but will NOT fax these 
file types by using this Fax menu item. 

Lab Tracking Displays a list of pending CPT and HCPCS codes for the selected patient.  These 
pending codes can be marked as complete to prevent overdue lab messages from 
being sent (see "Lab Tracking Interface Overview" for details). 

Graph Allows users to manually graph Laboratory Results. 
FlowSheet Opens FlowSheet window that allows users to document data.  See "FlowSheets, 

Patient Specific FlowSheets" for more information. 
Refill Request Allows end user to access the refill grid to complete refills based incoming fax 

requests. 
ABN/Forms Manager Allows end user to track pending tasks set in Schedule/Bill and link them to an 

image in DocMan. 
Sign Off Allows users with appropriate privileges to sign documents, making them a 

permanent part of the patient record. 
Sign-Off Type Allows end user to set preference for sign-off with or without a rubber stamp. 
Memo Allows user to attach a memo to an image (see "Add a Memo to a Document" for 

details). 
Summary Allows the addition of a concise summary of the document along with document 

parameters, which are displayed in the main DocMan grid along with the document 
description (see "Add a Summary to a Document" for details). 
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Messages/Task Opens the TaskMan message window that allows end user to create messages 
from the DocMan Image Window toolbar. 

Message Options Allows end user the ability to attach/not attach associated memos and/or summary 
along with document when sending a message. 

Patient Demographics Allows end user to update/edit patient demographics from the Image Page DocMan 
toolbar. 

Help Opens the Help Search tool. 
Exit Closes the application. 

 

Images Toolbar  
Show/Hide Thumbnails Click this button to either hide or show thumbnail sketches of each page in a single 

or multi page image. 
First/Prior Page and 
Next/Last Page Arrows 

Allows user to page forward and backward through a multi-page image. 

Zoom In Allows user to zoom in to enlarge the image size.  The image is returned to default 
size by exiting out of image page. 

Zoom Out Allows user to zoom out to reduce the image size.  The image is returned to default 
size by exiting out of image page. 

Full Screen Displays document in full screen mode. Click anywhere on the document to return to 
Image page view. 

Rotate Rotates the image 90 degrees each time the button is clicked. 
Pan Allows user to move image (pan through) with a hand icon after Zooming in and out. 
Zoom Area Allows user to zoom (enlarge) a specific area. 
Arrow Changes cursor to Arrow within the Document view area. Closes Pen Editor, if 

opened. 
Pen Editor (Draw) Allows the end user to mark the image with lines, squares, ellipse with a varying 

degree of thickness to a .TIF image.  Only available with .TIF images. Clicking on 
the Pencil icon opens the editor including standard pen width icons (narrow, 
medium, wide) and a manual pen width setting.  Clicking blue return arrow removes 
edits. Clicking on the Arrow icon closes Pen Editor. 

 

Image Window – TIF Image Files (Fax Filing Patient Record) 
This image window displays only tif image types. Jpg, bmp and gif file types are displayed in a slightly 
different window. 

Image Screen  
Identification Bar Identifies the patient name (Fax Filing). Also includes the Document Name, Create 

Date, Date of Service, and Created by (user name and login). 
 

File Menu Options  
Import Disabled when viewing a scanned/imported document. 
Select Twain Source Displays the available Imaging Devices currently installed on this computer, 

including scanners and/or cameras that use a Twain driver. 
Print Setup Displays the printer dialog screen so users can select a default printer for DocMan 

printing as well as to set printer preferences. 
Print First 5 Pages Allows user to print the first 5 pages of this document. 
Print Current Page Prints current page of a document displayed. 
Print All Prints all pages of a document whether displayed or not. 
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Print Card Prints a wallet card size version of this document. 
Fax Allows users to Fax .TIF, .JPG, .BMP and .GIF image files. 
Exit Closes the application. 

 

Tools Menu Options  
New Message Opens the TaskMan message window that allows end user to create messages 

from the DocMan Image Menu Toolbar. 
Lab Tracking Displays a list of pending CPT and HCPCS codes for the selected patient.  These 

pending codes can be marked as complete to prevent overdue lab messages from 
being sent (see "Lab Tracking Interface Overview" for details). 

FlowSheet Opens FlowSheet window that allows users to document data. See "FlowSheets, 
Patient Specific FlowSheets" for more information. 

 

Help Menu Options  
Search Topic Opens the Help Search tool. 
About Displays the DocMan version currently installed including support files. 

 

Main Toolbar Options  
Print First 5 Pages Allows user to print the first 5 pages of this document. 
Print Current Page (1 page 
only) 

Prints the image seen on screen, 1 page only.  This does not print associated 
memos (see "Print a Document" for details). 

Print All Pages Prints all pages associated with the document displayed. 
Fax All Pages and 
Permanent Memos 

Allows users to Fax .JPG, .BMP and .GIF image files with associated memos. 
These files are converted to .TIF format prior to faxing. 

Scan Document Disabled when viewing a scanned or imported document (see "Scanning 
Documents" for details). 

Scan Custom Disabled when viewing a scanned or imported document (see "Scanning 
Documents" for details). 

Scan Color Disabled when viewing a scanned or imported document (see "Scanning 
Documents" for details). 

Import Document Disabled when viewing a scanned or imported document (see "Scanning/Importing 
Documents" for details). 

Save Disabled when viewing a scanned or imported document (see "Scanning 
Documents" for details). 

Fast File Disabled for all image file types except .TIF image files (see "Fast File" for details). 
Tracking Displays a list of pending CPT and HCPCS codes for the selected patient.  These 

pending codes can be marked as complete to prevent overdue messages from 
being sent (see "Lab Tracking Interface Overview" for details). 

Print All Pages Prints all pages associated with the document displayed. 
Fax All Pages and 
Permanent Memos 

Allows users to Fax .JPG and .TIF image files only.  Clicking this Fax button when 
viewing a .BMP and .GIF file launches the reasons window, but will NOT fax these 
file types by using this Fax menu item. 

Lab Tracking Displays a list of pending CPT and HCPCS codes for the selected patient.  These 
pending codes can be marked as complete to prevent overdue lab messages from 
being sent (see "Lab Tracking Interface Overview" for details). 

Graph Allows users to manually graph Laboratory Results. 
FlowSheet Opens FlowSheet window that allows users to document data.  See "FlowSheets, 

Patient Specific FlowSheets" for more information. 
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Refill Request Allows end user to access the refill grid to complete refills based incoming fax 
requests. 

ABN/Forms Manager Allows end user to track pending tasks set in Schedule/Bill and link them to an 
image in DocMan. 

Sign Off Allows users with appropriate privileges to sign documents, making them a 
permanent part of the patient record (see "Sign Off a Document" for details). 

Sign-Off Type Allows end user to set preference for sign-off with or without a rubber stamp. 
Memo Allows user to attach a memo to an image (see "Add a Memo to a Document" for 

details). 
Summary Allows the addition of a concise summary of the document along with document 

parameters, which are displayed in the main DocMan grid along with the document 
description (see "Add a Summary to a Document" for details). 

Messages/Task Opens the TaskMan message window that allows end user to create messages 
from the DocMan Image Window toolbar. 

Message Options Allows end user the ability to attach/not attach associated memos and/or summary 
along with document when sending a message. 

Patient Demographics Allows end user to update/edit patient demographics from the Image Page DocMan 
toolbar. 

Help Opens the Help Search tool. 
Exit Closes the application. 

 
Images Toolbar  
Show/Hide Thumbnails Click this button to either hide or show thumbnail sketches of each page in a single 

or multi page image. 
First/Prior Page and 
Next/Last Page Arrows 

Allows user to page forward and backward through a multi-page image. 

Zoom In Allows user to zoom in to enlarge the image size.  The image is returned to default 
size by exiting out of image page. 

Zoom Out Allows user to zoom out to reduce the image size.  The image is returned to default 
size by exiting out of image page. 

Full Screen Displays document in full screen mode. Click anywhere on the document to return to 
Image page view. 

Rotate Rotates the image 90 degrees each time the button is clicked. 
Pan Allows user to move image (pan through) with a hand icon after Zooming in and out. 
Zoom Area Allows user to zoom (enlarge) a specific area. 
Arrow Changes cursor to Arrow within the Document view area. Closes Pen Editor, if 

opened. 
Pen Editor (Draw) Allows the end user to mark the image with lines, squares, ellipse with a varying 

degree of thickness to a .TIF image.  Only available with .TIF images. Clicking on 
the Pencil icon opens the editor including standard pen width icons (narrow, 
medium, wide) and a manual pen width setting.  Clicking blue return arrow removes 
edits. Clicking on the Arrow icon closes Pen Editor. 

The Image Window – HL7, QL7, GL7 Image Files (Patient Record) 
Note:  The extensions of QL7 and GL7 all refer to HL7 lab result files that come in through the lab 
interface modules.  In prior versions QL7 and GL7 were used to differentiate results from specific labs but 
all results are actually sent in HL7 format.  e-MDs is phasing out the use of these other identifiers. 
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Image Screen  
Identification Bar Identifies the patient name, display name (i.e. nickname), date of birth, age, gender, 

insurance information including Insurance company name, co-pay and percent 
insured and patient telephone number. Also includes the Document Name, Create 
Date, Date of Service, and Created by (user name and login).  If document is signed 
off, also displays Signed by (user login, date and time). 

 

File Menu Options  
Import Disabled when viewing a scanned/imported document. 
Select Twain Source Displays the available Imaging Devices currently installed on this computer, 

including scanners and/or cameras that use a Twain driver. 
Print Setup Displays the printer dialog screen so users can select a default printer for DocMan 

printing as well as to set printer preferences. 
Print First 5 Pages Allows user to print the first 5 pages of this document. 
Print Current Page Prints current page of a document displayed. 
Print All Prints all pages of a document whether displayed or not. 
Print Card Prints a wallet card size version of this document. 
Fax Allows users to Fax .TIF, .JPG, .BMP and .GIF image files. 
Exit Closes the application. 

 
Tools Menu Options  
New Message Opens the TaskMan message window that allows end user to create messages 

from the DocMan Image Menu Toolbar. 
Lab Tracking Displays a list of pending CPT and HCPCS codes for the selected patient.  These 

pending codes can be marked as complete to prevent overdue lab messages from 
being sent (see "Lab Tracking Interface Overview" for details). 

FlowSheet Opens FlowSheet window that allows users to document data.  See "FlowSheets, 
Patient Specific FlowSheets" for more information. 

 
Help Menu Options  
Search Topic Opens the Help Search tool. 
About Displays the DocMan version currently installed including support files. 

 
Main Toolbar Options  
Print First 5 Pages Disabled when viewing HL7, QL7, or GL7 document. 
Print Current Page (1 page 
only) 

Disabled when viewing HL7, QL7, or GL7 document. 

Print All Pages Prints all pages associated with the document displayed. 
Fax All Pages and 
Permanent Memos 

Allows users to fax HL7, QL7, or GL7 file types and associated memos. 

Scan Document Disabled when viewing HL7, QL7, or GL7 document. 
Scan Custom Disabled when viewing HL7, QL7, or GL7 document. 
Scan Color Disabled when viewing HL7, QL7, or GL7 document. 
Import Document Disabled when viewing HL7, QL7, or GL7 document. 
Save Disabled when viewing HL7, QL7, or GL7 document. 
Fast File Disabled when viewing HL7, QL7, or GL7 document. 
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Tracking Displays a list of pending CPT and HCPCS codes for the selected patient.  These 
pending codes can be marked as complete to prevent overdue messages from 
being sent (see "Lab Tracking Interface Overview" for details). 

Graph Allows users to manually graph Laboratory Results. 
FlowSheet Opens FlowSheet window that allows users to document data.  See "FlowSheets, 

Patient Specific FlowSheets" for more information. 
Refill Request Allows end user to access the refill grid to complete refills based incoming fax 

requests. 
ABN/Forms Manager Allows end user to track pending tasks set in Schedule/Bill and link them to an 

image in DocMan. 
Sign Off Allows users with appropriate privileges to sign documents, making them a 

permanent part of the patient record (see "Sign Off a Document" for details). 
Sign-Off Type Allows end user to set sign-off with or without a rubber stamp. 
Memo Allows user to attach a memo to an image (see "Add a Memo to a Document" for 

details). 
Summary Allows the addition of a concise summary of the document along with document 

parameters, which are displayed in the main DocMan grid along with the document 
description (see "Add a Summary to a Document" for details). 

Messages/Task Opens the TaskMan message window that allows end user to create messages 
from the DocMan Image Window toolbar. 

Message Options Allows end user the ability to attach/not attach associated memos and/or summary 
along with document when sending a message. 

Patient Demographics Allows end user to update/edit patient demographics from the Image Page DocMan 
toolbar. 

Help Opens the Help Search tool. 
Exit Closes the application. 

 
Lab Viewer Options  
Lab Report Displays the laboratory report received.  Out of range values are displayed in red.  

Double clicking on individual tests displays historical values for this test (see "Lab 
Interface" for details). 
 Revert to original lab report:  After end user clicks on a specific lab test, i.e. 

CBC, the historical values for this test are displayed.  The Revert button is now 
active and can be clicked to return to the original lab report. 

 Labels: Clicking this button displays the labels for buttons in Lab Report 
 Help: Opens the Help Search tool. 
 HL7 Hierarchy: Displays the audit trail for the received lab; displays errors in 

pink. Panel items are displayed in blue font. 
 Label: Clicking this button displays the labels for buttons in Lab Report 
 Help: Opens the Help Search tool. 

Lab Results Status End user can set up results panel through Lab Interface Module so that reported 
results displayed in Lab Viewer per status (see "Lab Interface" for details). 
 P: Preliminary result, final not yet obtained 
 C: Correction of previously reported result 
 D: Delete previous reported result 
 N: Test not necessary; not done 

These values also are displayed under the HL& Hierarchy per each specific lab test. 



 

e-MDs Solution Series Utilities Guide 8.0 R01 61 
 

Image Window – HL7, QL7, GL7 Image Files (Fax Filing Patient 
Record) 
Note:  The extensions of QL7 and GL7 all refer to HL7 lab result files that come in via the lab interface 
modules.  In prior versions QL7 and GL7 were used to differentiate results from specific labs but all 
results are actually sent in HL7 format.  e-MDs is phasing out the use of these other identifiers. 

Image Screen  
Identification Bar Identifies the patient name (Fax Filing). Also includes the Document Name, Create 

Date, Date of Service, and Created by (user name and login). 
 

File Menu Options  
Import Disabled when viewing a scanned/imported document. 
Select Twain Source Displays the available Imaging Devices currently installed on this computer, 

including scanners and/or cameras that use a Twain driver. 
Print Setup Displays the printer dialog screen so users can select a default printer for DocMan 

printing as well as to set printer preferences. 
Print First 5 Pages Allows user to print the first 5 pages of this document. 
Print Current Page Prints current page of a document displayed. 
Print All Prints all pages of a document whether displayed or not. 
Print Card Prints a wallet card size version of this document. 
Fax Allows users to Fax .TIF, .JPG, .BMP and .GIF image files. 
Exit Closes the application. 

 

Tools Menu Options  
New Message Opens the TaskMan message window that allows end user to create messages 

from the DocMan Image Menu Toolbar. 
Lab Tracking Displays a list of pending CPT and HCPCS codes for the selected patient.  These 

pending codes can be marked as complete to prevent overdue lab messages from 
being sent (see "Lab Tracking Interface Overview" for details). 

FlowSheet Opens FlowSheet window that allows users to document data.  See "FlowSheets, 
Patient Specific FlowSheets" for more information. 

 

Help Menu Options  
Search Topic Opens the Help Search tool. 
About Displays the DocMan version currently installed including support files. 

 

Main Toolbar Options  
Print First 5 Pages Disabled when viewing HL7, QL7, or GL7 document. 
Print Current Page (1 page 
only) 

Disabled when viewing HL7, QL7, or GL7 document. 

Print All Pages Prints all pages associated with the document displayed. 
Fax All Pages and 
Permanent Memos 

Allows users to fax HL7, QL7, or GL7 file types and associated memos. 

Scan Document Disabled when viewing HL7, QL7, or GL7 document. 
Scan Custom Disabled when viewing HL7, QL7, or GL7 document. 
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Scan Color Disabled when viewing HL7, QL7, or GL7 document. 
Import Document Disabled when viewing HL7, QL7, or GL7 document. 
Save Disabled when viewing HL7, QL7, or GL7 document. 
Fast File Disabled when viewing HL7, QL7, or GL7 document. 
Tracking Displays a list of pending CPT and HCPCS codes for the selected patient.  These 

pending codes can be marked as complete to prevent overdue messages from 
being sent (see "Lab Tracking Interface Overview" for details). 

Graph Allows users to manually graph Laboratory Results. 
FlowSheet Opens FlowSheet window that allows users to document data.  See "FlowSheets, 

Patient Specific FlowSheets" for more information. 
Refill Request Allows end user to access the refill grid to complete refills based incoming fax 

requests. 
ABN/Forms Manager Allows end user to track pending tasks set in Schedule/Bill and link them to an 

image in DocMan. 
Sign Off Allows users with appropriate privileges to sign documents, making them a 

permanent part of the patient record (see "Sign Off a Document" for details). 
Sign-Off Type Allows end user to set sign-off with or without a rubber stamp. 
Memo Allows user to attach a memo to an image (see "Add a Memo to a Document" for 

details). 
Summary Allows the addition of a concise summary of the document along with document 

parameters, which are displayed in the main DocMan grid along with the document 
description (see "Add a Summary to a Document" for details). 

Messages/Task Opens the TaskMan message window that allows end user to create messages 
from the DocMan Image Window toolbar. 

Message Options Allows end user the ability to attach/not attach associated memos and/or summary 
along with document when sending a message. 

Patient Demographics Allows end user to update/edit patient demographics from the Image Page DocMan 
toolbar. 

Help Opens the Help Search tool. 
Exit Closes the application. 

 

Lab Viewer Options  
Lab Report Displays the laboratory report received.  Out of range values are displayed in red.  

Double clicking on individual tests displays historical values for this test (see "Lab 
Interface" for more details). 
 Revert to original lab report:  After end user clicks on a specific lab test, i.e. 

CBC, the historical values for this test are displayed.  The Revert button is now 
active and can be clicked to return to the original lab report. 

 Labels: Clicking this button displays the labels for buttons in Lab Report 
 Help: Opens the Help Search tool. 
 HL7 Hierarchy: Displays the audit trail for the received lab; displays errors in 

pink. Panel items are displayed in blue font. 
 Label: Clicking this button displays the labels for buttons in Lab Report 
 Help: Opens the Help Search tool. 
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Lab Results Status End user can set up results panel through Lab Interface Module so that reported 
results displayed in Lab Viewer per status (see "Lab Interface" for details). 
 P: Preliminary result, final not yet obtained 
 C: Correction of previously reported result 
 D: Delete previous reported result 
 N: Test not necessary; not done 

These values also are displayed under the HL& Hierarchy per each specific lab test. 
 

Document Memo Toolbar 
To add the first memo to a selected document, click the Memo button on the Image window toolbar (see 
"Add a Memo to a Document" for details). If prior memos exist, the memo window will already be open. 
The Memo button is a toggle button; click it again to hide the memos. 

Document Toolbar 
Menu Options 

 

Permanent Memo Click the first button in the Memo toolbar to add a Permanent Memo. Permanent 
Memos can be deleted only up until the point that the associated document is 
signed off. A Permanent Memo is appropriate for most clinical notes associated with 
documents. 

Sticky Memo Click the second button to add a non-permanent "Sticky" Memo. Sticky Memos are 
identified by the yellow highlight. In the example above, the second note is a Sticky 
Memo. These notes can be deleted at any time, even after the document has been 
signed off. Sticky Memos are never printed, and are ideal for internal communication 
that is not intended to be a permanent part of the patient record. 

Delete a Memo Click the third button to delete a selected memo. Sticky Memos can be deleted at 
any time. Permanent Memos can only be deleted if the associated document has 
not been signed off. 

Print Memos Click the fourth button to print both the memos and their associated document. 
Memos print on one page and the document on a separate page. Sticky Memos do 
not print. 

Memo Security Click the last button for memo-level security. A user with the DocMan Security 
privilege can lock memos from other individual users. This hides only the selected 
memo, and does not hide the associated document. For further information 
regarding record-level locking, see "Prevent Access to Specific Documents."  

Reference Documents Toolbar (previously known as DOCS) 
“Reference Documents” Categories, are not patient-specific, and might hold administrative forms such as 
"Consent Forms".  These folders are not displayed in patient’s charts, but are accessible from the 
application’s toolbar, without the need to first search for a patient. 

To access the Reference Documents, click on the Reference Documents button located next to the 
Control Panel button. 

• Screen Layout: 

○ The uppermost area allows searching by Document Code (Doc Code) or Document 
Description (Doc Description).  Click the Search button (with the magnifying glass) to list all 
documents. 

○ The second area permits searching by Document Group. 

○ The left windowpane displays the document folders in the selected Document Group. 

○ If a folder has documents, it is displayed with a yellow folder icon. 

○ Numbers in parentheses show the total document count in each folder. 
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○ Empty folders are displayed with a blue folder icon. 

○ The right windowpane lists the documents contained in the selected folder. 

○ These are displayed by Code, Description and Create Date. 

○ If there is a document scanned or imported, a check mark will be displayed. 

• Buttons: 

Buttons are located along the right windowpane. Their functions are fairly self-explanatory.  

Reference Documents 
Toolbar Buttons 

 

Add Document Opens the Add Document window that allows users to add document description 
prior to Scanning. 

Scan See "Scanning a Document into a Reference Document Category" for details. 
Import Document After selecting a Category, click on button which opens a Browser Search Window 

to locate file to import. 
Edit Document Edits the Code and Description data only. 
Delete Document Opens confirmation window to delete selected Reference Document. 
View Document Opens Image Window to display Reference Document. 
Record Security See "Prevent Access to Specific Documents" for details.  If login has DocMan 

privilege, this gives users the ability to grant/limit access to a specific Reference 
Document. 

Control Panel  
To access the Control Panel, click the Control Panel button on the main DocMan toolbar or click Tools 
on the menu and select Control Panel from the pop-up menu. 

Note:  Depending on security access rights, this button may not be visible. 

Control Panel Toolbar 
Buttons 

 

Category Access to creation of categories and subcategories, which are the folders that 
catalog and store images and documents. Two basic types of categories are 
"DocMan” categories, which are folders that are displayed within patient records, 
and "Reference Documents” categories", which are not patient-specific, and might 
hold items such as administrative forms (see "Create Categories and 
Subcategories" for more details). 

Log Viewer Access to the security log. This audit trail tracks every action taken in the DocMan 
application, including the date and time, type of action (such as view, print, update), 
the patient record that was involved, and identification of the user performing the 
actions. See "Log Viewer (Audit Trail)" for details. 

Move Documents Users can move all documents in one category to another category.  This allows 
users to consolidate (and eliminate if desired) categories in DocMan.  This is a 
Global feature so any categories that are changed are changed for ALL users and 
patient accounts. 

Reasons Users printing (or faxing) images from the DocMan application are required to give 
an appropriate HIPAA reason for printing a patient record. This icon opens a window 
that allows users to create additional canned responses (see "Document Reason for 
Printing Image" for details). 

Report Access two custom reports generated by DocMan. 
Rubber Stamp Opens the Rubber Stamp Sign-Off Editor where the users can add, edit, delete and 

preview Rubber Stamps. 
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Signature Opens the Signature window where the users can print, scan and/or import a 
signature page.  These signatures can be appended to DocMan .tif files at Sign-Off. 

Storage Access to the setup and maintenance of image storage directories, as well as to the 
registry of CD disks (or other disk media) on which backed-up images are stored. 
See "Create an Image Storage Directory" for more information. 

User Setup Access to setup and maintenance of users, security groups, and group access 
rights. See "Create Security Groups" for more information.  
Note: This edits only the login information for users.  To create a new user, see 
"Demographics, Providers & Staff." 

Log Viewer (Audit Trail) 
Lob Viewer Toolbar 
Buttons 

 

List All Shows the entire audit log. 
Show by date Shows all entries in the audit log by a selected date. 
Calendar Drop-down arrow opens calendar to select specific date. 
Print log Prints the log as it appears on screen. 
Exit Closes the Log Viewer window. 

 

Lob Viewer Toolbar 
Columns 

Double-click any line in the audit log for further information, in addition to 
that listed in the columns. 

Type Records the type of action taken in the record.  Types include: 
○ Insert (scan or import a new item) 
○ Update (change the properties of a document or re-file a document) 
○ View 
○ Print (or Fax) 
○ Soft Delete (delete an image or image description prior to sign off) 
○ Delete (delete non-image items, such as memos) 
○ Break Security 

Dates/Times Records the date and time that the action started and ended, including total elapsed 
time. 

Patient Records which patient record was affected by the action. 
Reason If the action type is Print (or Fax), the justification for printing shows in this column. 
User Records which user (user name/login) performed the action. 
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3 
TaskMan 

TaskMan is a messaging and tasking system.  It can be used to send messages to 
different users, as well as tasks with assigned users, due by dates and tracking.  You 
can also send and receive external e-mail through TaskMan. TaskMan is a major part 
of the messaging component of the e-MDs Patient Portal if you have licensed that 
application.  This makes it an excellent management and communication tool. 

• Dashboard Functionality:  TaskMan is typically run as a preferred 
application in the e-MDs Dashboard bar because its application button shows 
a count of messages and tasks.  If you are using the automatic tasking and 
reporting functionality of the system, you can set this to be your rightmost 
automatically starting module and thus, when you log in at the start of the day, 
can see a “dashboard” of things to do. 

• Accessibility:  TaskMan can also be run as a standalone module using a 
desktop shortcut, or from within e-MDs Bill, Chart, DocMan, and Tracking 
Board.  You can also initiate messages from within Chart, DocMan, Bill, and 
other modules and attach an entire chart, a progress note, or a document 
such as lab results, or scans.  Messages sent by patients from the e-MDs 
Patient Portal are routed to TaskMan.  This accessibility makes it a key 
component of the workflow in a clinic. 

If TaskMan has not already been installed and customized on your system, see the e-
MDs Solution Series Administration Guide for assistance in customizing TaskMan to 
work properly in your environment. 

Continued on the next page ... 
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Receiving Messages in TaskMan 
Several types of messages can be routed to a user’s TaskMan inbox: system-generated messages, 
messages from the Patient Portal, and external Direct Messages. 

System-Generated Messages 
Certain Solution Series modules generate messages automatically. Some of those messages include 
attachments such as lab results or documents.  The following are examples of automated messages: 

• Document scan notifications 

• Incoming faxes (e.g. refill requests, consults) 

• Electronically imported lab results and lab interface exception messages 

• Overdue order messages from Chart’s lab tracking system 

• SureScripts electronic prescribing administration and exception messages 

• e-MDs content engine notifications 

• DocMan administrator exception messages. 

Portal Messages 
Users can receive messages from the Patient Portal.  Those messages might be from the patient or from 
a designated patient representative. If a message is from a patient representative, it will be flagged as 
such within the message. 

 
Note: A patient with a Portal account can create a patient representative account for another person, 
such as a parent or lawyer. Using that account, the patient representative can log in to the Portal, view 
the health information displayed in the patient’s Portal, and exchange messages with the patient’s 
healthcare providers. 

External Direct Messages 

Users who are registered for Direct messaging have a Direct Address and can receive external messages 
that are sent to that address. (Information about Direct messaging is provided later in this chapter of the 
user guide.) 

Sending Internal Messages from TaskMan 
New messages can be sent directly from the TaskMan module to other Solution Series users, as 
described below. In addition, messages can be initiated from within a patient's chart or from DocMan. 

Note: Messages can also be sent from TaskMan to an external Direct Address. For more information, see 
the Using Direct Messaging section provided later in this chapter. 
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To send a message in TaskMan: 
1. To open TaskMan, click the TaskMan button in Dashboard.   

You can also double-click the TaskMan desktop icon and log in (with the same login and 
password used for Dashboard or Chart) or, within e-MDs Chart, click Tools and select the 
TaskMan menu option. 

2. Click the dropdown next to the yellow envelope under the TaskMan toolbar. 

3. Select the New Message menu option. 

4. In the Untitled - Message window, select the recipient by clicking the checkbox to the left of the 
user or group name. 

OR  

Click the To button to search for and select a recipient. More than one recipient may be selected. 
After selecting all recipients, click OK. 

5. Type a short message title in the Subject field, if desired. The subject of the message is 
displayed to the recipient in his or her Inbox. 

6. To change the default priority from Normal, click the radio button to the left of the desired priority 
status.  

If Urgent or Stat is selected, exclamation point icons are displayed next to the message in the 
recipient’s Inbox. 

7. Select a message category by clicking the down-arrow in the Category field.  

If no category is selected, the message will appear in the "Other" category in the recipient’s 
Inbox. 

8. Type the message in the large white window located below the Category field. 

9. Add any desired attachments. 

10. When finished, click Send. 

Adding Attachments to Messages 
Charts, Visit Notes, Order Notes, Telephone/Log Notes, and DocMan images can be attached to 
messages generated from TaskMan module. 

To add an attachment to a message: 
1. Open TaskMan. Click the TaskMan button in Dashboard.  You can also double-click the 

TaskMan desktop icon and log in (with the same login and password used for Dashboard or 
Chart), or within e-MDs Chart, click Tools and select the TaskMan menu option. 

2. Create a new message (see Send a Message from TaskMan for details). 

3. Within the New Message window, click the Attachment button on the message toolbar and 
choose Add Attachment. 

4. In the Module Attachment window, select Chart to attach a patient chart or individual Visit or 
Order Note. Select DocMan to attach a scanned or imported image. 

○ To Attach a Chart: Click Chart in the Module Attachment window. Click Open Patient Chart 
in the Attachment Type window. Search for the patient in the Find Patient window. Highlight 
the correct patient in the search results and then click Select. More than one chart can be 
attached to a given message; simply repeat the steps above to add another chart. 

○ To Attach a Doctor’s Visit Note: Click Chart in the Module Attachment window. Click Open 
Doctor Visit in the Attachment Type window. Search for the patient in the Find Patient 
window. Highlight the correct patient in the search results and then click Select. The Select 
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Patient Visit window will open, listing all notes by visit date, provider, and diagnoses.  Click 
the correct visit from the list. Although only one visit can be added at a time, numerous visits 
can be attached to a single message. Simply repeat the steps above to add additional visits. 

○ To Attach a Nurse’s Visit Note: Click Chart in the Module Attachment window. Click Open 
Nurse Visit in the Attachment Type window. Search for the patient in the Find Patient 
window. Highlight the correct patient in the search results and then click Select. The Select 
Patient Visit window will open, listing all visit notes by visit date, provider, and diagnoses.  
Click the correct visit from the list. Although only one visit can be added at a time, numerous 
visits can be attached to a single message. Simply repeat the steps above to add additional 
visits. 

○ To Attach an Order Note: Click Chart in the Module Attachment window. Click Open Order 
Note in the Attachment Type window. Search for the patient in the Find Patient window. 
Highlight the correct patient in the search results and then click Select. The Select Patient 
Visit window will open, listing all order notes by visit date, provider, and diagnoses.  Click the 
correct note from the list. Although only one note can be added at a time, numerous notes 
can be attached to a single message. Simply repeat the steps above to add additional notes. 

○ To Attach a Log/Phone/Rx Note: Click Chart in the Module Attachment window. Click Open 
Nurse Visit in the Attachment Type window. Search for the patient in the Find Patient 
window. Highlight the correct patient in the search results and then click Select.  The Select 
Log/Phone/Rx Note window will open, listing all Log and Phone notes by date and 
description.  Click the correct note from the list. Although only one note can be added at a 
time, numerous notes can be attached to a single message. Simply repeat the steps above to 
add additional notes. 

○ To Attach a DocMan Image: Click DocMan in the Module Attachment window.  Search for 
the patient in the Find Patient window. Highlight the correct patient in the search results and 
then click Select. In the Document Attachment window select one or more documents by 
clicking the checkbox to the left of the desired document description.  When done click the 
Select button on the toolbar.  Multiple documents can be selected at one time as 
attachments. 

5. Verify that the attachment appears in the Attachment field of the message and that the rest of 
the information such as recipient, subject, category, etc. are filled in and then click Send. 

You can delete an attachment if it gets mistakenly attached to a message. 

To delete an attachment: 
1. Open a message that has an attachment. 

2. Click the attachment that is to be deleted. 

3. Click the Attachment menu item in the New Message menu bar. 

4. Choose Delete Attachment from the pop-up menu. 

The attachment will be removed from the message without displaying a warning message. 

Replying To or Forwarding a Message 
Any message received in the TaskMan Inbox can be replied to, meaning that the recipient sends the 
original message, along with a response, back to the sender. The recipient can also forward (send) the 
message, with or without additional comments, to other recipients. 

To reply, reply to all or forward a message: 
1. Open TaskMan. Click the TaskMan button in Dashboard.  You can also double click the TaskMan 

desktop icon and log in (with the same login and password used for Dashboard or Chart), or 
within e-MDs Chart, click Tools and select the TaskMan menu option. 
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2. TaskMan will open to display all items in the user’s Inbox. Highlight the correct message in the 
upper right window, and then click the Reply, Reply to All or Forward button on the message 
toolbar. 

3. If Reply or Reply to All is clicked, the To field will automatically be filled in with the name or 
names of the sender(s), though this can be changed and additional recipients can be added.  

4. In a Forwarded message, the To field is empty. Select a recipient or recipients by clicking the 
checkbox to the left of the user or group name OR click the To button and search for a recipient. 
More than one recipient may be selected. When finished, click OK. 

5. The Subject, Priority, and Category fields will appear as in the original message. (The Subject is 
preceded by the letters "RE:" in replies and by "FW:" in forwarded messages.) The Subject and 
Priority can be changed, if desired. If Attachments were included in the original message, they will 
also appear in the Reply or Forward. 

6. The message body window will display an "-----Original Message-----" header, followed by the 
message itself. Place the cursor in the upper left corner of the message body window (above the 
header), and type a response or additional message, if desired. 

7. Click Send. 

Following Up on Messages 
This feature allows users to mark TaskMan messages to generate a reminder if the message has not 
been dealt with in the specified time frame.  Users can click the Mark for Followup button and set a follow 
up date.   When logging in to TaskMan users will be notified if there are messages overdue for follow up.  
Additionally users can see this information on demand by clicking the Action menu and selecting Check 
Followup.  Either option will allow users to get a notification whether there are overdue messages, the 
number of overdue messages and then they will have an option to view a list of these. 

To mark a message for follow up: 
1. Click Send. 

2. Select the message that is to be marked for follow up. 

3. Right-click the message and choose Followup from the pop-up menu. 

OR 

Click the Mark for Followup button  on the main TaskMan toolbar. 

The Follow Up window will open. 

4. Choose a follow-up due date from the drop-down calendar field. 

5. Click the Save button when finished. 

To mark a follow-up message as complete: 
1. If a message has been marked for follow up it will begin displaying as overdue when the due date 

is reached.  To prevent the message from displaying as overdue you need to mark it as complete. 

Note:  This is a DIFFERENT feature from the feature that removes completed messages from 
another user’s inbox if the message was sent to multiple recipients (see “Mark as Complete” for 
details about this other feature).  

2. Select the message to be completed. 

3. Right-click on the message and choose Follow Up from the pop-up menu. 

4. Click the Completed checkbox. 

5. Click Save when finished. 
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Marking a Message as Complete  
This feature allows users to mark a message as having been “completed”. If a message has been sent to 
more than one person, such as a request to contact a patient, whoever completes the assignment has the 
option to mark ALL related messages as complete also. This gives the user the ability to assign 
messages to multiple users and then all users receive a passive notification (by having the message 
removed from their inbox) that the task was completed. 

Note:  Despite the similar sounding name this feature is DIFFERENT from the Mark Follow Up Message 
as Completed feature. 

To mark a message as complete: 
1. Select the message to be completed. 

2. Right-click on the message and choose Mark as Completed from the pop up menu. 

OR 

Click the Completed button on the toolbar. 

A Mark Message as Complete window will open. 

 
3. To mark the message as complete for all recipients, choose the appropriate radio button. 

4. Click OK when finished. 

Saving TaskMan Messages to Chart 
This feature allows TaskMan messages to be saved to a patient’s chart. The messages are converted to 
a new note type with an envelope icon and are stored in the Log / Phone Notes section of Chart View.  
This can be a handy feature when patient specific clinical information that was collected in a TaskMan 
message needs to be added to the patient’s chart. 

To save a TaskMan message to Chart: 
1. Select the message to be saved to Chart. 

2. Right-click the message and choose Save Log/Phone/Rx Note from the pop-up menu. 

OR 

Click the Save Message to Patient Chart button on the toolbar. 

A patient search window will open. 

3. Search for and select the patient. 

4. The confirmation window will appear, indicating “This message was saved as Log/Phone/Rx note 
for patient: PatientLast, PatientFirst.” 

5. Click OK. 
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Printing TaskMan Messages 
Messages sent to or received from other users can be printed if necessary. 

To print a message: 
1. Open TaskMan. 

2. Double-click the message to be printed to open it. 

3. In the View Message window click the Print button. 

OR 

Click to select the desired message 

4. Click the Print button on the toolbar. 

Deleting TaskMan Messages 
Users can delete a single or multiple messages in TaskMan. 

To delete a single message: 
1. Highlight the message to be deleted. 

2. Click the Delete button on the main TaskMan toolbar. 

OR 

Right-click the message and choose Delete from the pop-up menu. 

3. Click Yes in the confirmation window. 

Multiple messages can be selected and deleted at the same time in TaskMan.  However, only contiguous 
bulk selections can be made (by using the Shift key). Unlike normal Microsoft Windows convention the 
Control key cannot be used be used to select non-contiguous messages. 

To select and delete multiple messages simultaneously: 
1. Highlight the first message to be deleted. 

2. While holding the Shift key on the keyboard down, highlight another message. 

3. All messages between the first and second message highlighted will be selected. 

4. Click the Delete button on the main TaskMan toolbar. 

OR 

Right-click on the message and choose Delete from the pop-up menu. 

5. Click Yes in the confirmation window. 

Sending Messages from e-MDs Chart 
When a patient-related message is initiated from the main TaskMan module, a patient search must be 
performed in order to attach the patient’s chart to the message. However, if a patient chart is already 
open in e-MDs Chart, it can easily be messaged in TaskMan without having to open the full TaskMan 
application. 

To send a message from e-MDs Chart: 
1. With a patient’s chart open in e-MDs Chart, click the Messages/Task button. This button has a 

white envelope icon and is located in the chart toolbar, below the blue patient identifier bar. 

2. Choose the Create Message menu option.  
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3. In the next menu, select which type of message to send. Message types refer to the type of 
attachment that will be appended to the newly created message.  See the Message Toolbar 
Options table for more information. 

 
4. Complete the To, Subject, Priority, and Category fields. Type a note in the Message Body 

field. These fields are the same as if the message were being created in the main TaskMan 
module. 

5. Click Send. 

Message Toolbar 
Options 

 

Blank This message is NOT associated with the current patient and has no attachments. 
Portal Message This option prepares a message to be sent to the patient’s portal account. 
Attach Current Visit This option attaches the entire patient chart to the message, but when the recipient 

opens the attachment, the chart will open to display the current visit note in editable 
format. This option is disabled if there is no currently open visit. 

Attach Current 
Log/Phone/Rx Note 

This option attaches the patient chart to the message but when the recipient opens 
the attachment, the chart will open to display the Log. Phone or Rx note that is open 
at the time this attachment choice is made.  This option is disabled if there is no Log, 
Phone, or Rx note displayed in the chart at the time the menu is open. 

Attach Chart This option attaches the patient chart to the message. When the recipient opens the 
attachment in his or her Inbox, the patient’s chart (with full functionality) is launched. 

Attach Doctor Visit If this option is chosen, the Select Patient Visit window will open, listing all visit notes 
by visit date, provider, and diagnoses.  Click the correct visit from the list. This 
option attaches the entire patient chart to the message, but when the recipient 
opens the attachment, the chart will open to display the chosen visit note. 

Attach Nurse Visit If this option is chosen, the Select Patient Visit window will open, listing all visit notes 
by visit date, provider, and diagnoses.  Click the correct visit from the list. This 
option attaches the entire patient chart to the message, but when the recipient 
opens the attachment, the chart will open to display the chosen visit note. 

Attach Log/Phone/Rx Note If this selection is chosen, the Select Log/Phone/Rx Note window will open and 
display all Log, Phone, and Rx notes for the patient.  Click to select the desired note.  
The entire chart will be attached, but when the recipient opens the attachment, the 
selected note will be displayed. 

Sending Images from DocMan 
At the time that a new item is scanned or imported into DocMan (see Send an Image when Scanning or 
Importing for details), the user is prompted to send the image to the ordering provider, though this is not 
mandatory. Any image can also be messaged (via TaskMan) at any time after it has been scanned or 
imported. 

When an image is sent from DocMan, a Document Scan Notification appears in the recipient’s inbox in 
TaskMan. The image appears as an attachment to that message. The recipient can then view the image, 
add a summary or a memo, and sign it off (if not signed previously) all from TaskMan. 
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To send an image from DocMan via TaskMan: 
1. In the main DocMan window, select the image to be sent by clicking on the description.  

2. Click on the Message button on the toolbar (envelope icon) 

OR 

Click Tools and select the New Message menu option. 

3. This opens a TaskMan message with the image attached. In the New Message window select the 
recipient by clicking the checkbox to the left of the user or group name OR click the To button to 
search for and select a recipient. More than one recipient may be selected. When finished, click 
OK. 

4. Select a Priority level, if other than the default "normal". 

5. Select the Category to define where the image will be sorted in the recipient’s inbox. The 
Category type will default to the name of the category in which the image was stored in DocMan, 
but this can be changed. 

6. If desired, type a message in the white message field 

7. Click Send. 

Searching for a Message 
Users can search by Folder by Subject or by text in the body of the message. 

To search for a message: 
1. Click the Search button on the main TaskMan toolbar 

2. A Search toolbar will open. 

 
3. Choose the folder to search from the Search Folder drop-down list. 

4. Specify to search on Message Subject, Message Body, Message Subject and Body or Message 
Sender from the Search In drop-down list. 

5. Type in the word or words to be searched for in the Search For field. 

6. Click Search when all the criteria have been added. 

7. The messages will be filtered to show only those items that meet the search criteria. 

Getting Message Notifications 
There are several ways to know if you have received messages: 

• TaskMan Button on Dashboard:  When TaskMan is running in Dashboard, the button label 
changes from TaskMan to show a summary of messages that looks something like this: 
“M(4/1)T(0/0)”.  It is showing the number of unread messages and tasks and how many of them 
are urgent.  In this example, there are 4 messages, 1 of which is urgent; and no tasks. 

• New Message Sound:  You can copy any .wav file to the c:\program files\e-mds\solution 
series\apps directory and name it “newmessage.wav”.  When a new message is received, 
TaskMan plays the sound.  Of course, you need speakers to hear it. 

• Folder Count in TaskMan:  The Inbox folders show an unread message count to the right of the 
folder label. 
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• Message Count in Tracking Board:  The Workload section of Tracking Board shows the 
number of messages and tasks for the logged in user.  You can expand the folder tree to show 
the personalized folders that the user has chosen to display here and can also double-click a 
folder to go directly into TaskMan.  The folders can be displayed in red based on the number of 
messages received.  This, and the selection of folders to display, is user-specific and is set up by 
going to File > Options in Tracking Board and setting the preferences in the Workload tab. 

Performing Message and Folder Maintenance 
You can multi select and move multiple messages at the same time for ease of maintenance.  You can 
also delete messages to reduce the amount in various categories, and also remove deleted items from 
view. 

To move messages from one folder to another: 
1. Select by clicking a message or multi select by holding down your left mouse button and then 

dragging (or using Shift and the up or down arrow keys). 

2. Right-click and select Move to folder. 

3. Select the folder and click the checkbox item. 

Permanently Deleting Messages 
This function cleans up the list of messages in your Deleted Items box.  It is a good idea to do this 
periodically because over time the number of messages stored here can get very large and can affect 
retrieval time.  Note that messages are not permanently deleted, they are still in the database should you 
ever need them. 

Simply click the message or multi select; then click the delete button and answer the prompt. 

Populating the Refill Requests Task List from TaskMan 
The Refill Requests module in Chart is a work list that is specifically designed to handle this function 
which can consume a lot of clinician time.  It is a top to bottom stack of requests to be processed and 
gives providers immediate access to the patient chart and other information that is needed to approve or 
deny the request and then either message someone with a follow up or automatically approve the request 
and have the system automatically send it to the pharmacy. 

A number of requests are received by fax.  Assuming that the practice uses e-MDs FaxMan, those 
incoming faxes may be sent manually or automatically to certain users as TaskMan attachments.  The 
attachments viewer provides access to the Refills Requests system. 

To populate refill requests from TaskMan: 
1. Open the attachment on the fax message (can also be done from the Fax Filing folder in 

DocMan). 

2. Search for and select the patient.  The Refill Request Form with the patient’s current medications 
opens. 

3. Based on the incoming fax check off the medications to be refilled. 

4. Select the Provider who needs to approve and click Save. 
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Understanding the Messages/e-Mail Interface 
The Main TaskMan toolbar includes standard buttons similar to many e-mail programs.  Several of the 
functions behind these buttons can also be accessed using the menus. 

Main Messages Toolbar 
Buttons 

 

New Opens a screen in which new e-mails are created.  Clicking the arrow next to this 
button provides options for sending other message types including portal messages 
and messages sent to an external Direct Address. (See the Using Direct Messaging 
section provided later in this chapter.) You can also use the File menu to initiate new 
messages of each type. 

Print Prints the selected message. 
Mark as Completed Sets tracked messages to be completed.  Marking a message as completed 

automatically moves it to the Completed Items folder and have a green flag icon in 
the follow up column. 

Mark for Follow Up Sets a follow up date for a message that you have received.  Messages with a follow 
up are displayed with a red flag icon in the follow up column.  The Actions > Check 
Followup function filters the inbox messages to those with a follow up flag. 

Delete Deletes a message. 
Reply Replies to a selected message. 
Reply to All Includes all cc’d parties on a message in your reply. 
Forward Forwards a message to other users. 
Category Opens the category editor where inbox and tasking category folders can be set up. 
User Setup Sets up favorites or quick list users and groups of users to message.  Your entries 

make it quicker to send messages because you can tap a checkbox versus having 
to type and search. 

Search Opens filters to search for messages. 
Send/Receive Refreshes the data. 
Save Message to Patient 
Chart 

Opens a patient search so that users can automatically add a message to a 
patient’s chart as a log note. 

Legend Shows a legend describing the different icons in TaskMan. 
Help Loads the application help system. 
Exit Closes TaskMan. 

 
 

Main Messages Columns, 
Folders and Icons 

 

Folder Tree The left column shows the different folders where messages are stored.  The 
standard folders are Inbox, Sent Items, Deleted Items, Completed Items and Outbox 
Items.  The Portal Unread Messages and Portal read Messages folders used for e-
MDs Patient Portal messaging and show which messages that you sent have been 
read by users.  Like e-mail, these folders hold newly received messages, messages 
sent by the user, and messages deleted from the inbox and sent folder, respectively. 
When TaskMan is opened, the Inbox folder auto-expands, while the Sent and 
Deleted folders remained closed.  The Inbox sub-folders are customizable and are 
set up using the Category editor and which help organize messages. These 
customizable folders might be thought of as an organized "To Do" list. For example, 
there may be folders for “Admin”, “Collections”, "Refill Requests", and "Phone 
Messages”.  To see all messages, click the main Inbox folder.  To filter messages by 
category, click the sub-folder.  If you do not see specific folders, it is because you do 
not have any Inbox items which were classified into these categories. 
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Messages/Tasks Toggle Clicking the blue and orange bars at the bottom left is how you toggle between the 
messages and tasks in TaskMan.  Whichever is orange is open.  The Tasks bar also 
includes a count of Unread, Coming Due and High Priority tasks. 

Message List Navigation You can click on any column heading to use it as the sort order (ascending or 
descending).  A small up or down pointing triangle appears in the column heading to 
denote if it is the sort order.  You can also use the mouse wheel to scroll through 
messages. 

Message List Columns The upper right window lists messages for the selected folder. Unread messages 
are in bold.    The different columns and icons in this screen are: 
○ !: Message priority.  The column is blank for normal priority items, contains one 

red exclamation point for urgent issues, and two exclamation points for stat 
messages. 

○ Read Status: A yellow envelope indicates unread messages, gray ones are for 
read messages.  Red and blue arrows indicate if the message has been replied 
to or forwarded.  Messages from the e-MDs Patient Portal have a planet Earth 
icon on the envelope.  Messages from the SureScripts e-Prescribing interface 
have a red box with a white S. 

○ Paper Clip: Displays a paperclip icon if the message contains one or more 
attachments. 

○ Follow Up Messages: Messages with an icon in this column are flagged for 
follow up.  If the icon has a red flag, this is a message that still needs to be 
followed up on.  A blue flag indicates that the follow up is complete. 

○ From/To: In the Inbox, this column displays the name of the sender. In the Sent 
folder, it shows the recipient. 

○ Subject: Displays the subject matter of the message (if the sender included 
one). 

○ Date Sent: The date and time that the message was sent. 
Message Body The text for the selected message is shown below the list.  The gray bar above this 

shows From, To, the subject and when the message was first viewed.  At the far 
right end of the gray bar, a yellow paperclip icon appears if the selected message 
has attachments. Click this paperclip to open the attachments. 

Message Right-Click Menu A number of functions that are typically also available on the menus and/or toolbar 
are available by right-clicking a message.  You can Reply, Reply to All, Forward, 
Delete, Mark as completed, set messages for follow up, Move messages to other 
folders, mark messages as read/unread and save messages to Chart as log or 
phone notes.  These functions are described in more detail elsewhere in this 
section. 

Using Direct Messaging 
Direct messaging refers to a special type of email designed specifically for sending health information 
securely over the Internet. Direct messaging must meet standards established by the Direct Project, 
which is an open government initiative started by the Department of Health and Human Services' Office of 
the National Coordinator (ONC) for Health Information Technology. 

If you are registered for Direct messaging, you can send and receive Direct messages in TaskMan. 
Inbound Direct messages will be placed in your Inbox folder; a copy of outbound Direct messages will be 
saved in your Direct Sent folder. 

Note: Outbound Direct messages can be sent to a Direct Address only; they cannot be sent to a regular 
email address.  A Direct Address will typically have the word “direct” in the address.  
“cardio.kevin@direct.updox.com” is an example of a Direct Address. 

To register a clinic: 
1. For the user that will be setting up the Direct Messaging, assure that a default facility is set in 

Chart. This is required for the registration process to be successful.  
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2. To confirm that you have a default medical facility:  In Chart, go to File and look at Change 
Internal Medical Facility. The default will be listed or can be set here. 

 
3. In the Chart module menu, click File > Direct Messaging Setup.  

4. On the Direct Messaging Setup screen for Step one, enter the clinic domain-name and click 
Register. This will be a fixed component of each Direct Address related to the clinic and its 
providers. If you select a domain name that is already assigned, a message box will appear to 
prompt you to make another selection.  When selecting a domain-name it must be between 8 and 
30 characters in length and only letters, digits and hyphens are permitted. 

IMPORTANT! Once a domain is chosen and registered for the clinic it is unable to be changed 
and permanently assigned. 

The large checkmark will turn green when the domain is registered.   

 

5. The Direct Messaging service provider requires additional verification to activate your Direct 
Messaging service. Click the Direct Messaging Verification Link to open the external validation 
form. This link will open a webpage outside of Solution Series.  

The Updox NPI Practice Information form will need to be completed once, using a single 
provider’s information. This action will validate the practice (clinic) by verifying the registering 
provider’s identity and allow for the Direct address registration of licensed clinic providers. 

Notes:  The person registering with their Individual Provider NPI must have matching personal 
credit card information to be used in the identity validation process. Credit card information 
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entered is never stored.  

 

IMPORTANT! 

The following items may not be permanent characteristics of the Updox form’s functionality but 
are included here as help references before using the Get Help* service: 

a. In the State field, both initials must be capitalized. 

b. Do not use dashes in the Phone Number field. 

c. After you click the Check Verification button, the Apps folder will open. Close out of the Direct 
modal and access File > Direct Messaging Setup once more. 

*For assistance in completing the Updox verification form, click the Get Help button located at the 
bottom of the verification page. A message will appear indicating that Updox Support has been 
notified. 

 

6. After the external validation is complete, go back to Solution Series and in Step two, click Check 
Verification. The checkmark should turn green and Step three for Provider Registration will 
become active. 

 

a. To enable the sending and receipt of Direct Messages, the e-MDs Secure Messaging Service 
must be (re)started. Click the Windows button + R and type in ‘services.msc’.  

b. Locate e-MDs Secure Message Service.  

c. Right-click on the e-MDs Secure Message Service option and select Start or Restart. 
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7. Return to Solution Series for step three in the Direct Message Setup window. Choose Providers 

you want to register by clicking the Select box next to their name.  

8. When Providers have been chosen, click the Register Selected Providers button.  

As the Providers are registered, the Direct Messaging Address column within the grid will 
populate. 

 

9. When all of the selected Providers have been assigned a Direct Messaging Address, the process 
is complete, simply close the window to exit.  
Notes:  After the initial registration, multiple Providers can be added by repeating the grid 
process in step three, OR from the Staff Provider Maintenance screen as shown in the following 
steps. 

 

To register a Provider after initial clinic registration: 
1. In the Chart module menu, click Demographics > Providers & Staff > Staff Providers. 

2. Search for the Provider you want to register and click Edit.  

3. In the Edit Provider window go to the Misc. tab and click Register Direct Address.  The Direct 
Address field will populate. Or select the Provider’s name from within the Direct Message Setup 
grid, and click the Register Selected Providers button. 

 



 

e-MDs Solution Series Utilities Guide 8.0 R01 81 
 

To send a Direct Message from TaskMan 
1. In the TaskMan toolbar, click the down arrow and then select New Message via Direct. 

 
2. The Direct Message Compose window opens. The system automatically populates the From field 

with the Direct Address of the logged in provider. 

Note: The registered provider’s Direct Address must be entered in the demographics record. 

3. In the To field, type a Direct Address. (No address book is available. However, if you have 
previously entered a Direct Address, that address will be remembered and will be displayed in a 
drop-down list when you begin to type in the To field.) 

4. Type the message text and then click the Send button. 

Tracking Tasks 
A task is an assignment that can be tracked through to completion. Tasks can either be personal tasks 
(ones assigned to your) or can be ones that are assigned to others. For example, a personal task can be 
created to remind you to look for lab results for a particular patient when they should be available no later 
than a certain date. Or a task can be assigned to another person in the clinic (medical assistant, nurse, 
billing person, etc.) to do the same thing. 

To access TaskMan tasks: 
1. Open TaskMan from Dashboard or Tools > TaskMan in several of the other Solution Series 

modules. 

2. Make sure the Messages bar at bottom left is orange meaning to indicate that you are in the tasks 
section.  If not, click it to switch from messages. 

TaskMan always opens to show the tasks for the logged in user.  The login name is displayed at the top 
of the window.  The toolbar includes buttons for working with tasks. 

Main TaskMan Toolbar 
Buttons  

 

New Task Starts a new task. 
Edit Task Opens a highlighted task. 
Print Prints the specific task. 
Mark as Completed One of several ways to mark a task as completed and move it to the Completed 

folder. 
Shortlist Users/Groups Opens the tool to create and select shortlist users to whom you frequently send 

messages or tasks. 
Refresh Updates the task list. 
Search Opens a search window so you can locate specific tasks and also view archived 

(soft-deleted) tasks. 
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Legend Opens the legend if you need assistance with understanding different message and 
task display fonts and icons. 

 

Main TaskMan Columns, 
Folders and Icons  

 

Inbox, Send Out and 
Completed Folders 

These are folders into which the system automatically places tasks.  You can add 
multiple levels of personal folders to the Inbox and set up folder rules to put 
incoming tasks into these.  The Inbox also shows counters of unread/coming 
due/high priority items by folder.  The Send Out box lists all tasks you have sent and 
is a way to see their current completion status.  The Completed folder is where the 
system automatically puts tasks that you have marked as completed. 

All Tasks Folder Users with the TaskMan Administrator security privilege will also have this folder in 
the tree.  It is a way for an administrator to open a search screen to generate a list of 
tasks for multiple users so that activity across the organization can be monitored, 
tasks reassigned or employees reminded to get work done, and so on. 

Messages and Tasks 
Toggle 

The blue and orange blocks at the bottom left are toggle buttons to move between 
the TaskMan messages and tasks interfaces.  The active one is displayed in 
orange.  The TaskMan block also shows a count of unread, coming due and high 
priority items in your inbox. 

Categories The main folders are then subdivided into sub folders (referred to as Categories), 
which help organize Tasks. These customizable folders might be thought of as an 
organized "File Cabinet" for tasks. For example, a physician might have a folder for 
"Refill Requests", another for "Administration”, and another for "Collections Work 
Lists." Categories are set up in the messaging section of TaskMan. 

Task List If the user clicks any of the main folders in the tree, the Task Summary window on 
the right lists all tasks in that folder. If, instead, a subfolder is selected, the window 
displays only those tasks in the selected category.  The columns in the list are: 
○ !: Displays the priority of the task; the box is blank for normal priority items, 

contains a downward pointing green arrow for low priority tasks and a red 
exclamation mark for high priority tasks. 

○ Paperclip: Displays a paperclip icon next to the task if the task contains an 
attachment or is blank if there is no attachment. Double-clicking the paperclip 
icon or using the right-click Open Attachment option opens it. 

○ Completion Status: The block in this column is empty for incomplete tasks 
and checked for complete tasks.  Clicking the block in the list is one of the 
ways to mark a task as complete and automatically moves it to the Completed 
folder.  You can also mark completed tasks as incomplete by clicking the box. 

○ Task #: Sequential number assigned by the system for tracking purposes. 
○ Task Description: Displays the description entered by the user who sent a 

manual task or set up an automated one. 
○ Created By: The person who set up the task. 
○ Date Created: The date the task was created.  Automatic tasks show the date 

that the job was run, not the original setup date since a task may (and should) 
run repeatedly. 

○ Date Due: Displays this if one was set.  For automatic tasks users set up a 
number of days from the date that the task is generated by the server so a 
calculated date is displayed. 

○ Date Completed: Date the task was completed. 
○ %: Shows the completion percentage.  This can be set manually by a user but 

for some task types the system can calculate this automatically.  An example is 
a collections work list where there are a defined number of invoices and users 
have a function to mark those they have “worked” as completed, so a 
percentage is easy to calculate.  Setting a task to 100% completed is another 
way of automatically moving it to the Completed folder. 
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All Tasks This is described in more detail elsewhere.  Clicking on the folder loads a filtering 
window for the administrator to selectively load a list of tasks.  Clicking Retrieve 
pulls up the list.  This list also includes the current status such as In Progress, 
Declined, etc. 

Note:  Completed tasks are automatically moved to the Completed folder and it is displayed with a line 
through the text in several of the descriptors.  It also has a check in the completion status box, and should 
also have 100% in the % box.  Some task attachment types are work lists that the system can use to 
automatically calculate the % complete.  Note that if there is more than one attachment of this type on a 
task, the completion status is based on the first one. 

Setting Task Options 
There are a number of options that can be used to customize the tasks interface display. 

To customize the tasks interface display: 
1. Go to File > Options. 

2. Set options based on their explanations below: 

○ Refresh Rate: This system-wide setting is not user-specific.  It determines how often the 
system queries the server to update the messages and tasks as well as the counters on the 
folders, TaskMan dashboard button and the tasks bar at bottom left.  The minimum setting is 
30 seconds but e-MDs recommends a much higher value such as 10 minutes because more 
frequent querying adds to the load on your server.  If you have a lot of users this can affect 
overall performance.  The task list refreshes automatically as you move between screens 
anyway. 

○ Coming Due Days and Color: This gives you the ability to set your personal preference of 
displaying tasks in a different color if they are coming due within a certain timeframe.  The 
middle number in the task counters is also updated based on this. 

○ Include Sub-Folder Items in Higher Folders: This preference controls the display of the 
unread/coming due/high priority counters for each Inbox folder.  When the box is checked, 
then the Inbox folder count includes the sum of all sub-folders.  Likewise, if you have multiple 
sub-folder levels, the counts for the lower levels are rolled up into the higher ones.  If it is 
unchecked, each folder only displays the count of items in its folder. 

○ Auto Archive:  The archive function automatically soft deletes tasks but only if they are in 
the Completed folder.  Check the Auto Archive Completed Items box to activate this function 
and then set the number of days from the task create date on which the system soft deletes 
it.  We recommend that you use this because after a while you will accumulate a large 
number of tasks which, when you open the Completed folder, will all try to load and will take 
an increasing amount of time.  Note that the search function and administrator All Tasks 
filters both have options to retrieve archived tasks. 

○ Folder Rules: Folder rules help to automatically move incoming tasks to specific folders 
based on the task name/subject, task type, or sender.  To set up a folder rule: 

3. Set options based on their explanations below: 

4. Click Folder Rules. 

5. Click New. 

6. Enter the rule name. 

7. Select the rule criteria.  Based on the type, the criteria options change.  For Subject line, enter the 
text you want to match on.  For Task Type, select from the different attachment types.  For 
Sender, select a user login. 

8. Select a folder from your personal inbox list. 
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9. Review the rule criteria which are displayed at the bottom of the Edit Rule window. 

10. Click Save.  It is displayed in the Folder Rules window.  You can click the rule to see the criteria 
in the bottom half of this window too. 

11. Select the rule and use the Move Up and Move Down buttons to change its order in the list.  If a 
task is received which meets the criteria for multiple rules, it is moved to a folder based on the 
rule with the highest precedence. 

12. Click Save. 

Creating Custom Tasks Folders 
Users can create their own personal tasking folders.  These are a useful way to categorize incoming 
messages by type so that you can process shortlists more easily.  You can drag tasks from one folder to 
another and you can also set up the folder rules described above to have the system automatically move 
incoming tasks into the folders.  You can create multiple levels of folders if that works for you. 

To create task folders: 
1. Select and then right-click the Inbox folder to which you want to add a sub-level. 

2. Click New Folder. 

3. Enter the folder name in the box to the right of the folder that appears.  The name must be unique 
for the parent folder. 

You can edit a folder name if necessary using the right-click Rename function or by double-clicking the 
description.  The right-click delete option is used to remove a folder but if you have items in the folder, the 
system will prompt you to move them to another folder and shows a list of folders.  If the folder you are 
deleting has sub-folders, you also have the option to move those.  Tasks are moved appropriately. 

Performing General Task Functions 
Tasks can either be personal tasks (ones assigned to you) or can be assigned to others. 

To create a task: 
1. Open TaskMan to the tasks interface. 

2. Click New. 

3. Select recipients using the shortlist checkboxes or using the To button.  If you are sending 
yourself a task/reminder, no recipients are necessary. 

4. If the task is to be split into separate tasks for each user, check the option to Send as Multiple 
Tasks.  If this is not checked then when one user completes the task it is moved to the Completed 
box for all users. 

5. Enter a Subject. 

6. Select the Due Date, Start Date and Priority. 

7. Type the message associated with the task in the Task Memo section. 

8. Add attachments if desired by clicking the Attachment button.  You can add multiple attachments 
for different patients if you want.  See the Attachment Options table for a description of the 
supported types. 

9. If the task attachment type is a particular work list type the Enable Worklist option to the right of 
the To field may become available.  Check the field so that the completion % is automatically 
updated as users complete records in the list. 

10. Click Send. 
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Attachment Options  
Chart You can send an entire patient chart, or specific doctor and nurse notes or log 

notes.  In all cases the complete Chart interface is opened; the difference is whether 
it opens to a specific entry or not.  Select the patient and then the specific record. 

DocMan After selecting a patient a list of all the files in that person’s DocMan folders is 
loaded.  Check off the ones to send then click the attach button.  You can open a file 
to check it is the correct one using the View Document button. 

Lab Code Library Sends task types for users who are familiar with linking electronic lab 
results/observations to the master flow sheets in e-MDs Chart so that these can be 
automatically parsed. 

Bill There are multiple types some of which can also be used to generate Schedule, 
DocMan and Chart oriented tasks.  For manually created tasks these typically send 
the interface to a module with predefined filters so that when the recipient opens the 
attachment a work list of entries is quickly loaded.  All of these can be automated to 
run on a repetitive basis and typically those save parameters which are executed to 
retrieve items when the task is run since that could many times from now and into 
the future. 

Collections Worklist Set the filters and retrieve the list.  Give the work list a name, then click Save and 
Exit. 

Referrals Worklist Set filters then Save and Exit.  When a referral work list is opened as a task 
attachment an additional completion status column appears on the left on the 
window.  Complete and Incomplete buttons above the work list give users the ability 
to update their progress. 

Invoice Status 
Administration 

Set filters, click Search then Save and Exit. 

Daily Work List This gives you the ability to generate many different kinds of work lists.  When the 
DWL interface is opened as a TaskMan attachment it has an extra column to the 
left.  Double-clicking the cells adds or removes a green check mark to denote 
completed items.  There are also two buttons to do this at the top right. 

Statements Set the filters; then click Save and Exit.  Of particular note is the option to use the 
server-based dynamic Use Current Date for the Last statement on or before filter.  If 
the task may be completed several days after sending it and you do not want to 
miss any accounts which have accrued billable balances since then, check this box 
so it is not fixed to the task create date.  The only thing the recipient will be able to 
do in the Options tab is change the Printed statement date. 

HCFA Wizard Set up the Options and then the other information and filters in Steps 1 and 2 and 
save.  Disregard the batch number in Step 1 which is set to 0.  It will be created 
when the task recipient executes the job.  The attachment opens at Step 2 so that 
the recipient can click Next to gather and print the claims. 

Electronic Filing Wizard Set up the Options and then other information and filters in steps 1 and 2 and save.  
The recipient’s attachment opens to Step 2 so that the rest of the wizard can be 
navigated to generate a claim file. 

ABN/Forms Incomplete This generates a list of forms or scans that are not in the system but which are 
required based on CPT rules.  Set filters, then click Save and Exit. 

Electronic Remittance Sends a work list of ERAs that may need to be posted and from which the user can 
open the ERA posting window. 

Visits to Bill Sends the posting ledger window Visits window as a task so that users can build 
claims from Chart. 

Insurance Eligibility Set filters; then click Save and Exit. 
Registry Processor Gives you the ability to generate notices, letters, etc.  The recipient will open to the 

preview. 
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Schedule Although there is currently only one attachment type under this category, keep in 
mind that the Daily Work List and Insurance Eligibility Bill attachment types are 
cross-over types. 

Appointment 
Confirmations 

A list of appointment confirmations based on status. 

To accept a task: 
The recipient of a task can open it and use the Accept button on the toolbar to set him/herself as the 
owner.  If you’ve sent a task to yourself, you are automatically assigned as the owner. 

To redirect a task: 
Tasks may be redirected because they were inadvertently sent to the wrong person or because the 
original recipient may be unable to complete it for one reason or another. 

• If the task was sent to you, open it then click Redirect Task and select another recipient.   

• If you sent the task to someone else, click the Send Out folder to find the task then use the same 
steps. 

To change the status of a task: 
1. A task recipient can update the current status of a task so that the sender and administrators can 

see progress.   

2. Open the task and select an option in the Status field.   

3. Status options are Assigned, Not Started, In Progress, Waiting on Someone Else, Declined 
and Completed.   

4. Save the task after changing the setting. 

The Completed status can also be set in other ways as described next. 

When a task is completed it should be marked as such by the person who accepted it.  A task can be 
marked as complete in multiple ways.  When a task is marked as completed it is automatically moved to 
the Completed folder. 

To complete a task: 
1. Click the box in the status column. 

2. Right-click the task and click Mark Complete. 

3. Set the % Completed to less than 100%.  Note that tasks which are enabled work lists that 
automatically calculate the completion percentage will override manual settings. 

4. Open the task and set the Status to Completed. 

If a task is marked as completed by mistake it can be reset.  Click the Completed folder then uncheck 
the status box or right-click and select the Mark Incompleted option. 

To print a task: 
Printing a task is easy.  Select the task in the task list and click the Print button on the toolbar. 

Automating Tasks 
One of the most powerful aspects of TaskMan and Solution Series is the ability to set up the system so 
that it sends multiple different tasks types to users on a repetitive basis.  This can ensure that things 
which need to be done are routed to people in the organization in a systematic manner so that completing 
them becomes part of the routine and not something that will be “dealt with later”. 
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You can generate tasks that are work lists or reports using Report Manager or the Tasks function in Rule 
Manager.  Reports are saved as a PDF file and the task includes an attachment icon that is actually a link 
to open the report.  You will need to have a PDF reader installed on your workstation to view these.  Go 
to www.adobe.com to download their free reader if you do not already have one.  Other tasks can be 
work lists which send the user an interface with a preloaded list of records meeting the task criteria. 

The important thing to understand is that although you can set up a task to run once on a predefined 
date, the real power is to create repetitive tasks that only need to be set up one time and are then set to 
run daily, weekly, or monthly.  This is possible through the use of various functions like dynamic date 
filters which give you the ability to generate tasks based on Last, Current or Next time periods such as 
number of days, months, quarters or years.  These do not restrict you to the same range each time (which 
would then make the report or task useless after an iteration or two).  They base the task off the current 
server date. 

In addition to the productivity benefits of task automation there is also a benefit in terms of reducing 
server overhead during busy periods.  You can set up Report Manager and Rule Manager to run during 
off peak times so that intensive operations do not have the potential to affect other tasks.  Keep in mind 
that you need to take into account the timing of other maintenance plans such as backups. 

• Report Manager: Report Manager module types can be routed as tasks.  Despite its name, 
Report Manager also includes some work list interfaces. 

○ Accounts Receivable Report (Patient, Guarantor, Invoice) 

○ Activity Analysis Reports (there are 11 different report options) 

○ Case Tracking Report 

○ Eligibility Check Worklist (saves an ANSI 270 eligibility check file into a directory which you 
may also have monitored by other programs that automatically upload the file to a payor or 
clearing house). 

○ HCFA Wizard (saves individual PDF files for each HCFA generated; users can multi select 
these and print all using standard Windows functions). 

○ Illness and Injury Report 

○ Insurance AR Report 

○ Patient Statement (also saves individual PDFs) 

○ Work Restrictions Report 

○ DOQ-IT Estimated Compliance Report 

○ DOQ-IT HL-7 File Generation (generates a file for uploading to CMS) 

○ DOQ-IT Patient Flag Update (if this is set up as a task it is really just a notification that this 
has been done since the flag update is setting database values). 

• Rule Manager Tasks: These are mostly interfaces.  There is some cross-over with Report 
Manager tasks such as Statements and HCFAs.  The difference is that the Rule Manager task 
sends the interface from which the user starts the print job whereas Report Manager has already 
generated PDFs on disk. 
○ Collections Worklist 
○ Referrals Worklist 
○ Invoice Status Administration 
○ Daily Work List 
○ Statements 
○ HCFA Wizard 
○ Electronic Filing Wizard 

http://www.adobe.com/�
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○ ABN/Forms Incomplete 
○ Electronic Remittance 
○ Visits to Bill 
○ Insurance Eligibility 
○ Registry Processor 

Setting Up Report Manager Tasks 
Report Manager is a module that can be run automatically using the Windows Scheduled Tasks program.  
You can also open the module and run the jobs manually if you want.  It is a timesaver regardless 
because you do not have to set parameters each time.  You can also refer to this section for defining the 
default network folder path in which reports are saved if they do not have a specific path identified in the 
specific job setup. 

To send a task based on a Report Manager job: 
1. Go to Reports > Report Manager in Bill or Schedule. 

2. Click New. 

3. Select the Billing or DOQ-IT job type and the specific job. 

4. Set the Job information, parameters.  Of specific note is that when you open the parameters 
window you will almost always use a dynamic date filtering option so that the job can be run 
repetitively and still retrieve current information.  For statements and accounts receivable reports 
there is no Dynamic Date but there are options to use a Current Date.  All use the server date at 
the time of running the job when calculating which dates to use. 

5. Set the storage file path.  Keep in mind that because a report is saved as a PDF and because 
users may forward tasks to other people, a report that you do not want someone to see could still 
end up in their task list.  Thus it is a good idea to have storage directories for automatically 
generated reports which have network security rights to prevent unauthorized opening of the 
reports even if the user has a task with a link to it. 

6. Click the Task Info tab.  This is where you can make this job send a TaskMan task. 
a. Check Generate Task. 
b. Enter a Task Name value.  This is what the task recipients will see as the task 

subject. 
c. Enter the Attachment Description value. 
d. Select a Sender Name.  It defaults to the login of the user setting up the task. 
e. Set the Priority and Due Days values. 
f. Click the Add/Modify button to pick users and/or user groups to assign to the task 

(groups are in bold).  Then click OK to add them to the task. 

7. Click Save. 

Setting Up Rule Manager Tasks 
Rule Manager is a module that can be run automatically using the Windows Scheduled Tasks program.  
The same instructions for setting up Report Manager to run automatically can be used for Rule Manager 
except that in Step 12 you should point the scheduled task to run the RuleManager.exe program located 
in the e-MDs installation directory. 

You can also open the module and run the jobs manually if you want.  It is a timesaver regardless 
because you do not have to set parameters each time.  You can also refer to this section for defining the 
default network folder path in which reports are saved if they do not have a specific path identified in the 
specific job setup. 
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To send a task based on a Report Manager job: 
1. Start Rule Manager in e-MDs Dashboard (you must have the Dashboard Rule Manager security 

privilege to do this). 

2. Click the Tasks tab. 

3. Click New Rule. 

4. Select the Task Rule Type. 

5. Enter the Rule Information: 
a. Enter Rule Name and Rule Description values.  Make these as descriptive as possible so it 

is easy to see what this specific task does simply by scanning these columns in the main Rule 
Manager window.  The Rule Name is what will appear in the task Subject. 

b. Make sure the rule is active.  If it is not the system will not run it automatically although the 
main Rule Manager window does have an option to show inactive rules which can then be run 
manually. 

c. Select the Sender.  It defaults to the person setting up the task. 

d. Set the Parameters for the task type.  Remember to use Dynamic date filtering options 
wherever possible so that the job can be run repetitively and will retrieve current information.  
the Statements to Print task does not have a Dynamic Date range option but the Current Date 
works the same and bases the data retrieved on the server date when the job is executed. 

e. Set Priority and Due Days. 

6. Click the Result tab.  

7. Click the Add/Modify button to pick users and/or user groups to assign to the task (groups are in 
bold); then click OK to add them to the task. 

8. Click the Result tab and set the Schedule.  Keep in mind that the EOW day and EOM date are 
based on the settings under Rule > Setup in the main Rule Manager window.  These give you 
the ability to define the day of week and day of month.  The latter is particularly useful for tasks 
that are based on a “Last” reporting period since you can give yourself time to reconcile the prior 
month instead of always having to run it on the last day of the month. 

9. Click Save. 

Once you have set up the automatic Windows Scheduled task users in the system will start receiving the 
task on a regular basis but with different data based on your parameter settings. 

Searching for Tasks 
Sometimes it is hard to find a task despite the various display options such as column sorting and color 
coding.  The search function can be used to find tasks by a variety of criteria. 

To search for tasks: 
1. Click the Search button on the toolbar to open the search filters above the task list. 
2. Set search criteria: 

○ Search Folder: Select from all or Completed, Inbox or Send Out. 
○ Search In: Pick from Subject, Memo, Subject and Memo, or Sender. 
○ Search For: Enter the starting characters of the text string.  To do a partial string search start 

enter the % sign before your characters (e.g. “%abc”). 

○ Show Archived: Includes archived/soft-deleted tasks in the search results. 

3. Click Search. 
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The search window stays open until you click the red X at the right of the search filters or you 
close TaskMan. 

Archiving Tasks 
The archive function is a utility which soft deletes messages in the Completed folder.  It is recommended 
that this is done because after a while the number of records in the folder will be huge and mostly of no 
use.  The larger the list, the longer and longer it will take for the system to retrieve them each time you 
click the folder.  Archiving can be done manually or automatically: 

• Manual:  Click the Completed folder, right-click the task and select Archive. 
• Automatic:  In the File > Options window you can activate the auto archive option and the age 

of the tasks to archive. 

Archived tasks can still be retrieved if necessary.  A user can view assigned tasks by using the search 
function which has a checkbox to Show Archived tasks.  An administrator has the same option in the All 
Tasks filters window. 

Administering the Task Interface 
The tasks interface has a special administration function.  If you have the TaskMan Administrator security 
privilege, a special “All Tasks” folder appears in the list at left.  All Tasks allows the user to search for and 
view tasks for other all users, not just for tasks received or sent by the administrative user. This makes 
the All Tasks view a powerful tool for monitoring and ensuring that all users are keeping up with their task 
list. This window also allows tasks to be redirected to a different staff member. 

To retrieve a task list: 
1. Click the All Tasks folder. 
2. Set filters, your preference for the number of records to display on a page, and whether to include 

archived/soft-deleted tasks. 
3. Click Retrieve. 

Auditing Tasks and Tracking User Productivity 
There are two audit reports to track task activity and user productivity: 

• Task Audit: Tracks creation, assignment, acceptance and other granular level detail of what has 
been happening with tasks.  This audit report also tracks automatically created rules.  There are 
several output formats and a nice summary table that counts each activity type by user. 

• Task History: Opened from within a specific task this provides an element level detail of all 
activity and changes associated with that task. 

To print the Task Audit Report: 
1. Click Reports > Task Audit in the tasks section of TaskMan. 
2. Set the Report Format. Standard shows a chronological list of all activity followed by a summary 

table by user and activity type.  Summary only is just the table.  Group by user is a chronological 
activity list grouped by specific person. 

3. Set Activity Types. 
4. Pick one or more users to report on. 
5. Set an Activity Date Range. 
6. Click Print or Preview to generate the report. 

To print a task history: 
1. Open the task upon which you want to report. 
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2. Click Show History. 
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4 
FaxMan 

Throughout the Solution Series documentation you will find instructions for sending 
information to fax machines and printers.  This section provides instructions for 
setting up and using FaxMan and other tools to customize fax settings and manage 
fax processing and access. The entire faxing solution is composed of: 

• FaxMan to define how faxes should be processed when they are sent or 
received. 

• Fax Server to manage the flow of faxes between various servers and 
environments as they move in and out of different areas. 

• DocMan and TaskMan for processing the faxes as they interface with other 
applications such as Chart, Bill and Schedule. 

• Solution Series modules that generate faxes for various purposes, such as 
prescribing medications, receiving information from outside resources like 
labs, and transmitting information to patients and other healthcare providers. 

Continued on the next page ... 
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Setting Up and Maintaining FaxMan  
FaxMan is an overall fax management tool for use with e-MDs Solution Series. FaxMan provides 
seamless control over inbound and outbound faxes. Most of the fax processing is handled automatically 
based on the options set on the Configuration tab of the FaxMan screen. The exact handling of each fax 
will depend on what type of fax is being processed, who it is to and from, and who is currently logged on 
viewing the fax information. 

FaxMan is accessed by going to Windows Start  All Programs  e-MDs and selecting FaxMan, or 
through your desktop shortcut. Most of the options configured in FaxMan are matched to the user 
currently logged on Solution Series. That means the handling of faxes for each user will depend on their 
custom settings on the Configuration tab of this screen. 

 

Setting FaxMan User Options 
Users can set their own options in the Notify Rules for Current User section.  With those options, each 
user can create a list to identify who can see their faxes, who to notify if their fax jobs fail, and who to 
notify if there is a delay in transmitting faxes for a predefined amount of time. A separate list can be 
created for each user option in this section. If the word List is red on the option button, no list currently 
exists or is active for that user. When a list is created and is active, the List button text will turn to black. 

See Fax Configuration Tab Options for a description of each available user fax option. 

To create or update user fax lists: 
1. Click the List button for the option. A list of all current system users will display. If you are editing 

an existing list, all users will be displayed and those already on the list will have a check mark 
next to their names. 



 

e-MDs Solution Series Utilities Guide 8.0 R01 94 
 

2. Check the box next to each user to be added to the list. If you are editing an existing list and want 
to remove current users, click the check box next to those user’s names to deselect them. 

3. Click OK to save the list.  

Understanding Fax Administration Permissions 
The following levels of administrative authority can perform specific fax management functions as 
described below: 

• FaxMan Administrator: An individual who does not otherwise have administrative authority in 
Solution Series can be given FaxMan Administrator permissions to manage all fax servers and 
perform other fax administrator functions. FaxMan Administrators can also designate other users 
through the Maintain Server Permissions option in the Server Configuration Settings section. 

• Fax Server Administrator: A fax server administrator can be designated for each fax server, if 
desired. This permission level does not authorize the individual to perform general Solution Series 
Administrator tasks nor FaxMan Administrator tasks in the Admin. Setup section. The Fax Server 
Administrator is authorized only to set options in the Server Configuration Settings section for the 
server(s) for which that individual has permissions. 

• Solution Series Administrator: This permission level can perform all Solution Series administrative 
tasks, including the ones designated for a FaxMan Administrator and a Fax Server Administrator. 

Administrators can set or change all options except the individual user option of Allow others to see my 
faxes. Non-administrator logins will not have access to the Admin Setup section of the main FaxMan 
screen. See e-MDs Solution Series Administration Guide for more information about permissions and 
access levels. 

Setting Fax Server Options 
The Server Configuration Settings section contains options for managing individual fax servers. You 
must be designated as a Solution Series Administrator, FaxMan Administrator, or Fax Server 
Administrator to add, update or delete these settings.  Fax server options are accessed in the lower-left 
section entitled Server Configuration Settings. 

 
Note:  A Fax Server Administrator must have specific permissions for a fax server to perform server 
administration tasks. This permission can be given by a FaxMan Administrator or a Solution Series 
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Administrator through the Maintain Server Permissions option in the Server Configuration Settings 
section of the Configuration tab. 

To set fax server options: 
1. In the Server Configuration Settings section, use the drop-down list to select the fax server to 

be set up. 

2. Use the up and down arrows beside the options to change the number of days, minutes, or tries 
for that option.  

3. Close the window or click another tab to continue. 

Defining Modem Schedules 
As part of the server setup process, you must specify when each fax modem on each server will be active 
(on) for both sending and receiving faxes. The modem schedules are accessed by clicking the Maintain 
Modem Schedules button. 

To define outbound modem schedules on a fax server: 
1. In the Server Configuration Settings section, use the drop-down list to select the fax server to 

which the modem is connected. 

2. Click the Maintain Modem Schedules button to display the schedule screen for the selected 
server. A screen showing all currently active modems attached to the selected server will appear. 
The schedule for each day of the week for each modem on the server will be displayed. 

 
Note:  Modems will default to both Send and Recv settings with checkmarks before each option 
after the modem name. Note that each modem has one horizontal bar for Send settings and 
another bar for Recv settings. Inbound (Receive) settings cannot be customized. When a modem 
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is set to Recv, it is on for the entire day. If the outbound (Send) setting of a modem is turned off 
(deselected), any faxes that are currently queued will be sent before shutting down. 

3. Click the name of the modem to be set up. 

4. If you want the modem to be used to only send faxes or to only receive faxes, deselect the option 
you do not want active for the modem. 

5. Use the following methods to create, delete or merge time bars in the modem schedule: 

○ To create outbound (Send) schedules, double-click on any open area of the row. A new time 
bar will be created. You can adjust the new time bar by clicking and dragging it from either 
end. The default time block is 4 hours. 

○ To delete a schedule, right-click the time bar and select Delete.  

○ To merge two time periods in the schedule, click and drag the end of one bar into the other 
bar. The two time bars will merge into a single bar. 

After making your changes to a schedule, click the check box for Send for that modem. 

6. To retain the schedule changes for the selected modem, click Save and then confirm the change 
when prompted. 

OR 

To discard the schedule changes and revert to the previous settings, click Cancel. 

Setting FaxMan Administration Options 
An individual who does not otherwise have administrative authority in Solution Series can be given 
FaxMan Administrator permissions to manage all fax servers and perform other fax administrator 
functions. FaxMan Administrators can also designate other users through the Maintain Server 
Permissions option in the Server Configuration Settings section. FaxMan Administrators can perform 
all administrative functions on the FaxMan screen except specifying Allow others to see my faxes, 
which is a user-specific option, not an administration option. 

The values selected in the Admin Setup section apply to all faxes coordinated by FaxMan. 

 

To set global FaxMan options: 
In the Admin Setup section, use the drop-down lists to set the values for fax handling options to be 
applied to all faxes. See Fax Configuration Tab Options for a description of the available options. Also 
see the To create or update user fax lists procedure for using the List button to designate users for 
each option. To activate an option setting, click the check box to the right of the option. Click a check 
box to remove a checkmark to deactivate that setting. 
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Creating and Maintaining Fax Groups 
In most environments, more than one person will perform various tasks. For that reason, you will need to 
set up Fax Groups to manage faxes being sent to different areas. For example, you may have a Lab 
group, a particular provider’s medical staff group, or any other specialized area group. This group 
management is accessed through the Maintain Fax Groups button in the lower right section. 

 

To create a Fax Group: 
1. From the main FaxMan screen, click Maintain Fax Groups button. The Maintain Fax Groups 

screen appears. 

2. Click Add New to display a new name field below the two columns. 
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3. Type the name of the group to be added and click Add. (The group name can be up to 50 
characters in length.) The new group name will appear in the left section. If you typed the group 
name incorrectly or decide to not keep it after adding the group, click Cancel to remove it from 
the group list and remain on this screen. 

4. Click the new group name in the left section and a list of available facilities will appear in the right 
section. 

5. To associate the new group with one or more facility, check the box before the facility name(s). 

6. To save the new group(s) and facility settings, click Done.  

7. When prompted for confirmation, click OK to retain the new settings and close the window. 

To change a Fax Group name: 
1. From the main FaxMan screen, click the Maintain Fax Groups button. The Maintain Fax Groups 

screen appears. 

2. Click to select the group name in the left pane, then click Edit Title. 

3. When the group name appears in the field below the list of groups, type the new group name in 
the field over the old name. 

4. Click Edit to place the new group name in the group pane. 

5. To save the changes made, click Done.  

6. When prompted for confirmation, click OK to retain the new entry and close the window. 

To delete a Fax Group: 
1. From the main FaxMan screen, click Maintain Fax Groups button. The Maintain Fax Groups 

screen appears. 

2. Click to select the group name in the left pane; then click Delete. 

3. If no faxes are currently associated with the group, you will be prompted to verify the deletion. 
Click Yes to continue the deletion. 

4. If faxes are currently queued for the group, you will be prompted to designate a different group to 
associate with those faxes. The following screen appears: 
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a. Click to select the group in the Fax Groups pane to which the queued faxes should be 
reassigned. 

b. Click Delete Group to delete the group selected in the earlier step (not the group selected on 
this screen). The faxes will be reassigned to the group selected on this screen and the old 
group will be deleted. 

5. To save the changes made, click Done.  

6. When prompted for confirmation, click OK to retain the faxes now appearing in the new group 
and to delete the old group. 

Maintaining Fax Line Numbers 
In order to receive incoming faxes, you must first identify the phone numbers of the fax machines. This 
function is accessed through the Maintain Phone Numbers button in the lower-right section. 

 

To add a new phone number: 
1. From the main FaxMan screen, click Maintain Phone Numbers button. The Maintain FAX Line 

Numbers screen appears. 

 
2. Click Add New to display a text field below the Phone Numbers pane. 



 

e-MDs Solution Series Utilities Guide 8.0 R01 100 
 

3. Type the new phone number for the fax in the field and click Add. The new number appears in 
the Phone Numbers pane. 

 
4. To save the new phone number, click Done.  

5. When prompted for confirmation, click OK to retain the new entry and close the window. 

To edit existing phone numbers: 
6. From the main FaxMan screen, click Maintain Phone Numbers. The Maintain FAX Line 

Numbers screen appears. 

7. Click to select the phone number in the Phone Numbers pane, then click Edit Number. 

8. When the phone number appears in the field under the Phone Numbers pane, type the new 
phone number in the field over the old number. 

9. Click Add to place the new number in the pane. 

10. To save the changes made, click Done.  

11. When prompted for confirmation, click OK to retain the new entry and close the window. 

To delete a phone number: 
1. From the main FaxMan screen, click the Maintain Phone Numbers button. The Maintain FAX 

Line Numbers screen appears. 

2. Click to select the phone number in the left pane; then click Delete. 

3. You will be prompted to verify the deletion. Click Yes to continue the deletion. 

4. To delete the phone number, click Done.  

5. When prompted for confirmation, click OK to delete the number and close the window. 

Note:  Deleting a phone number will not delete the group with which it is associated.  
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Associating Phone Numbers with Groups 
After setting up groups and adding phone numbers for the fax machines, you must associate a fax phone 
number with the group who will be using it. A group can be associated with multiple fax phone numbers, 
but a fax phone number can be associated with only one group. 

To access this function, click the Maintain Fax Groups/Phone Numbers button in the lower-right 
section. 

 

To associate groups with fax numbers: 
1. From the main FaxMan screen, click Maintain Fax Groups/Phone Numbers. The Maintain Fax 

Phones to Groups screen appears. Each fax phone number defined earlier will appear in the Fax 
Phone Lines column. If a number has not already been associated with a group, the entry in the 
Fax Groups column for a phone number will indicate Unassigned Faxes. 

2. Click to select the phone number in the Phone Numbers pane. 

3. In the field to the right of the selected phone number, use the drop-down list to display available 
groups. 

 



 

e-MDs Solution Series Utilities Guide 8.0 R01 102 
 

4. Click to select the appropriate fax group name.  

Note:  If the fax phone number was previously associated with a different group, there may be 
faxes already queued. If that is the case, you will be prompted Move faxes to this number to 
new group? (where new group is the group being associated in this process). Your options are: 

○ Yes: The queued faxes will be moved to the newly associated group. 

○ No: While faxes received after this point will be moved to the new group, queued ones will 
remain with the original group. 

○ Cancel: The fax number will revert to the old group and the new number association will be 
cancelled. 

5. Click Save to retain the group-to-fax number association. 

6. When prompted for confirmation, click OK to retain the new association and close the window. 

Defining and Maintaining Fax Routing Rules 
The routing rules are the driver for handling incoming faxes to ensure they get to the right groups and 
individuals. These rules provide the connection between FaxMan and DocMan, using DocMan Categories 
to process faxes. To manage routing rules, click the Maintain Routing Rules button in the lower-right 
section. 
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To add a new routing rule: 
1. From the main FaxMan screen, click Maintain Routing Rules. The Maintain Routing Rules 

screen appears. 

 
Note that all the categories in your DocMan installation will appear in the Category List column. 
The Rule column will indicate if a rule is Active ( ) or Inactive ( ). 

2. Click to select a category that does not currently have a rule associated with it (no checkmark in 
the Rule column). 

Note:  You cannot select another rule until you complete and save the selection of organizations 
and users for the currently selected rule. Also, you can only apply an organization to one 
category/rule. 

3. In the Organization List column, click the boxes next to each organization whose faxes will be 
routed to the selected category. 

4. Click the boxes next to each person in the User List column who will be notified by TaskMan 
when a fax is received by any of the organizations selected in the previous step. 

5. Click Done to retain the settings and close the window. 

To modify an existing routing rule: 
1. From the main FaxMan screen, click Maintain Routing Rules. The Maintain Routing Rules 

screen appears. 

2. Click to select a category that has a rule currently associated (a checkmark in the Rule column). 

3. In the Organization List column, click the boxes next to each organization whose faxes will be 
routed to the selected category or deselect the boxes of any organizations that should no longer 
be associated with the selected rule. 

4. Click the box next to each person in the User List column who will be notified by TaskMan or 
deselect the box next to any previously selected user to stop that notification. 

5. Click Done to retain the settings and close the window. 
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Fax Configuration Tab Options 
Configuration Options  

Notify Rules for Current User Section 
Allow other users to see 
my faxes 

If users have been identified in the list (click List to view) and Active? is checked, 
the users in the list are allowed to view the individual user’s faxes. 

On failure notice (after 
retries) notify  

If users have been identified in the list and Active? is checked, the users in the list 
will receive any failure notice that occurs for individual user’s faxes. 

On fax delay of n hours, 
notify 

If users have been identified in the list and Active? is checked, the users in the list 
will be notified of delays beyond the number of hours selected in the option. 

Server Configuration Settings Section 
Selected Server This list contains the names of all fax servers that have been defined for this 

environment. The option settings in the Server Configuration Setting section will be 
set for the server whose name is selected and displayed in this field. 

Maintain Server 
Permissions 

A Fax Server Administrator must have specific permissions for a fax server to 
perform server administration tasks. This permission can be given by a FaxMan 
Administrator or a Solution Series Administrator through the Maintain Server 
Permissions option. 

Purge sent faxes after n 
days 

Defines the number of days an outbound fax should be accessible under the Sent 
Faxes tab before the archived fax image or note is purged and no longer available 
for viewing. The default value is 2 days. The minimum value can be 0 days and the 
maximum is 90 days. 

Purge received faxes after 
n days 

Defines the number of days an incoming fax should be accessible under the 
Received Faxes tab before the archived fax image or note is purged and no longer 
available for viewing. The default value is 2 days. The minimum value can be 1 day 
and the maximum is 90 days. 

Purge every n mins Defines the number of minutes FaxMan should check for faxes that have remained 
in the sent and received tabs for the time periods specified on the above two 
options. By default, FaxMan will check the sent and received faxes every 15 minutes 
to determine which faxes should be purged. The minimum value for this query is 1 
minute and the maximum is 30 minutes. 

Maximum retries When a fax cannot be sent for one reason or another, FaxMan will attempt to resend 
it. The value set in this option will determine how many attempts are made to send 
the fax. The default value is 5 attempts. The minimum number of retries is 0 and the 
maximum is 10 retries. 

Retry Delay n mins This value specifies how long FaxMan should wait between trying to send faxes that 
could not be sent. The default value is to wait 3 minutes between attempts. The 
minimum time is 1 minute and the maximum wait time is 10 minutes. 

Maintain Modem 
Schedules 

This button provides access to the Modem Schedule screen where schedules are 
defined for the selected server.  See Defining Modem Schedules for a description of 
that function. 

Admin Setup Section 
On failure notice (after 
retries) notify 

When a failure occurs, after retrying the action a predetermined number of times, a 
notice will be sent to the users in the list (accessed by the List button). 

On fax delay of n hours, 
notify 

If a fax is delayed beyond the number of hours designated in this option, the user(s) 
in the associated list will be notified of the delay. 

On outbound fax count of 
n notify 

When the number of faxes defined in this option are reached, the user(s) in the 
associated list will be notified that the referenced number of faxes have been sent. 

Check on delay and 
outbound count every n 
mins 

The number of minutes specified in this option determines how frequently the fax 
servers should be checked for delays and outbound fax counts. 
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Maintain Fax Groups/ 
Phone Numbers 

Use this button to display the screen to allow administrators to maintain the 
association of fax groups and phone numbers. See Associating Phone Numbers 
with Groups for a description of this function. 

Maintain Fax Groups Use this button to display the screen to set up and maintain fax groups. See 
Creating and Maintaining Fax Groups for a description of this function. 

Maintain Phone Numbers Use this button to display the screen to define and maintain fax phone numbers. 
See Maintaining Fax Line Numbers for a description of this function. 

Maintain Routing Rules Use this button to display the screen to manage the routing of faxes with DocMan 
categories. See Defining and Maintaining Fax Routing Rules for a description of this 
function. 

 

Viewing Received Faxes 
All faxes received can be viewed on the Received Faxes tab, much like an e-mail “Inbox” folder. From 
this screen you can preview received faxes to verify the contents, or delete faxes that should not be 
processed. 

 

To preview a received fax: 
On the Received Faxes tab, click the icon of the fax to be previewed. The image of the fax will 
display. 

To delete a received fax: 
On the Received Faxes tab, right-click the received fax entry to be deleted and select Delete. The 
fax job will appear on the Deleted Faxes tab. 

Received Faxes Tab Columns 
Received Faxes 
Columns 

 

The Row Filters at the top allow you to filter the received faxes by sender, date received, sending 
phone number, recipient phone number, and server. 
Sender This is the fax phone number that sent the fax. The column can be sorted 

alphabetically then numerically, or in reverse order with second click.   
Date Received  This column will list the date and time the fax was received. The column can be 

sorted chronologically. 
Sending Phone Number This column contains the fax phone number to which the fax was sent. The column 

can be sorted numerically. 
Recipient Phone Number This column contains the fax phone number from which the fax was sent. The 

column can be sorted numerically. 
Server This column identifies the virtual fax server associated with the fax job. If the virtual 

fax server identified has been deleted from Server Manager, the entry will appear in 
bold red font. See Managing Fax Servers for more information about virtual fax 
servers. 
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Image The icon in this column represents the fax image.  Click this icon to see a preview of 
the fax. Fax images will be archived and available for viewing until they are purged. 
See the Configuration tab for those settings. 

Viewing Sent Faxes 
The Sent Faxes tab provides access to all faxes successfully transmitted from your system.  

 

To preview a sent fax: 
On the Sent Faxes tab, click the icon of the fax to be previewed. The image of the fax will display. 

To delete a sent fax: 
On the Sent Faxes tab, right-click the sent fax entry to be deleted and select Delete. The fax job will 
appear on the Deleted Faxes tab. 

Sent Faxes Tab Columns 
Sent Faxes Columns  
The Row Filters at the top allow you to filter the sent faxes by sender, date sent, recipient phone 
number, and server. 
Priority Values in this option include Immediate, High, Normal and Low. The column can 

be sorted from highest to lowest or lowest to highest. 
Sender This is the user login of the person who submitted the job. The column can be 

sorted alphabetically then numerically, or in reverse order with second click. 
Date/Time Sent  This column will list the date and time the fax was sent. The column can be sorted 

chronologically. 
Destination Phone 
Number 

This column contains the fax phone number to which the fax was sent. The column 
can be sorted numerically. 

Title This is the title given to the fax job at the time of submission. The column can be 
sorted alphabetically. 

Server This column identifies the virtual fax server associated with the fax job. If the virtual 
fax server identified has been deleted from Server Manager, the entry will appear in 
bold red font. See Managing Fax Servers for more information about virtual fax 
servers. 

Additional Notes Any notes that were included in the fax job are shown in this column. Fax notes will 
be archived and available for viewing until they are purged. See the Configuration 
tab for those settings. 

Image The icon in this column represents the fax image.  Click this icon to see a preview of 
the fax. Fax images will be archived and available for viewing until they are purged. 
See the Configuration tab for those settings. 
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Working with Pending Faxes 
The Pending Faxes tab will list all outgoing faxes that are awaiting the next scheduled fax transmission 
for the selected fax server. This might also include faxes that are retrying the transmission or that have 
failed transmission for some reason. 

 
You can perform some fax management tasks with pending faxes if the selected fax is not currently 
processing. If you attempt any of the following procedures for an active fax job, you will see a dialog box 
indicating that no options are available because the job is currently processing. 

To resend a fax with processing changes: 
1. On the Pending Faxes tab, right-click anywhere in the entry of the fax to be changed.  

2. When the right-click menu appears, select Edit/Resend. 

3. On Edit/Resend Fax, type in either field to change the phone number or the priority of the job.  

 
4. Click Resend.  The fax job will be updated and the retry count will be reset for that job. 
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Pending Faxes Tab Columns 
Sent Faxes Columns  
The Row Filters at the top allow you to filter the pending faxes by sender, date sent, recipient phone 
number, priority, title, server, and status. 
Priority Values in this option include Immediate, High, Normal and Low. The column can 

be sorted from highest to lowest or lowest to highest. 
Sender This is the user login of the person who submitted the job. The column can be 

sorted alphabetically then numerically, or in reverse order with a second click. 
Date/Time Sent  This column will list the date and time the fax was sent. The column can be sorted 

chronologically. 
Destination Phone 
Number 

This column contains the fax phone number to which the fax was sent. The column 
can be sorted numerically. 

Title This is the title given to the fax job at the time of submission. The column can be 
sorted alphabetically. 

Server This column identifies the virtual fax server associated with the fax job. If the virtual 
fax server identified has been deleted from Server Manager, the entry will appear in 
bold red font. See Managing Fax Servers for more information about virtual fax 
servers. 

Status The Status column is color coded for quick identification. Red means the fax job 
has failed, Yellow means the job is currently retrying to send, and no color indicates 
the fax job is waiting for processing for the first time. 

Retry Count When a fax job is retrying to send, the number in this column indicates what the 
number of the next retry will be. For example, if the job transmission has been 
attempted 3 times, this column will indicate 4 as the next retry attempt number. This 
column is sortable for the number of retries attempted.  

Additional Notes Any notes that were included in the fax job are shown in this column. Fax notes will 
be archived and available for viewing until they are purged. See the Configuration 
tab for those settings. 

Image The icon in this column represents the fax image.  Click this icon to see a preview of 
the fax. Fax images will be archived and available for viewing until they are purged. 
See the Configuration tab for those settings. 

 

Viewing Deleted Faxes 
The Deleted Faxes tab allows you to view information about faxes that have been deleted manually by a 
user or automatically according to FaxMan purge settings. From this tab you can restore a deleted fax 
and process it, or you can reassign a fax transmission to a different virtual fax server for processing. 

 

To restore or resend a deleted fax: 
1. On the Deleted Faxes tab, right-click the line item to be restored or resent and select Restore 

Deleted Fax. 

2. Click Yes to restore the fax. 
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Deleted Faxes Tab Columns 
Deleted Faxes Columns  
The Row Filters at the top allow you to filter the deleted faxes by priority, sender, date sent, destination phone 
number, fax title, and server. 
Priority  Values in this option include Immediate, High, Normal, and Low. The column can be 

sorted from highest to lowest or lowest to highest. 
Sender If the deleted fax was an outgoing (sent) item, this will be the user login of the 

person who submitted the job. If the deleted fax was inbound (received) item, this 
will be the fax phone number that sent the fax. The column can be sorted 
alphabetically then numerically, or in reverse order with second click. 

Date/Time Sent This column will list the date and time the fax was sent or received. The column can 
be sorted chronologically. 

Phone This column contains the fax phone number to which the fax was sent. The column 
can be sorted numerically. 

Title This is the title given to the fax job at the time of submission. The column can be 
sorted alphabetically. 

Server This column identifies the virtual fax server associated with the fax job. If the virtual 
fax server identified has been deleted from Server Manager, the entry will appear in 
red bold font. See Managing Fax Servers for more information about virtual fax 
servers. 

 

Managing Fax Servers 
FaxMan uses virtual servers to manage fax servers with the least amount of user down time or time-
consuming physical interactions. A virtual server that is associated with one fax server can easily be 
reassigned to a different fax server, if necessary.  This reassignment can be performed by a Fax Server 
Administrator, a FaxMan Administrator, or a Solution Series Administrator.  

You can have multiple “virtual” fax servers assigned to each “physical” fax server and move those virtual 
servers to different physical servers as needed.  

For example, Fax Server 1 may be associated with Virtual Server A, Virtual Server C, and Virtual Server 
E, while Fax Server 2 is associated with Virtual Server B, Virtual Server D, and Virtual Server F.   

 

 

 

 



 

e-MDs Solution Series Utilities Guide 8.0 R01 110 
 

If Fax Server 1 has to be taken down for service, an administrator can easily reassign Virtual Servers A, C 
and E to process their fax jobs on Fax Server 2.  All fax groups, priorities, and other fax job settings are 
retained – just moved to a different physical fax server. 

 
After Fax Server 1 becomes available again, the administrator can again reassign Virtual Servers A, C 
and D back to that device. 

Both physical fax servers and virtual fax servers are managed on the FaxMan 2.0 Server Manager tab. 
Click the Server Manager tab to access this screen. 
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The color coding in the Virtual Servers pane is as follows: 

• Green: The virtual server is assigned to the fax server that is currently selected in the left pane. 

• Red: The virtual server is assigned to one of the fax servers not currently selected in the left pane. 

• White: The virtual server is not currently assigned to any fax server. 

Virtual server maintenance is very similar to phone number maintenance.  You can create a new virtual 
server, edit a virtual server’s information, delete a virtual server, associate a fax server with a virtual 
server, and reassign virtual servers to different fax servers. 

To create a new virtual server: 
1. From the Server Manager screen, click Maintain Virtual Servers to display the Maintain Virtual 

Servers screen. 

 
2. Click the Add New button to display the free text field and buttons under the server list pane. 

3. Type the new virtual server name in the field and click Add. The new virtual server name appears 
in the Virtual Servers pane. 

 
4. To save the new virtual server, click Done.  

5. When prompted for confirmation, click OK to retain the new entry and close the window. 

To edit a virtual server: 
1. From the Server Manager screen, click Maintain Virtual Servers to display the Maintain Virtual 

Servers screen. 

2. Click to select the virtual server in the Virtual Servers pane; then click Edit Name. 
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3. When the server name appears in the field under the Virtual Servers pane, type the new virtual 
server name in the field over the old name. 

4. Click Add to place the new name in the pane. 

5. To save the changes made, click Done.  

6. When prompted for confirmation, click OK to retain the new entry and close the window. 

To delete a virtual server: 
1. From the Server Manager screen, click Maintain Virtual Servers to display the Maintain Virtual 

Servers screen. 

2. Click to select the appropriate virtual server in the left pane; then click Delete. 

3. When prompted to verify the deletion, click Yes to continue the deletion. 

 
4. If there are pending faxes on this Virtual Server, click Yes to confirm redirecting the faxes. 

 
5. On the Change Virtual Server window, select an active Virtual Server from the list and click OK. 

   
6. To delete the virtual server, click Done.  

7. When prompted for confirmation, click OK to delete the virtual server and close the window. 
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Important!  When a virtual server is deleted, it will be a “soft” delete and any current faxes in 
the queue will still be associated with that server. To run those fax jobs, use the procedures in 
Working with Pending Faxes to reassign the virtual server to another fax server. You must, of 
course, have the proper administrative access to the servers in question to reassign the faxes. 

To associate a fax server with an unassigned virtual server: 
1. From the Server Manager tab, click to select the fax server in the left pane. 

2. Click the box next to each virtual server in the right pane that should be associated with the 
selected fax server. 

After the selection is complete, the selected virtual server row(s) in the right pane will change to 
green to indicate the virtual servers are associated with the selected fax servers. 

To associate a fax server that already has an assigned virtual server: 
1. From the Server Manager tab, click to select the fax server in the left pane. 

2. Click the box next to the appropriate virtual server(s) in the right pane. Note that the virtual server 
row(s) will be red with an empty check box because they are currently assigned to a different fax 
server. 

3. When a message pops up indicating that you are about to remove the selected virtual server from 
another fax server and asking if you want to continue, click Yes to complete the action. 

OR 

Click No to retain the original setting and cancel the assignment to the new fax server. 

To reassign all virtual servers from one fax server to another: 
1. From the Server Manager tab, click to select the fax server in the left pane. 

2. While still holding down the left mouse button, drag the pointer to the fax server to which you are 
reassigning the associated virtual servers.  

3. When a message pops up indicating that you are about to transfer all the associated virtual 
servers to the selected fax server, and asking if you want to continue, click Yes to complete the 
action. 

OR 

Click No to retain the original setting and cancel the assignment to the new fax server. 

To remove virtual server assignments: 
1. From the Server Manager tab, click to select the fax server in the left pane. Any associated 

virtual servers will appear in green rows in the right pane with check marks in their boxes. 

2. Click the checked box(es) next to the appropriate virtual server(s) in the right pane. Note that the 
virtual server row(s) will no longer be highlighted and the check box will be empty because they 
are no longer associated with any fax server. 

To delete a fax server: 
1. From the Server Manager tab, click to select the fax server to be deleted in the left pane. 

2. Click the Delete Selected Server button below the left pane. If the selected fax server has virtual 
servers associated with it, a message will pop up indicating that continuing the deletion will result 
in virtual servers assigned to the selected server becoming unassigned. 

3. Click Yes to complete the action. The selected fax server will be removed from any virtual server 
associations as well as the list of servers available on the FaxMan Configuration tab. 
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OR 

Click No to retain the fax server and cancel the deletion. 

Server Manager Tab Columns 
Fax Server Columns 
and Buttons 

 

Server Name This is the physical fax server that is a machine that is connected to your network. 
State This column indicates if a fax server is currently Active, Inactive, or Unknown.  
Last Pulse This date and time will reflect the last interaction with the server. 
Virtual Servers This is the name of the virtual servers that were created to manage fax jobs.  The 

color background in this pane is as follows: 

• Green: The virtual server is assigned to the fax server that is currently 
selected in the left pane. 

• Red: The virtual server is assigned to one of the fax servers not 
currently selected in the left pane. 

• White: The virtual server is not currently assigned to any fax server. 

This color key is displayed at the lower-right corner of the tab as a reminder.

Delete Selected Server Select a fax server in the left pane and click this button to delete the selected server. 
Maintain Virtual Server Click this button to open the Maintain Virtual Servers screen. 

 

Using DocMan to Reorganize Misplaced Faxes 
If a fax is inadvertently assigned to the wrong fax group, anyone on the receiving fax group can reassign 
the fax to the proper group (assuming the user has access to the receiving group). In most cases, this 
should be done by an administrator. See Reassigning Misplaced Faxes in DocMan for the procedure 
steps. 

Setting Up a TIFF Printer as a Virtual Fax Machine 
When Solution Series is installed on your system, a TIFF Printer is added automatically.  This is a "virtual" 
printer that can be used as a fax machine for sending faxes through your computer network rather than a 
physical machine.  To ensure this will work properly with the Solution Series fax features, perform the 
following setup steps on each computer where it will be used. 

 To set up a TIFF printer: 
1. Go to Start > Printers and Faxes. 

2. Right-click TIFF Printer and select Properties. 

3. Click the TIFF Options tab. 
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4. Click to select Save original name and Add JobID in the File Name section. 

5. In the Compression section, select LZW, set the Quality (Jpeg) to 100, and select Multi Page.  

6. In the Color section, select Monochrome. 

7. In the Output folder section, click Browse to locate and select your fax printer. 

8. Click Apply; then OK to save your settings and close the window. 

9. Open Solution Series and select the Fax Monitor module. 

 
10. If the following window appears, click OK to continue. 
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11. If the above window does not appear, go to Tools > Options. 

 
12. When the e-MDs Fax Monitor Options window opens, browse to and select the Fax Printer 

Folder value. 

13. Click the drop-down list button next to the Fax Server field and select the fax server to be used.   

Note:  The values selected in this window should be the same as the fax printer selected on the 
TIFF Options tab of the TIFF Printer Properties window earlier.  If these values do not match, the 
TIFF printer will not be recognized as the fax machine in the Fax Monitor module. 

14. Click OK to save your settings and close the e-MDs Fax Monitor Options window. 

To use the TIFF Printer for faxing: 
1. From the open file to be faxed, or with that file selected in a Solution Series module, select Print. 

2. Select the TIFF Printer and click OK.  The selected file will be read into the Fax Monitor which 
will determine the type of file being received. 

3. Open the Fax Monitor module and click Refresh below the Fax List section.   

 
4. Select your file from the list and the file's contents should display in the left section of the window. 
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5. Enter the appropriate text in the fields of the Fax Information section.  Some of these fields may 
already be filled in depending on the source of the file you are faxing. 

 
6. Click Add Recipient to open the Select Fax Recipient window. 

7. Enter the information about the recipient, including name and fax number. 

8. Click Done to save the recipient information and return to the Fax Monitor screen.   

9. When all information is complete, click Submit to fax the file using the TIFF Printer as the fax 
selected during setup. 
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5 
Snapshot (Digicam) 

In each individual patient’s chart, there is a placeholder for a headshot photograph 
near the upper left corner (just to the left of the blue patient identifier bar). (These 
photos also appear in the lower right corner of Tracking Board and the lower left 
corner of e-MDs Schedule.) If no photo exists, the placeholder in e-MDs Chart will 
appear as a white square labeled “Image N/A." 

The placeholder can hold a series of photographs, and will always display the most 
recent. To view other images, just double-click on the displayed image. 

The only way to replace the placeholder with a photograph is to the use e-MDs 
Snapshot. Snapshot captures photo images as computer code. Therefore, users 
cannot import .jpeg, .gif, or .tif file images into e-MDs Chart or export the e-MDs 
Snapshot photos to other applications. 

Continued on the next page ... 
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Setting Up Snapshot 
It is recommended that a single workstation be set up to handle photographs. It should be located in an 
area with good lighting and some privacy for the patient’s comfort. It is helpful if the camera can be 
mounted in a fixed position that will be appropriate regardless of height. A conveniently placed chair can 
help to limit guesswork for height adjustment. Or, mount the camera in such a way that it can be adjusted 
easily. 

To set up Snapshot: 
1. Prior to using e-MDs Snapshot, install all necessary hardware components for your digital 

camera, such as updated drivers. 

Note:  Webcams to be used with Digicam require a TWAIN driver which must be compatible with 
the workstation operating system. Some of the newer cameras may not include TWAIN drivers, 
but a generic TWAIN driver may be available, which you can place in the C:\Windows|twain_32 
folder on the computer where the camera software will be installed. See e-MDs Hardware and 
Software Recommendations for more details. 

2. To create a shortcut to e-MDs Snapshot on your desktop, open Window Explorer and go to 
Program Files\e-MDs\Solution Series\Apps. Locate the file called digicam.exe and create a 
shortcut. (Since the executable file is called digicam, the shortcut is also digicam.) Drag the 
shortcut to your desktop. DO NOT copy the executable or drag it to your desktop as program files 
that are generated will then be stored on the desktop. 

3. e-MDs Snapshot was developed with SKYLINE programming tools for imaging. These 
development tools require specific settings for the computer's monitor resolution. To set the 
monitor resolution: 

a. Go to Start > Settings > Control Panel > Display.  

b. In the Display Properties window, click the Settings tab.  

c. Under Colors, select 32Bit True Color. If the maximum setting available is 24Bit True 
Color, select it.  

d. Verify that the Screen Area Setting is at 1024 x 768 pixels. 

e. Click the Advanced button.  

f. Under the General tab, set the Font Size to Small Fonts (or Normal Font, 96 dpi). 

g. Click Apply to enable these settings. Some operating systems require a reboot to 
process these changes to the display resolution. 

4. Click the digicam shortcut on the desktop to open Snapshot.  

5. Enter a login and password (the same login and password used in e-MDs Chart).  

The e-MDs Snapshot window with a toolbar will open on the desktop. 

 
6. Click the Select button to display a window in which you can select the camera driver. 
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7.  Highlight the correct driver and then click Select. 

 

Note:  When you are finished taking pictures with e-MDs Snapshot, and a scanner or other 
hardware that requires a Twain driver is also installed on this computer, be sure to select that 
driver prior to using the other hardware. 

8. Click the Options button.  In earlier Digicam versions, the user had to position their camera on its 
side to capture the photo in a portrait view.  With 6.0 and later, e-MDs Snapshot defaults to the 
standard portrait view. 

Note:  If you are currently using Solution Series 5.3x or an older version, you can either set the 
rotation to Left or Right depending on how your camera was mounted.  Or you can re-position 
your camera upright with No Rotation as your preference. 
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9. Select the preferred Capture Method. The Software provided by the camera manufacturer 

option loads the image into the manufacturer’s editing tool prior to loading it into e-MDs Snapshot.  
This allows you to make edits through the camera’s software if desired. 

Note:  If you select Read directly from camera memory, the photo is loaded directly into 
Snapshot. 

 
10. The Select button is also available here to allow you to set the correct TWAIN driver. 

 

 
To ensure that everything is working as expected, you can test the photo capture process prior to 
loading your first patient photo. 

11. If you have selected the Software provided by the camera manufacturer: 

a. Click the Test button. This will launch the manufacturer’s tool.   

b. If the photo appears as expected, click OK to capture the picture.  This will display the photo 
in a Test Picture Window.  

c. Click OK to close the Test Picture window. 



 

e-MDs Solution Series Utilities Guide 8.0 R01 122 
 

 

Note:  If you cancel the photo capture process within the Manufacturer’s tool, you may get the 
following error: 

 
This error is related to a conflict between the Manufacturer’s capture tool and e-MDs Snapshot, 
but generally does not cause any problems or issues.  If it happens during the test, click OK to 
close this error message. 

Note:  If you see this error message when attempting to capture a photo, review the installation 
process of your camera and its driver. 

12. If you have selected Read directly from camera memory option, the photo is displayed in the 
Test Picture only.  Use this option if you will be editing the picture with Snapshot utility.  Click OK 
to close the Test Picture window. 

To record a photograph in e-MDs Snapshot: 
1. Click the Snapshot (DigiCam) shortcut on the desktop to launch the camera utility.  

2. Enter a login and password (the same login and password used in e-MDs Chart). The e-MDs 
Snapshot window with a toolbar will open on the desktop. 

3. On the Select Source screen, click the Select button to locate the Camera Driver.  

4. Highlight the correct driver and then click Select. 

Note:  When you are finished taking pictures with e-MDs Snapshot, and a scanner or other 
hardware that requires a Twain driver is also installed on this computer, be sure to select that 
driver prior to using the other hardware. 

5. If you have not set your preferences under Options as explained in the setup instructions, do so 
now. 

6. Click Patient to search for the patient whose photograph is being taken.  

7. Highlight the correct name from the search results, and click the Select button. This will close the 
Find Patient window and return you to the e-MDs Snapshot toolbar. 
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The Take (camera icon) button is now active.  Also notice that the patient name is now displayed 
below the toolbar. 

 
8. Place the patient in the correct position before the camera and click the Take button. Snapshot 

captures the photo in a default Portrait setting. 

9. If you selected Software provided by the camera manufacturer, this will launch the 
manufacturer’s tool.  Perform any necessary edits or cropping and click the option to capture the 
picture. 

Note:  If you cancel the photo capture process within the Manufacturer’s tool, you may get the 
following error: 

 
This error is related to a conflict between the Manufacturer’s capture tool and e-MDs Snapshot, 
but generally does not cause any problems or issues.  If it happens while testing, click OK to 
close this error message.  If, however, you see this error message when attempting to capture a 
photo, review the installation process of your camera and its driver. 

The captured picture is now displayed below the toolbar with a box overlaid. 

10. If you have selected Read directly from camera memory, the photo is displayed below the 
toolbar with a box overlay. 

11. Place the mouse cursor anywhere within the box area.  Do not click the box or image.  You 
should see a picture with a double-arrow cursor, as shown below: 

 

Note:  If you do not see a double arrow, click any area OUTSIDE the box overlay and then place 
the mouse cursor within the box overlay.  You should now see the double-arrow icon. 
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12. Move the mouse to the left or right.  When you are satisfied with the position, click the image.  
This moves the picture to the left side of the window.  If a mistake was made or the position 
needs to be modified, simply click the Undo button and the box overlay re-appears. 

 
13. If the picture does not come out as desired, keep pointing the camera and clicking the Take 

button until an acceptable image is obtained. 

You can use the Crop feature to resize the photo. 

14. Click the Crop button and then place the cursor on the image. While holding down the Left 
mouse button, drag the cursor until the desired image is captured within the rectangular cropping 
outline. If a mistake is made in cropping, click the Undo button to return to the previous image 
and try again. 

 
15. Click Save to assign this photo image to the patient. This will return then display the Snapshot 

tool bar in a small window with the patient’s name listed with (saved) text. 

Note:  The Take button is still active and another photo can be taken at this time.  However, 
photos taken at this time will be in addition to the original photo, not a replacement for it. 
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The image should now be visible in the upper-left corner of the patient’s chart. 

 

16. If more than one image exists, view all images by double-clicking the displayed photograph.  

17. Click the arrows to expand or shrink the size/position of the images. Position the cursor over any 
individual image to display the date that the photograph was taken. 

 

Using FAQs and Troubleshooting Tips 
e-MDs Snapshot captures these photo images as computer 
code. Therefore, .jpeg, .jpg, .gif, or .tiff file images cannot be 
imported into this area of e-MDs Chart, nor can these photos be 
exported to other applications. 

Currently there is not a way to delete pictures that have been 
taken through e-MDs Snapshot.  If you mistakenly took the 
wrong patient’s picture or would like to remove a picture for 
whatever reason, contact e-MDs support team. 

If the photo displays correct in the e-MDs Snapshot viewer but 
displays as multi-color, neon-like image in Chart (Schedule or 
Tracking Board) review your display settings.  Your monitor may 
be set to 16-bit color. 
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6 
Forms/Letter Builder 

The custom Forms/Letter Builder lets users create forms and letters that are 
commonly used in the practice.  These documents are created using fields from the 
database and work like mail-merge form letters, allowing information from the 
database to automatically populate the document.  These forms and letters are 
created and generated using Microsoft Word 2000 or higher (previous versions may 
work but have not been tested).  Word is an industry standard word processing tool 
with extremely advanced editing capabilities that allow users to create professional 
looking standardized documents. 

Forms/Letter Builder permits mail-merging of different data elements from the e-MDs 
database.  This means that they can be used for: 

• Referral Authorization Forms 

• Letters to patients, other physicians, insurances, etc. 

• Labels 

• Other reporting forms 

A particularly powerful capability of the Forms is that they can be saved to predefined 
folders in DocMan (if the clinic has purchased this module).  They can also be linked 
to tasks to be performed in e-MDs Schedule’s Check-In module.  This gives clinics 
the ability to, for example, capture digital signatures for patient waivers and then be 
able to find them easily by looking up the documents in the patient’s DocMan file.  It 
also means that the time and cost of printing and then rescanning forms can be 
reduced significantly. 

Continued on the next page ... 
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Setting Security Access for Word 
Forms can only be created and used on computers with Microsoft Word 2000 or higher.  In addition, the 
workstation must also have security access to Visual Basic Projects.  The procedures for setting security 
access in the two most frequently used versions of Microsoft Word – 2003 and 2007 – are provided 
below.  If you are using an earlier or later version of Microsoft Word, please see Word documentation or 
the Microsoft website for those procedures. 

To configure security in Microsoft Word 2003: 
1. Open Word 2003. 

2. Go to Tools > Macro > Security. 

3. Click the Trusted Sources tab. 

4. Check the Trust Access to Visual Basic Project check box. 

5. Click OK to save your changes. 

To configure security in Microsoft Word 2007: 
1. Open Word 2007. 

2. On the Developer tab, click the Macro Settings button. 

3. In the Developer Macro Settings section, click the check box for Trust access to the VBA 
project object model.  

4. Click OK to save your changes. 

Adding Forms to the System 
To create a new form: 
1. Click Reports on the main Chart menu, select Forms/Letter; then Edit. 

2. In the Select Form/Letter window, click New. 

3. Give the form a description.  It is a good idea to include the pertinent application or function of the 
form as part of the description.  For example: “Refl: Blue Cross” or “Lab: UA Results”. 

4. Select the DocMan category to which this form will be saved by clicking the button with the 
magnifying glass in the DocMan Category field.  A list of categories grouped by specialty will 
open.   

If necessary, open the tree by clicking the + sign to the left of the Specialty category; then select 
an appropriate folder and click Select.  If a folder is used by multiple specialties, it is only 
necessary to pick it under one specialty. 

5. Back in the Forms/Letter Maintenance window, click the Edit Document Definition button to 
open Word and lock the Chart application (it will unlock after the form is closed). 

6. Create the form or letter.  Any function of Word can be used including graphics, watermarks, 
tables, formatting of fonts such as color, bold, size, etc. 

7. To insert merge fields, click the e-MDs menu item on the main menu (or in Word 2007, first click 
the Add-Ins tab then select e-MDs) then select Field Definitions from the menu bar.   

Depending on the boxes checked (such as Visit), different merge fields are made available.  
Click to highlight fields and then click the Select button to drop the fields into the document.  This 
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inserts the fields at the current cursor position in the document.  Multiple fields can be selected at 
once by using Shift+Arrow keys, or holding down Ctrl and selecting multiple fields.   

8. Click Done when all fields have been selected. 

9. In Word, click File and select Save to retain the document contents. 

10. Click File again; then select Exit to return to Chart. 

11. Back in the Form/Letter Maintenance window, click Save; then click Exit in the Select Form/Letter 
window. 

Note:  Some of the fields inserted into a document have descriptions that may be longer than the 
areas designated for the text.  To avoid this overlap, use tables.  The table row heights and 
column widths can be fixed, and the lines edited to be transparent. 

Copying forms and editing them, or copying forms from other sources, speeds up the forms creation 
process. 

To copy and edit an existing form: 
1. Click Reports on the main Chart menu then Forms/Letter then Edit. 

2. In the Select Form/Letter window search for and highlight the form to be copied. 

3. Click Copy. 

4. Enter a description. 

5. If necessary, change the DocMan category. 

6. Click Edit Document Definition and make the necessary changes to the form. 

7. Click File on the main Word menu click Save to save the document. 

8. Click File then Exit to return to Chart. 

9. Click Save in the Document Definition window. 

Importing and Exporting Forms/Letters 
Forms can also be imported and exported.  This makes it easy to share forms with other users in the e-
MDs user community.  Users can download forms that are in a commonly used format or e-mail them 
between sites. 

Note:  e-MDs strongly supports the sharing of resources between Solution Series users.  To find out how 
you can do that, see the Knowledgebase article entitled "How do I share my templates, Crystal Reports, or 
Word Forms with other e-MDs users?" in the e-MDs Support Center at https://supportcenter.e-mds.com. 

To export a form: 
1. Click Reports on the main Chart menu then Forms/Letter then Edit. 

2. In the Select Form/Letter window search for and highlight the form to be exported. 

3. Click Export. 

4. Browse for a directory and give the file a name. 

5. Click Save.  The form is saved with the .doc extension in the directory specified.  It can now be 
attached to an e-mail to send to other users, or attached to a post to upload to the e-MDs.forms 
newsgroup where other users will be able to download the form for their use. 

https://supportcenter.e-mds.com/�
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To import a form: 
1. Click Reports on the main Chart menu then Forms/Letter then Edit. 

2. In the Select Form/Letter window, click Import. 

3. Browse for the file that will be imported (it will have a .doc extension) select it and then click 
Open. 

4. Give the form a description. 

5. Link the form to a DocMan category. 

6. If necessary, click Edit Document Definition to make changes to the form. 

7. Click Save. 

Generating and Printing Forms/Letters 
Forms and Letters created using the Forms/Letter Builder can be merged with information from the 
database to create auto-populated documents.  Once the document has been generated it can be printed 
although it does not have to be.  The document can also be saved to the DocMan category to which it is 
linked. 

To generate a form or letter outside a patient chart: 
1. Go to Chart > Reports > Forms/Letter > Print. 

2. In the Select Form/Letter window, search for and highlight the form to be used and click Select. 

3. In the Word Wizard window, select a patient by clicking the Browse button then searching for the 
correct patient. 

Note:  Depending on the type of information in the Form/Letter, the user may be prompted to 
pick other specific information by clicking the Next button (ex. Visit, Invoice, etc.) 

4. Once the patient (or other information) is selected the Done button will become enabled. 

5. Click the Done button to open Word and merge the information with the Form/Letter. 

6. Fill out any information that was not auto-populated or make any changes to the document as 
needed. 

7. OPTIONAL: Click the Print button if it is necessary to print the document. 

8. When finished, click File on the main Word menu and select Exit OR click the x in the top right 
corner of the Word window to close the program and return to Chart. 

9. The Send Document to DocMan window will open and a document description can be entered. 

10. Click Save to save the document into the linked DocMan category  

OR 

Click Cancel to avoid saving the document into DocMan. 

To generate a form or letter within a patient chart: 
1. From within an open patient chart, click the Print Patient Reports button and select Print 

Form/Letter from the pop-up menu. 

2. In the Select Form/Letter window, search for and highlight the form to be used and click Select. 

3. In the Word Wizard window the patient’s name will automatically be filled in. 
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Note:  Depending on the type of information in the Form/Letter, the user may be prompted to 
pick other specific information by clicking the Next button (ex. Visit, Invoice, etc.). 

4. Once the patient (or other information) is selected the Done button will become enabled. 

5. Click the Done button to open Word and merge the information with the Form/Letter. 

6. Fill out any information that was not auto-populated or make any changes to the document as 
needed. 

7. OPTIONAL: Click the Print button if it is necessary to print the document. 

8. When finished, click File on the main Word menu and select Exit OR click the x in the top right 
corner of the Word window to close the program and return to Chart. 

9. The Send Document to DocMan window will open and a document description can be entered. 

10. Click Save to save the document into the linked DocMan category. 

OR 

Click Cancel to avoid saving the document into DocMan. 

Examples of Forms/Letters 
Forms created using the Forms/Letter Builder are very flexible and have many uses.  The following are 
some examples: 

• Claim Appeals:  Create appeals letters with data from the progress note and/or claim. 

• Referral Letter:  Send letters to referring physicians (doubles the functionality of the Registry 
Processor in Bill, or the Letter Editor in Chart). 

• Insurance Authorization Forms:  Many insurance companies have their own authorization 
forms.  Forms can be created that save time by auto-populating a lot of this information 
automatically. 

• Lab/Radiology Orders:  Many specialty groups issue forms that they want filled out by the 
doctors sending patients to them.  Forms can be created that auto populate many of these fields. 

• In House Lab Results:  Create a form for some of the labs the clinic does in-house such as 
urinalysis.  The form can be created with drop down boxes prepopulated with various values and 
can be saved into a Lab folder in DocMan. 

• Patient Intake Form:  Print patient demographics forms that shows most of the patient data but 
leaves space for additions or corrections.  This can be printed directly from the Check-In module 
in Schedule. 

• Patient Agreement:  Most practices make patients sign a form that requires them to pay for 
services in the event that insurance does not cover the service.  This can be done in a paperless 
manner, and saved directly to the patient’s DocMan folder.  This also can be printed from Check-
In module in Schedule. 

• Appointment Reminder Cards:  Create a form for patients to remind them about their next 
appointment. 

• ABN Notice:  Create a Medicare ABN notice by inserting merge fields for patient name and 
policy number.  Create text boxes for other parts of the form (or use the Word Form Builder tools 
to create list boxes).  If a patient needs to sign an ABN for a procedure, it can be opened directly 
from Chart, printed for patient signature (or signed on screen where legally allowable) and 
immediately saved into the patient DocMan folder. 
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7 
Registry Processor 

The Registry Processor is a very useful tool for searching for clinical and 
demographics information in the Solution Series database.  With the Registry 
Processor, you can generate, print and transmit problem lists, medication lists, 
medication allergy lists, demographics information, lab test results, and much more.  
Using the predefined patient communication preferences, you can use e-mail and 
Portal messaging to let patients know when they are due for preventative care. 

This interface uses Clinical Rules to track patient preventative care information and 
then triggers the communication portion in the Registry Processor.  This section 
provides detailed instructions on how to use the Registry Processor to search for 
patient information in the database and how to print or transmit this information using 
different communication methods. 

Continued on the next page ...  
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Getting Started with the Registry Processor  
You can access the Registry Processor through the Chart or Bill top menu by going to Reports > 
Registry Processor.  With this tool you can run and display existing reports, create new reports, modify 
or delete reports, and copy existing reports to create new reports meeting similar but different 
requirements.  The search functionality allows you to generate problem lists, medication lists, medication 
allergy lists, demographics information, and lab test results based on selected parameters.  This 
information gathering is useful for capturing statistics and communicating clinical and billing information to 
the patients on those lists.  

 
After accessing the Registry Processor main screen, the next screen that appears depends on the task 
you are performing.  If you are going to create a new report from scratch, you can simply click the New 
button at the top.  On the other hand, if you are looking for a specific report, you may need to search for 
the report and then, after selecting it from the search results screen, click the appropriate button (Edit, 
Run, Copy or Delete) to move to the next screen.  The procedures provided later in this section will lead 
you through each of those tasks step by step. 

Using the Results of the Registry Processor 
After you have created, run and reviewed the information in the Registry Processor reports, you can use 
the results in many different ways, including: 

• Export patient lists to Crystal Reports for viewing and printing. 

• Print labels for use in patient mailings.  

• Print letters for use in patient mailings and reminders where Mail has been specified as the 
patient's preferred reminder method. 

• Select a patient from a displayed patient list and open the patient's chart. 

• Send eReminders and notifications to the patient list using the reminder method selected by the 
patient. 

The specific method used for sending all reminders and demographic information will depend on the 
reminder method selected by the patient at the time the account was set up. 
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Creating Reports and Using Existing Reports 
When queries and reports are used on a regular basis, most organizations will create, save and reuse 
reports that gather the required information.  The Registry Processor provides a method of saving and 
reusing reports.  If you already have reports available in Registry Processor, use the following procedure 
to locate, open and use those reports.  Or, if you need to create new reports, use the other procedures to 
create a new report from scratch or copy an existing report and modify it to create a new report. 

To locate and run available reports: 
1. On the main Registry Processor screen, type all or part of the name of the report in the Report 

Name field, if you know it. 

OR 

If you do not know the report name, type one or more keywords in the Report Description field. 

Note:  If you do not enter a search string in either field, all available reports will be listed in the 
search results.  You can also enter values in both fields to further define the search criteria as 
needed. 

2. Click Search to find existing reports that match the selection criteria. 

3. If the report you want is listed, click the check box to select the report and click the Run button at 
the top of the screen.  The report will run and the resulting patient list will display. 

4. To sort the resulting report by any column in the listing, click the column heading.  To sort the 
report in the opposite order, click the same column heading again. 

To create a new report: 
1. Click New to begin the report and open the Report Properties window. 

2. On the Report Properties screen, type the name to be used for your report in the Report Name 
field. 

3. Type a meaningful description of the report in the Report Description field.   

4. By default, all options in the Report Parameters list will already be selected.  Click any 
parameters you do not want to include to deselect them. 

5. If you want to exclude certain patient categories from this report, click to select each option to be 
excluded in the Report Exclusions list. 

6. If the list being generated is to be used for sending clinical reminders, click the check box before 
This is a Clinical Reminder Request. 

7. If this report will be run on a regular basis, such as every 30 days, you should click the last check 
box to avoid sending duplicate reminders to patients that have received the reminder within a 
certain period of time.   

8. If you checked the last check box (Exclude patients ...), type and select the time period to use 
for this selection process. 

9. Click Next to open the next window where you can further define the report parameters. 

When the next window opens, the Facilities/Provider parameters will be displayed.  
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Navigating and Selecting Parameters: 

On this screen, and the remaining Registry Processor option screens, you can access and select 
the appropriate set of parameters needed for your report.  To move to each screen, you can click 
the left-side navigation buttons or click the Next and Previous buttons at the bottom of the 
screen.   

Keyboard combinations are also available for accessing any screen in this processor as shown 
here: 

○ Alt+F:  Facilities/Providers 

○ Alt+D: Demographics  

○ Alt+U:  Rules 

○ Alt+G:  Diagnosis 

○ Alt+O:  Orders 

○ Alt+V:  Results/Vitals 

○ Alt+T:  Prescriptions 

○ Alt+I:  Immunizations 

○ Alt+P:  Previous 

○ Alt+N:  Next 

○ Alt+C:  Cancel 

○ Alt+S:  Save 

If you do not select specific parameter values on a screen, the parameter values default to All for 
that screen.  Therefore, in order to produce a useful report, you must select the parameters that 
should be reflected in your report. To deselect parameter values on a screen, click the check box 
for each parameter.  To select a specific value, click that check box. 

10. On the Facilities/Provider screen, leave All selected in the Facilities and Providers lists or 
deselect All and click the check boxes for each appropriate value. 

11. Click Demographics in the left navigation or click Next at the bottom of the screen.  The 
Demographics screen appears. 

12. Deselect any All or N/A options that are not appropriate and select the specific parameter values 
needed for your report. 

13. Continue in this way until you have viewed and possibly updated each parameter screen. 

14. After reviewing and possibly updating the last parameters screen, click Save to retain your report 
settings.   

15. Go to the To locate and run available reports procedure to generate and view the completed 
report. 

To copy an existing report to create a new report: 
1. On the main Registry Processor screen, type all or part of the name of the report in the Report 

Name field, if you know it. 

OR 

If you do not know the report name, type one or more keywords in the Report Description field. 
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Note:  If you do not enter a search string in either field, all available reports will be listed in the 
search results.  You can also enter values in both fields to further define the search criteria as 
needed. 

2. Click Search to find existing reports that match the selection criteria. 

3. If the report you want is listed, click the check box to select the report and click the Copy icon at 
the top of the screen.   

4. When the next screen appears, type the report name and description to use for the new report. 

At this point the report parameter screens will display for you to modify the parameter values as 
described in the To create a new report  procedure. 

5. After reviewing and possibly updating the parameters screens, click Save to retain your report 
settings.   

6. Go to the To locate and run available reports procedure to generate and view the completed 
report. 

To edit an existing report: 
1. On the main Registry Processor screen, type all or part of the name of the report in the Report 

Name field, if you know it. 

OR 

If you do not know the report name, type one or more keywords in the Report Description field. 

Note:  If you do not enter a search string in either field, all available reports will be listed in the 
search results.  You can also enter values in both fields to further define the search criteria as 
needed. 

2. Click Search to find existing reports that match the selection criteria. 

3. If the report you want is listed, click to select the report and click the Edit button at the top of the 
screen.   

At this point, the report parameter screens will display for you to modify the parameter values as 
described in To create a new report. 

4. After reviewing and updating the parameters screens, click Save to retain your report settings.   

5. Go to To locate and run available reports to generate and view the completed report. 

To delete a report: 
1. On the main Registry Processor screen, type all or part of the name of the report in the Report 

Name field, if you know it. 

OR 

If you do not know the report name, type one or more keywords in the Report Description field. 

Note:  If you do not enter a search string in either field, all available reports will be listed in the 
search results.  You can also enter values in both fields to further define the search criteria as 
needed. 

2. Click Search to find existing reports that match the selection criteria. 

3. If the report you want is listed, click the check box to select the report and click the Delete button 
at the top of the screen.   

4. When the deletion confirmation prompt appears, click OK to continue the report deletion or 
Cancel to exit the report screen without making any changes. 
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Using the Patient Listing Reports 
After you have successfully created a patient listing report in the Registry Processor, you can use one or 
more of the following procedures: 

• Export the patient list to Crystal Reports for viewing and printing. 

• Select a single patient from the listing and create a Log/Phone/Rx Note containing information 
about the reminder notification sent to the patient. 

• Select one or more patients from the list and open their charts for viewing or updating in the Chart 
module. 

• Print letters and address labels for mailings to patients in the listing. 

• Send electronic reminders to patients in the list, using their previously defined preferred method 
of receiving reminders.  

All of the following procedures are performed after the patient listing report has been run and is displayed 
on the report screen.  A report screen will look something like the following example: 

 

Patient List Options  
Status You can filter the patient list as follows: 

• All:  Shows all patients who meet the search criteria regardless of whether they 
have been notified or not. 

• Not Notified/Not Done: Shows only patients who have not been notified. 
• Notified/Done: Shows only patients who have been notified. 
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Display Use this option to specify which demographic information should be displayed: 
• Demographics Detailed View: The default is checked (selected), indicating all 

fields should be displayed. If this option is deselected, the following fields are 
hidden: 

o Race 
o Language 
o Ethnicity 
o SSN 
o Acct# 
o Balance 

• Results/Vitals (If Applicable): The default is checked (selected), indicating 
that any FlowSheet fields selected on the parameter selection screen will 
appear on the patient list. If this option is deselected, the selected FlowSheet 
fields will be hidden. 

To export and print a report: 
1. With the report containing the patient listing on the screen, click the Export icon at the top of the 

screen.  

The patient listing will be exported to Crystal Reports for viewing and printing. 

2. After printing the report, click the window toolbar X to exit and close the Crystal Reports viewer. 

To create a Log/Phone Note containing reminder information: 
1. With the report containing the patient listing on the screen, click the check box to select a patient 

from the listing. 

2. Click Log/Phone Note at the bottom of the screen.  

3. In the Edit Chart Note window, assign Log as the Note Class. 

4. Assign a Note Type – either Permanent or Sticky. Permanent notes can be signed and 
permanently attached to a patient’s chart while "sticky" notes are intended to be temporary. 
"Sticky" notes do not print when the entire chart is printed. 

5. In the right, top section, click to select the appropriate options (Confidential, Electronic Copy of 
Health Info, and/or Medical Records Request). 

6. Verify the message appearing in the white free text area. 

7. Click Save to close the window and save the note.  

OR 

Click Sign Off to close the window and permanently sign the note. 

Note:  Only providers (doctors, nurse practitioners, physician assistants) can permanently sign a 
Phone Note or Log Note. If the user logged in is not a provider, the Sign Off button will be 
disabled. 

To open patient charts from the patient listing: 
1. With the report containing the patient listing on the screen, click to select one or more patients 

from the listing. 

2. Click Chart at the bottom of the screen.  The first patient's chart opens. 

3. View or update the current patient chart. 

4. After you finish with that chart, click the X in the chart's right corner to close it. 

If more than one patient was selected from the listing, the next chart opens.  
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5. Continue reading and/or updating and closing the charts until all selected patient charts have 
been accessed. 

To print address labels for mailings: 
1. With the report containing the patient listing on the screen, click Print Labels at the top of the 

screen. 

2. When the print screen appears, select the printer to use and set any parameters for that printer. 

3. Click Print to send the job to the printer. 

Note:  If you are using adhesive labels, do not forget to load the labels in the printer before 
clicking Print. 

4. When the processor prompts Do you only want to print labels for patients with Mail as 
his/her reminder method, click Yes to print labels for those patients only or click No to print 
labels for all listed patients. 

To print letters for mailings: 
1. With the report containing the patient listing on the screen, use the Letter drop-down list at the 

bottom of the screen to list available letters and select the one to use for the mailing. 

2. Click Print Letters at the top of the screen. 

3. When the processor prompts Do you only want to print letters for patients with a Reminder 
preference of Mail method, click Yes to print labels for those patients only or click No to print 
labels for all listed patients. 

4. When the print screen appears, select the printer to use and set any parameters for that printer. 

5. Click Print to send the job to the printer. 

To send eReminders to patients: 
1. With the report containing the patient listing on the screen, use the Letter drop-down list at the 

bottom of the screen to list available letters and select the one to use for the reminder. 

2. Click Send eReminder at the bottom of the screen.   

The letter selected will be prepared and distributed electronically to the patients in the listing, 
using their preferred electronic reminder method.  If the preferred reminder method selected by a 
patient is Portal, an e-mail message will be sent instructing the patient to log in to Portal to view 
important information. 

When electronic reminders are sent to patients using this method, a Log Note is added to the 
patient's chart citing the reminder type and report name. 
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To document phone reminders: 
If the patient has chosen a phone and specified a preferred phone number as their preferred reminder 
method, you can also track that activity from this screen. 

1. Using the patient name and preferred phone number on the report, call each patient and verbally 
deliver the reminder. 

2. Click the check box by the patient's name to indicate that the reminder has been provided.  
Clicking this check box will cause a Log Note to be added to the patient's chart indicating that a 
reminder has been given on the current date. 

Note:  Do not click the check box by the patient's name until you have actually performed the 
notification.  After clicking the status check box, you cannot deselect it to remove the checkmark. 

To automate Registry Processor reports using Rules Manager: 
1. At the Solution Series Dashboard, open Rule Manager. 

2. Click the Tasks tab. 

3. On the Tasks tab, click New Rule at the top of the screen.   

4. In the Task Rule Type Selection window, select Notice Processor and click Select at the top of 
the screen.   

5. In the New Rule window, select Parameters and the Registry Processor window opens. 

6. Using the procedures described in To locate and run available reports, locate and select the 
report to be run through Rules Manager. 

7. Click OK  

8. Save the new Task rule.  After the rule is run, the desired action occurs.  To schedule and further 
automate the process, see "Creating a New Rule" in e-MDs Solution Series Chart User Guide for 
detailed instructions.   
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8 
Generating QRDA Files for 

PQRS  
The PQRS QRDA Creator allows users to generate PQRS reports that conform to the Quality Reporting 
Document Architecture (QRDA) standard. 

Privilege Required for the e-MDs PQRS QRDA Creator 
You cannot use the e-MDs PQRS QRDA Creator unless the PQRS QRDA Creator security privilege 
(shown in the following image) is assigned to your Solution Series user account with Read/Write/Delete 
access. This privilege is included in the All Privileges and Chart Administrator security groups. 

 
Note:  Every Solution Series user who will access the PQRS QRDA Creator must have this privilege. 

Selecting Parameters and Generating the QRDA File 
Note:  The first time you open the e-MDs PQRS QRDA Creator, a setup screen is displayed.  In 
the setup screen, you can select parameters that will be used to generate a PQRS QRDA file. 
Once you have generated a QRDA file, a summary screen (shown below) is displayed each time 
you open the PQRS QRDA Creator. The summary screen lists completed and pending files. 
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You can display the setup screen again by clicking the Add button (shown below). 

 

To select parameters and generate a QRDA file: 
1. To open the e-MDs PQRS QRDA Creator, double-click the shortcut on located on the desktop.  

 
2. If the summary screen is displayed, click Add to access the setup screen. 

3. On the setup screen (shown below), click the drop-down button in the Provider field to display a 
list of active and inactive staff providers. Select the Provider for whom the PQRS QRDA file is to 
be created. 

 
4. Select the Start Date and End Date of the reporting period. (Providers who are generating the 

QRDA files for the 2012 PQRS program should enter a reporting period of 01/01/2012 to 
12/31/2012.) 

5. From the Insurance Clase Code drop-down list, select the appropriate insurance class or 
classes. This drop-down list allows selction of more than one insurance class. Providers who are 
generating the QRDA files for the 2012 PQRS program should select all insurance classes that 
are associated with Medicare insurance plans. 
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6. Select the CMS measure(s) to be calculated and included in the QRDA file. 

7. If the path shown in the File Location field is not correct, click the Browse button to search for 
and select the folder on the workstation or network where the PQRS QRDA files are to be saved. 

 
It is a good practice to select the same folder each time you set up a QRDA file job. For each job, 
the PQRS QRDA Creator creates a folder within this folder. To quickly view the existing folders, 
click the File menu in the PQRS QRDA Creator summary screen and select Explore files. 

8. At this point, you can generate the file or you can schedule it to be generated later. 

○ To generate the file now, select the Run Now option and then click Ok. 

 
When you click Ok, calculation of the selected measures begins. (You can view progress in 
the Status column in the PQRS QRDA Creator.) 

When the measures have been calculated, the QRDS Builder opens and begins to generate 
the QRDA files. The QRDA Builder displays “Saved” in the Results column as the QRDA file 
for each patient is saved in the folder selected above.  

 
○ To generate the file later, select Run Later, select a date and time, and then click Ok. 

Note that the PQRS QRDA Creator must be open for file generation to begin. Only one QRDA 
file is generated at a time, regardless of the number of files scheduled for a specific time. If 
you schedule file creation for multiple providers at the same time, the files will be generated in 
the order in which they were set up. 
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If files are scheduled for generation at a later time, the Status column in the PQRS QRDA 
Creator screen displays “Waiting” until file generation begins. 

 

Editing Parameters for Scheduled PQRS QRDA Jobs 
You can edit parameters for PQRS QRDA files that have not yet been generated. 

To edit a scheduled job: 
1. On the PQRS QRDA summary screen, select the job to be edited and then click the Edit button 

(or, right-click the job and select Edit from the pop-up menu). 

 
The set up screen is displayed. 

2. Edit the parameters as desired. (You can edit the reporting period, insurance class, selected 
measure(s), or job start time.) 

3. Click OK to save the changes. 

Note:  PQRS QRDA jobs that have been completed cannot be edited. 

Error Handling in PQRS Measure Calculation 
When an error occurs in the PQRS measure calculation, the QRDA file cannot be created, and a 
message similar to the one shown below is displayed. 
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This type of message is indicative of a database inconsistency and requires immediate intervention. It can 
only be resolved with the assistance of a member of the e-MDs Support team. 

You can contact e-MDs Support at 1-800-565-5564, or you can create a Software Support Ticket and 
paste the error message into the ticket. (You can copy the error message by clicking the Copy to 
Clipboard button and then pasting the error message into the Support Ticket.) 

Error Handling in Patient QRDA Creation 
When an error occurs in the Patient QRDA creation, the PQRS QRDA Creator skips the patient and adds 
an ERROR note in the Results column of the QRDA Builder. 

To correct errors and generate another QRDS file: 
5. Click the Open Error Log button to view information about the error. 

 
The Error Log includes comments about each patient whose chart contained an error that 
prevented the creation of a QRDA file.  See example below. 
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6. If you can determine the cause of the error from the comments in the error log, open the patient’s 

chart and correct the cause of the error, then run the job again only for the patients for whom you 
have corrected errors. (See steps below.) 

If you cannot determine the cause of the error, contact e-MDs Software Support for assistance 
with correcting the errors. After errors are corrected run the job again only for the patients for 
whom you have corrected errors. (See steps below.) 

7. After you correct the errors, open the PQRS QRDA Creator again, click Add, and select exactly 
the same parameters for file generation, and then click Run Now. 

8. When the QRDA Builder opens, immediately click the Start/Stop button. 

 
9. Uncheck the Select All check box to deselect all patients. 

 
10. Select only the patients for whom errors were corrected. 

11. Click the Start/Stop button again to initiate file generation. 

When all QRDA files are generated and ready for submission to CMS, submit the original zip file and the 
zip file containing the QRDS files for the patients for whom you have corrected errors. 

Reviewing PQRS Data in the PQRS QRDA Report Module 
You can view the total number of patients who met, did not meet, or were excluded from each measure. 

To use the PQRS QRDA Report module: 
1. In the PQRS QRDA Creator, click a file generation job to select it and then right-click and select 

Report. 
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2. The PQRS QRDA Report module opens and displays information about the selected job. 

 
3. Click the name of a measure to display a list of totals for each status. 

 
4. In the list of totals, click a column header to view a list of patients for each status.  

 
If a measure has more than one numerator, the patient will be listed in each status with the 
corresponding numerator. For example, if the patient meets both numerator 1 and 2, the 
Numerator column will display 1, 2. 

Note:  If you want to export the report to a text file, click the Export data… button in the Reports module. 
The text file can then be imported into a spreadsheet for data manipulation. 
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9 
Spell Checker 

The spell check configuration tool is a third-party dictionary that has been integrated 
into the e-MDs Solution Series.  It can be used in many different text fields (also 
known as “blobs” or memo fields).  Examples of these are the patient alert, the Notes 
field for appointments, collections notes, phone note and free text boxes in Chart, and 
TaskMan messages. 

In addition to the spell check capabilities, a secondary function of the dictionary is the 
Auto Correct feature.  This is much like the correction functions seen in main stream 
word processing applications like Word which automatically change the words or 
characters entered by a user into something else, such as to correct common typing 
keystroke errors.  This makes it a very useful tool for setting up macros to enter 
commonly used comments and can thus save users literally thousands of keystrokes 
and a great deal of time.  For example, nlab6 can be used to enter “Normal labs, 
follow up in 6 weeks”, or 3col for “Mailed 3rd collection letter, turn over to agency”. 

Custom spell-check options are user and workstation specific.  The advantage of this 
is speed and reduced network traffic, but the disadvantage is that any custom 
changes to the dictionary for a user need to be done on all workstations that the 
person uses.  This is less of an issue for administrative staff (e.g. billers) who tend to 
use the same computer, but must be considered for users like doctors who move 
from one workstation to another.  It is possible to set up macros that push the 
dictionary files out to multiple workstations on the network.  The default name for a 
user dictionary is the Windows login name.  The file extension is .adu, so changes to 
the dictionary can be made on one workstation, and pushed to others where the user 
works. 

Continued on the next page ... 
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Using Spell Checker  
When entering information in free text fields, you can use Spell Checker to verify the spelling of words 
and view alternative spellings.  A set of standard dictionaries is provided with Solution Series but you can 
also create your own custom dictionary to check special terminology that is also used in your facility. 

Correcting Spelling Errors 
As you type in free text fields where the spell checker is enabled, misspelled words are underlined with a 
red line (see example screen shot below). 

 

To correct the errors: 
1. Right-click the misspelled word. 

2. Review the list of suggested alternatives in the top part of the right-click window and select the 
one needed.  If there are multiple instances of the same error, click Change All, then select the 
word to correct all the errors. 

3. If the word is valid but is not in the dictionaries, click Add 

4. To add this word to an auto-correct pair, click Auto Correct; then select the word with which to 
replace it.  Every time this same spelling error is made in future, the system will automatically 
correct it. 

5. The Spelling option opens a window from which additional options, including access to the 
dictionary setup, is available. 
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Choosing Dictionary Options 
The spell check configuration tool includes both a standard dictionary and a medical dictionary.  The 
standard dictionary is enabled by default, but the medical and user defined dictionaries can also be 
added.  The system will check all of them when verifying spelling, but there may be an effect on system 
speed. 

To set dictionary options and to enable/disable dictionaries from the Tools menu: 
1. Go to Tools > Spell Checker. 

2. Review and check/uncheck the Options at the top of the Spelling Options window.  If you are 
going to add your own options (word, auto-correct/macros), you must uncheck Suggest from 
main dictionaries only. 

 
3. Click to select the box to the left of the standard dictionary names in the Dictionaries section.  

These are typically English and Medical.   

4. To browse for other dictionaries available on your computer, check Locate Dictionaries.   

5. Click OK. 

The following method tends to be faster and more convenient than from the Tools menu. 

To set dictionary options on the fly: 
1. With an spell check-enabled memo window open, right-click a potentially misspelled word and 

select Spelling. 

2. Click Options. 

3. Review and check/uncheck the Options at the top of the Spelling Options window.  If you are 
going to add your own options (word, auto-correct/macros), you must uncheck Suggest from 
main dictionaries only. 

4. Check the box to the left of the standard dictionary names in the Dictionaries section.  These are 
typically English and Medical.   

5. To browse for other dictionaries available on your computer, check Locate Dictionaries.   

6. Click OK. 
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Selecting a custom dictionary adds it to the ones the system checks for spelling errors.  It is much the 
same as checking default dictionaries (English and Medical). 

To select a custom dictionary: 
1. Go to Tools > Spell Checker. 

2. Select a custom dictionary from the list in the Custom Dictionary field. 

You can create your own custom dictionary to use for checking spelling and terminology in addition to the 
standard dictionaries provided with Solution Series. 

To create a custom dictionary: 
1. Go to Tools > Spell Checker. 

2. In the Spelling Options window, click Dictionaries.  The Dictionaries window opens. 

 
3. Click New to open the New Custom Dictionary window. 

 
4. Type the name of your new dictionary and click OK.  The window closes and the new dictionary 

will appear in the Custom Dictionaries section of the Dictionaries window.   

 
The entry will already be checked, indicating it will be used for future spell checking. 

5. Click OK to save the new dictionary. 

6. Click OK again to close the Spell Checker window. 
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Note:  The custom file will be saved with the name you entered and a file type of .adu.  The 
location of this file will vary based on the version of Windows being run on your computer and 
other factors.   

○ If roaming user profiles are not used: 

 In Windows XP, the user-created dictionary is stored in the C:\Documents and 
Settings\logged-in-username\Application Data\e-MDs\SpellChecker.   

 In Windows 7, the user-created dictionary is stored: C:\Users\ logged-in-
username\AppData\Roaming\ e-MDs\SpellChecker. 

○ If roaming user profiles are used, these .adu files will be stored and accessed outside the 
standalone computer where they can be accessed from other computers on the same 
network.  For more information on how that works, see "Using Custom Dictionaries Across 
Your Network." 

Using Custom Dictionaries Across Your Network 
When you create a custom dictionary on your computer, that dictionary is normally available only on the 
computer where it was created.  In other words, if you create a custom dictionary on Computer A in the 
morning, and then perform free text entry in a note in the afternoon on Computer B, the custom dictionary 
you created on Computer A will not be accessible in the afternoon on Computer B.  That is standard 
Microsoft Windows handling of files created on individual computers.  However, there are alternative 
methods of handling user access and files if the staff at your facility frequently move from one computer 
to another during a normal work day. 

Microsoft provides a method of configuring roaming user profiles that are managed in the Active Directory 
service on a domain controller.  When administrators configure profiles to roam, the data and settings in a 
user's profile are copied to a network server when the user logs off the computer.  The data and settings 
are then available to the user no matter where he or she logs on to the network next time.   

If you determine that your organization needs this Windows feature, contact your system administrator 
and/or IT support staff to discuss this requirement.  More information on this functionality is available in 
the Microsoft Windows Professional Resource Kit Documentation that is described at 
http://www.microsoft.com/mspress and the TechNet Library at http://technet.microsoft.com/en-
us/library/default.aspx. 

Adding Words and Macros 
In addition to the spell check capabilities, a secondary function of the dictionary is the Auto Correct 
feature.  This is much like the correction functions seen in main stream word processing applications like 
Word which automatically change the words or characters entered by a user into something else, such as 
to correct common typing keystroke errors.  This makes it a very useful tool for setting up macros to enter 
commonly used comments and can thus save users literally thousands of keystrokes and a great deal of 
time.  For example, nlab6 can be used to enter “Normal labs, follow up in 6 weeks”, or 3col for “Mailed 3rd 
collection letter, turn over to agency”. 

To add custom words and macros from the Tools menu: 
1. Go to Tools > Spell Checker. 

2. Click Dictionaries.  The Custom Dictionaries window opens. 

3. Select the dictionary to which words or macros are to be added or excluded.  The dictionary 
name must be highlighted for it to be selected – just checking the box does not select it. 

4. Click Edit. 

5. To add words, click the Added Words tab, enter the word(s) in the Ignore this word field, and 
click Add. 

http://www.microsoft.com/mspress�
http://technet.microsoft.com/en-us/library/default.aspx�
http://technet.microsoft.com/en-us/library/default.aspx�
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6. To create Auto-Correct Pairs/Macros, click the Auto-Correct Pairs tab.  In the Replace field, 
enter the macro keystrokes you will use; then enter the full phrase that you want to appear in the 
With field.  When the Replace keystrokes are entered in memo fields, the system automatically 
replaces them with the With phrase. 

7. To exclude words, click the Excluded Words tab and enter the word(s) in the Exclude this word 
tab. 

To create auto-complete pairs/macros on the fly: 
1. Enter the macro code you want to use.  Assuming it is not a word, the system underlines it to 

indicate a spelling error. 

2. Right-click and select Spelling. 

3. Your code appears in the Not Found box.  Type the phrase you want in the Replace With box. 

4. Click Auto-Correct. 
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10 
Signatures 

Signatures are bitmaps or images of a user’s handwritten signature that are captured 
electronically via scanning and can be used within both the ScriptWriter, DocMan and 
Chart modules.  In the ScriptWriter module the signatures can be attached to faxed 
prescriptions to meet the requirements of most states to have an actual signature on 
faxes.  In DocMan the signatures can be used, in conjunction with the Rubber Stamp 
feature, as part of the sign-off process for scanned images such as lab results. In 
Chart the signatures of providers can be attached to Lab and Radiology reports for 
those labs that require such. 

Notes:    
• Not all states allow faxed prescriptions and within those that do allow faxes 

there may be specific requirements outside of simply having a signature 
attached.  e-MDs does not try to deal with each specific state requirement but 
instead tries to provide the features and flexibility that the user needs to meet 
those requirements.  e-MDs has tried to provide the necessary tools to do so 
but cannot guarantee compatibility with every state requirement. 

• Currently only provider (physician, physician assistant and nurse practitioner) 
signatures are used.  Signatures for other users can be captured but will not 
be used in the current version. 

• The use of Signatures is an optional feature when using DocMan.  However, 
for use of faxed prescriptions Signatures ARE required.  Even if your state 
does not require a signature on a faxed prescription, the only way to designate 
a faxed prescription as being a brand name or generic drug is by use of the 
Signatures.  See Using Signatures with Faxed Prescriptions for details. 

 

Continued on the next page ... 
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Understanding the Signature Window 
The Signature window provides all the tools needed to capture and maintain user signatures.  At the top 
of the Signature window is the menu system containing File and Action menu items.  Below the menu 
items are the following buttons: Scan, Import, Delete, Print Form, and Help Exit.  Just below these 
buttons is a Login user field.  Occupying most of the bottom of the window are two panes, one on the left 
and one on the right side.  The purpose of each of these sections of the screen are described below. 

File Menu Options  
Print Form Prints the form that is used to capture signatures (see the “Signature Form” section 

for details). 
Select Scanner Opens a Select Source window that allows the user to select the scanner that will be 

used to scan the Signature Form. 
Exit Exits the Signature window. 

 
Action Menu Options  
Scan Using an attached scanner, scans the Signature Form which allows the program to 

capture the user’s signatures and store them in the database.  Scanning in this 
manner bypasses any proprietary drivers or option screens that come with the 
scanner. 

Scan Custom Scans using the proprietary drivers or options screens that come with the scanner. 
Import Imports a previously scanned image of the Signature form into the system. This can 

be handy when there is a need to use a scanner that is not on the local network.  
For this feature to work the scanned image must be of the Signature Form in a tiff 
format and scanned at 300 dpi (dots per inch). 

Delete Deletes one or more of the scanned signatures stored in the database. 
 
Other Options  
Scan Using an attached scanner, scans the Signature Form which allows the program to 

capture the user’s signatures and store them in the database.  Scanning in this 
manner bypasses any proprietary drivers or option screens that come with the 
scanner. 

Import Imports a previously scanned image of the Signature form into the system. This can 
be handy when there is a need to use a scanner that is not on the local network.  
For this feature to work the scanned image must be of the Signature Form in a tiff 
format and scanned at 300 dpi (dots per inch). 

Delete Deletes one or more of the scanned signatures stored in the database. 
Print Form Prints the form that is used to capture signatures (see the “Signature Form” section 

for details). 
Help Accesses the help files. 
Exit Exits the Signature window. 

File Menu Options  
Print Form Prints the form that is used to capture signatures (see the “Signature Form” section 

for details). 
Select Scanner Opens a Select Source window that allows the user to select the scanner that will be 

used to scan the Signature Form. 
Exit Exits the Signature window. 
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Other Options  
Login user Shows the name of the person that is either logged in OR the name of the person 

whose signatures are being scanned or edited.  Users can always maintain their 
own signatures but there is also a security privilege included with the system that 
allows anyone with the privilege to scan or edit any other user’s signatures (see 
“Signature Security” for details). 

Accessing the Signature Window 
The Signature window is accessible from both the Chart and DocMan applications.  The same 
functionality is available in both locations. 

To access signatures from Chart: 
1. Log in to Chart using the normal e-MDs username and password. 

2. On the main Chart menu bar, select Tools > Signatures. 

The Signature window will open. 

To access signatures from DocMan within Chart: 
1. Log in to Chart using the normal e-MDs username and password. 

2. On the main Chart menu bar select Tools > DocMan or, if a patient chart is open, click the 
DocMan icon on the patient-specific chart toolbar. 

DocMan will open. 

3. On the main DocMan menu bar click Tools > Signatures. 

The Signature window will open. 

To access signatures from DocMan standalone: 
1. Login into DocMan using the normal e-MDs username and password. 

2. On the main DocMan menu bar select Tools > Signatures. 

The Signature window will open. 

Capturing Signatures with the Signature Form 
The Signature Form is used to capture user signatures in an image format.  The form is intended to be 
printed out and then filled out by the provider.  Once that is done the form is then scanned into the system 
and the signatures are linked to the provider for use with faxed prescriptions and with DocMan images.  
The form is divided into two sections.  The top section has five areas for input of signatures and one for 
input of user initials.  The bottom section of the form is contains additional information that must be filled 
out if the signatures are to be used for faxed prescription.  These sections are described below. 

Understanding the Signature Section 
This section contains five signature fields and one initial field.  Once the Signature Form is printed out, the 
provider must fill out AT LEAST ONE of the signature fields if the Signature feature is to be used.  At least 
one (and up to five) signatures for a provider can be captured and linked to the provider.  Once the form 
is scanned into the system the signature (or signatures) will be linked to the provider and can be used for 
faxed prescriptions or for adding signatures to DocMan images. If more than one signature is captured 
the application will randomly pick a signature to add to a faxed prescription or DocMan image.  This 
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prevents the exact same signature form appearing every time a signature is used and avoids the 
appearance of a “stamped” signature. 

Notes:    
• Currently only provider (physician, physician assistant and nurse practitioner) signatures are 

used.  Signatures for other users can be captured but will not be used in the current version. 
• Currently the Initial field of this section is not being used.  It is intended for a future feature.  This 

Initial field is not to be confused with the Rx Initial field which MAY be required depending on the 
state requirements for prescriptions.  See the "Additional Information for Prescription" section 
below for details. 

Determining Brand or Generic Drug Fulfillment 
This section contains additional information that will be used for faxed prescriptions and consists of two 
fields.  These fields are used to determine whether a prescription should be filled by the pharmacy as a 
Brand name or Generic drug.  One field is labeled Rx Initials and the other is labeled Rx Additional Text.  
One of these two fields (in addition to at least one signature field) must be filled out in order to be able to 
fax prescriptions.  Which of the fields gets filled out depends on the requirements of your state.  The 
sections below explain the functionality of each field. 
 

• Rx Initials:  Some states require that a provider place initials in a box or on a line on the face of 
the prescription to denote whether the prescription is to be filled as a Brand name or Generic 
drug.  This field is to be used for that purpose and should be filled out in those situations. For 
example, some states have a box on the prescription that requires the provider to enter D.A.W. 
while other states may require the provider’s initials or other initials to be entered.  The specific 
initials for each state vary and it is up to the user to enter the correct information into this field IF 
IT IS REQUIRED.  Other states require users to enter text rather than initials and that information 
must go in the Rx Additional Text field described below. 

• Rx Additional Text:  Some states require that the provider enter some text into a field or onto a 
line on the face of a prescription to denote whether the prescription is to be filled as a Brand 
name or Generic drug.  This field is to be used for that purpose and should be filled out in those 
situations.  For example, some states require that Brand Necessary be written on the script, 
others require Dispense as Written, Do Not Substitute, Product Selection Permitted or some other 
text.  The specific text for each state varies and it is up to the user to enter the correct information 
into this field IF IT IS REQUIRED.  Other states require users to enter initials rather than text and 
that information must go in the Rx Initial field described above. 

Adding and Deleting Signatures 
Using the Signature Form and a scanner, provider names can be captured electronically and stored in the 
database linked to the provider’s login.  Once in the system the signatures can be used for faxing 
prescriptions and for signing off DocMan scanned documents. See “Using Signatures with Faxed 
Prescriptions” and “Using Signatures with DocMan Images” for details. 

To print the signature form: 
1. Login into Chart using the normal e-MDs username and password. 

2. On the main Chart menu bar select Tools > Signatures. 

The Signature window will open. 

3. Click the Print Form button on the toolbar. 

4. The Signature Form will print out on the default printer assigned to the computer. 
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Print the Signature Form and, when it is filled out, scan it into the system using the Signature module. 

To scan the signature form: 
1. Login into Chart using the normal e-MDs username and password. 

2. On the main Chart menu bar select Tools > Signatures. 

The Signature window will open. 

3. Make sure the login name in the Login user field is the correct one for the signatures being 
scanned in. 

4. Load the Signature Form in to the scanner and click the Scan button on the toolbar. 

5. The form will be scanned into the database and the signatures will appear in the Signature 
module. 

Print the Signature Form and when it is filled out scan it to a file and place the file in a location that can be 
accessed on the network or on the machine the scanner is attached to.   

Note:  For this feature to work the scanned image must be in a tiff format and scanned at 300 dpi (dots 
per inch). 

To import the signature form: 
1. Log in Chart using the normal e-MDs username and password. 

2. On the main Chart menu bar, select Tools > Signatures. 

The Signature window will open. 

3. Make sure the login name in the Login user field is the correct one for the signatures being 
imported. 

4. Click the Import button on the toolbar. 

A browse window will open. 

5. Browse to the location where the file is stored and select it. 

The file will be imported into the database and the signatures will appear in the Signature module. 

To delete a scanned signature: 
1. Login into Chart using the normal e-MDs username and password. 

2. On the main Chart menu bar, select Tools > Signatures. 

3. The Signature window will open. 

4. If signatures exist a list of them will appear in the right pane of the Signature module. 

5. Clicking on the file name in the right pane will cause the scanned image to appear on the left. 

6. If a signature needs to be deleted click on the file name and click the Delete button on the 
toolbar. 

7. Click Yes in the confirmation window. 

Maintaining Signatures for Other Users 
Users can always maintain their own signatures but there is also a security privilege included with the 
system that allows anyone with the privilege to scan or edit any other user’s signatures (see “Signature 
Security” for details).  If a user has this privilege assigned to them they can Scan, Import or Delete 
signatures for other users.  To perform these tasks for other users: 
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To scan, import or delete signatures: 
1. Login into Chart using the normal e-MDs username and password. 

2. On the main Chart menu bar select Tools > Signatures. 

The Signature window will open. 

3. Select the appropriate user’s login by clicking the button to the right of the Login User field. 

The Find a Login window will open. 

4. Enter the user’s login into the Login Name field OR enter the users last name in the Last Name 
field (the First Name field can also be used). 

5. Click the Search button on the toolbar. 

6. Highlight the user in the search results and click the Select button. 

The users name will appear in the Login User field. 

7. Scan, Import or Delete signatures as necessary for the selected user (see “Adding and Deleting 
Signatures” for details). 

Using Signatures with Faxed Prescriptions 
If signatures exist for a provider the Script Writer program will attached the signature to faxed 
prescriptions.  This meets the requirements of MOST (but not all) state’s legal requirements for faxed 
prescriptions. In addition to a signature the program add additional text to denote whether the prescription 
should be filled as a Brand or Generic drug. 

To use signatures with prescriptions simply print the Signature Form, fill it out and scan it back into the 
Signature module.  Then setup Faxing options for passwords and designate staff to fax under with your 
name (if desired).  Once these things are done the process becomes transparent and when any script is 
designated to be faxed a signature will be automatically attached. 

Using Signatures with DocMan Images 
If signatures exist for a provider they can be used, in conjunction with the functionality of Rubber Stamps 
(see Reusing Statements with Rubber Stamp? for details), as part of the sign-off process for DocMan 
scanned documents.  This process adds a bitmap image of the signature to the scanned document. 

Using Signatures with Lab and Radiology Reports 
If signatures exist for a provider they can be used in the Chart application.  As an option the provider can 
choose to add their signature to all printed or faxed Lab and Radiology reports. This process adds a 
bitmap image of the signature to the report.  For instructions on setting the option, see Show Signature in 
Lab/Radiology Reports.  

Maintaining Signature Security 
There are two security components that are related to the Signature feature of Chart and DocMan.  These 
components consist of a security privilege called DocMan Signature Admin privilege and a set of user 
options for prescriptions call Fax Signature Options.  These components are described below. 
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Using the DocMan Signature Admin Privilege 
Users can always maintain their own signatures but there is also a security privilege included with the 
system that allows anyone with the privilege to scan or edit any other user’s signatures.  This feature was 
added to allow a non-provider to print out the Signature Form and distribute it to the providers that want to 
use the Signature feature and then, once the forms are filled out and turned in, the non-provider could 
scan the forms into the database and associate the signatures with the appropriate user.  This was done 
so that the providers would not be forced to do it themselves. 

This privilege as added to the All Privileges security group and the Chart Administrator security group.  
Any user with one of those privileges will be able to scan signature forms for any provider.  In addition 
certain users can be assigned individual privileges, if needed (see “Assign a User to a Security Group” for 
details). 

Setting Fax Signature Options 
This option is part of the User Preferences for Script Writer options and allows the provider to designate 
whether a password is required when faxing and also to designate whether other staff can fax 
prescriptions under the provider’s name.  For security purposes it is recommended that the provider be 
required to input a password when faxing but it is not a requirement.  If other staff members are 
designated to be able to fax prescriptions they will be required to enter a password. In either situation if a 
password is required it will be the same password that is used to login to the e-MDs application. 
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11 
CCD, C-CDA, and CCR 

Files 
Several types of electronic files are used to transfer a patient’s clinical data from one 
care provider to another. The Continuity of Care Document (CCD) and Continuity of 
Care Record (CCR) were previously the most commonly used file types. 
Consolidated Clinical Document Architecture (C-CDA) is a more recently developed 
file type. The C-CDA file type meets the requirements for Meaningful Use Stage 2.  

Any of these file types can be imported into e-MDs Solution Series. The imported file 
is stored in the patient’s DocMan files. 

Clinical data can be exported from Solution Series in the form of a C-CDA file. The 
exported file can include the data contained in a single Visit Note (Clinical Summary 
C-CDA) or can include the patient’s Health Summary (Transfer of Care C-CDA). 

 
Continued on the next page ... 
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Importing CCD, C-CDA, and CCR Files 
Imported files are stored in DocMan. After you import the file, you can use the clinical reconciliation 
feature in Chart to reconcile the contents of the file with the data documented in the patient’s chart.  

To import a CCD, C-CDA, or CCR file: 
1. Open the patient-specific DocMan and select (click) the folder in which the imported document 

should be saved. 

 
2. Click the Import Document button on the toolbar. 

 
A file browsing window will open.  

3. Browse to the location of the file to be imported. 

4. Click the file name and then click Open. 

A Documents window is displayed. 

5. In the Documents window, click the check box next to the folder name and confirm that Do not 
Send Message is selected. 

 
6. Click the OK button located in the lower right corner of the window. 

The imported file will be saved in the selected folder in DocMan. You can view the contents of the 
file by double-clicking the file name. 
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Note: You can also use the CCD button in the patient-specific Chart or DocMan toolbar to import a CCD 
or CCR. 

Exporting a C-CDA File 
A C-CDA file can contain the contents of a single Visit Note (Clinical Summary C-CDA) or the contents 
of a patient’s Health Summary (Transition of Care C-CDA). When you export a Transition of Care file, 
you can save the file, or you can send it via Direct messaging. 

IMPORTANT! C-CDA files contain protected health information: Never save these files to the local 
desktop on a computer that is accessible without a password. Best practice is to save C-CDA files in an 
audited network file folder with limited access and to delete the file after it has been provided to the 
intended recipient. 

To export a Clinical Summary C-CDA: 
1. Select the Visit Note and then click the CCD button on the patient-specific Chart or DocMan 

toolbar. 

2. Select Export Clinical Summary (C-CDA) from the menu. 

 
A list of reasons for exporting the Chart Summary is displayed. 

3. Select a reason and click OK.  

A pop-up window displays the sections available for inclusion. 

4. Note that all sections are automatically selected (checked). If you want to exclude certain 
sections from the exported file, click those sections to remove the check mark. If you do not 
remove any check marks, the system will generate a C-CDA file containing all sections and all 
test results. 

5. If you want to require a password to open the generated C-CDA file, select Password Protect and 
type a password in the text box. 

Note that the option to password protect the C-CDA will only appear if the option to password 
protect CDA documents is activated from File>>Options before beginning the export process. 

6. Click Save. 

A file browser is displayed. 

7. Select the folder in which the exported file is to be saved and then click Save. 

To view the file, navigate to the folder in which the file was saved and double-click the file name. 
File contents will be displayed in your default Internet browser. 

Note: If your browser is Internet Explorer version 9, the browser Security Setting “Access data 
sources across domains” must be selected in order to view the file in human readable format. 

To export and save a Transition of Care C-CDA 
1. Click the CCD button on the patient-specific Chart or DocMan toolbar. 
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2. Select Export Transition of Care (C-CDA) and then select Save. 

 
A file browser is displayed. (You cannot select specific sections for inclusion in the Transition of 
Care C-CDA file: All sections of the patient’s Health Summary are included.) 

3. Select the folder in which the exported file is to be saved and then click Save. 

To export a transition of Care C-CDA and send to a Direct Address 
1. Click the CCD button on the patient-specific Chart or DocMan toolbar. 

2. Select Export Transition of Care (C-CDA) and then select Send via Direct Message. 

The Direct Message Compose window opens. The system automatically populates the From field 
with the Direct Address of the logged in provider (pulled from the provider’s demographics 
record), and the Transition of Care file is generated and attached to the email. 

3. In the To field, type a Direct Address.  

Note: A Direct Address is different from a regular email address. It is a type of email that is 
designed specifically for transferring healthcare information securely from one care provider to 
another. A Direct Address will have the word “direct” in the address. 
“kevin.cardio@direct.updox.com” is an example of a Direct Address. 

4. Type the message text and then click the Send button. 

Note: A copy of the message is saved to the sender’s Direct Sent folder in TaskMan. 
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